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Abstract
This publication describes the protocols used in the IISD Experimental Lakes Area Analytical 
Service Laboratory for the measurement of chemical constituents in freshwater samples. The 
chemical constituents measured include anions (Cl and SO4), cations (Na, Mg, K, Ca, Mn, and 
Fe), carbon speciation (dissolved inorganic carbon, dissolved organic carbon, absorbance scan 
to assess dissolved organic carbon quality, and particulate carbon), chlorophyll-a, conductivity, 
dissolved oxygen, gran alkalinity, nitrogen speciation (nitrite, nitrate, ammonia, total dissolved 
nitrogen, and particulate nitrogen), particulate iron, pH, phosphorus speciation (total dissolved 
phosphorus and particulate phosphorus), soluble reactive silicon, and turbidity. In addition to 
the analytical methods used, quality assurance and quality control (QA/QC) protocols used for 
labware cleaning, calibration, and verifications, sample tracking and data recording, and sample 
preparation, filtration, and storage are also provided.  
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1.0 Introduction
The International Institute for Sustainable Development Experimental Lakes Area (IISD-ELA) 
Analytical Services Laboratory (ASL) has conducted chemical analyses of various constituents in 
fresh water for projects occurring at IISD-ELA since 1969. This document outlines how samples 
are processed (e.g. tracked, filtered, stored, etc.) and analyzed for various chemical constituents 
in freshwater samples, mostly of low solute concentrations, that are submitted to the IISD-
ELA ASL. These methods have mainly been used in studies of aquatic productivity and thus 
are designed for the measurement of micronutrients rather than for pollutants or water quality. 
Care should be taken when applying them to alkaline, hard, or saline waters, though many are 
adaptations of methods designed for seawater.

The chemical constituents measured include major nutrients (C, N, P) in their dissolved and 
particulate phase, soluble reactive silicon, anions (Cl and SO4), cations (Na, Mg, K, Ca, Mn, 
and Fe), chlorophyll-a, conductivity, dissolved oxygen, Gran alkalinity, particulate iron, pH, and 
turbidity. Analyses for the speciation of C (dissolved inorganic carbon, dissolved organic carbon, 
absorbance scans to assess dissolved organic carbon characteristics, and particulate carbon), 
N (nitrite, nitrate, ammonia, total dissolved nitrogen, and particulate nitrogen), and P (total 
dissolved phosphorus and particulate phosphorus) are described.

Dissolved and particulate fractions are operationally defined by the filters used (Whatman GF/C, 
1.2 µm), which are measured separately (filter and filtrate) and summed for total concentrations 
(e.g. total phosphorus equals total dissolved phosphorus plus particulate phosphorus). The 
dividing line, in particulate size, between particulate and dissolved phases could reasonably be put 
between 0.1 and 1.0 µm, where the smaller 
particles might be kept from settling by 
Brownian motion. Many researchers use 
0.45 µm membrane filters, but most cellulose 
ester membrane filters of this porosity are 
slow and apt to clog. The IISD-ELA ASL 
has used Whatman GF/C filters since the 
early 1970s because they are faster; in 
addition, because they are inorganic, they 
can be ignited before use and thus may be 
used for carbon and nitrogen determination. 
Although the pore size is greater and not well 
defined, the manufacturers state that 98% of 
particles between 0.5 and 1.0 µm are 
retained. There is very little difference in the 
quantity of particulate matter retained by the 
GF/C filters compared to 0.45 µm 
membrane filters.

Figure 1.1. Sample processing flow chart

Samples logged into LIMS

Samples subsampled, filtered,  
and labelled

Subsamples, filtered samples, and filters 
analyzed for various constituents

Analysis results manually entered  
into LIMS
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Samples submitted to the IISD-ELA ASL are logged into the Laboratory Information 
Management System (LIMS), Sample Master®, wherein sample metadata is recorded, Sample 
IDs are assigned, and labels are generated. Samples are subsampled, labelled, and filtered, then 
subsequently analyzed for chemical constituents. At summer temperatures, changes in nutrient 
speciation and concentration in stored samples can be rapid due to increased bacteria and 
phytoplankton abundance. As such, strict storage holding times need to be adhered to. Sample 
storage holding times adhered to by the IISD-ELA ASL for filtering and analyses are included 
for each applicable method. Quality control (QC) and quality assurance protocols are provided 
for each analysis. Details for how labware is cleaned, calibrated, and validated and how reference 
samples are prepared are also provided. 

The analysis results, QC results, and associated metadata are manually entered into the LIMS. 
Three quality statuses are applied to IISD-ELA ASL data. Data that has passed the analytical 
QC requirements are designated “Entered,” data that has been assessed for outliers is designated 
“Validated,” and data that has undergone peer review is designated “Approved,” though a process 
for peer review has not yet been developed. 

https://www.iisd.org/ela/
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2.0 Labware Cleaning

2.1 Introduction and scope
The following methods are used in the IISD Experimental Lakes Area Analytical Service 
Laboratory to clean the various labware.

2.2 Occupational health and safety
The concentrated hydrochloric acid (HCl) used for reagent preparation is corrosive and reacts 
violently with water. Handle in a fume hood to avoid HCl vapours. Avoid contact with skin. Wear 
goggles and gloves when handling and diluting. Always pour acid into water slowly while stirring. 
Never pour water into acid.

The use of extremely hot water could lead to burns. Wear rubber gloves when washing dishes. 

2.3 Equipment
	‒ dishwasher

	‒ scrub brushes of various sizes

	‒ drying racks

	‒ shallow bins lined with absorbent pads or mats

	‒ trays lined with absorbent pads or mats

	‒ large acid-resistant bin with a lid

2.4 Prepared reagents

2.4.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix® 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

2.4.2 Hydrochloric acid – 10% 

Dilute 100 mL of concentrated ACS-grade HCl in 800 mL of DRO and make to 1 litre. 

https://www.iisd.org/ela/
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2.5 Procedure

2.5.1 General use labware

General use labware (beakers, cylinders, sample bottles, etc.) is cleaned by rinsing three times 
with extremely hot running tap water followed by three rinses with DRO water. Rubber gloves are 
worn in order to utilize the hottest water possible and to ensure that finger marks are not left on 
the equipment.

After rinsing, the residual water is shaken out of the labware, and the labware is set upside down 
to drain and dry. Caps and small items are dried in a shallow bin lined with an absorbent pad. 
When the labware is dry, it is coupled with its appropriate cap, if needed, and is returned to its 
storage place. Aluminum foil is placed over the opening of any labware that does not have a cap/
lid (e.g. beakers, cylinders, etc.) to prevent dust contamination. 

2.5.2 Volumetric flasks

Volumetric flasks are cleaned in the same manner as general labware, but the water is warm rather 
than as hot as possible since heat can affect the accuracy of the volumetric glassware. 

2.5.3 Particulate (Part) P and Part Fe vials

The 40 mL glass Part P vials, polytetrafluoroethylene (PTFE)-lined caps, 20 mL high-density 
polyethylene (HDPE) Part Fe vials, and HDPE caps are rinsed three times with hot water, soaked 
in a 10% HCl bath for at least four hours, and then rinsed three times with DRO water. The vials 
and caps are dried in a shallow bin lined with an absorbent pad.

2.5.4 Dissolved organic carbon (DOC) and alkalinity bottles

The 175 mL HDPE DOC bottles and caps and the 125 mL HDPE alkalinity bottles and caps 
are inspected for adhered particulates and cleaned with a scrub brush as needed. The bottles are 
then washed, without detergent, in the dishwasher, and rinsed three times with DRO water. The 
175 mL polyethylene terephthalate glycol alkalinity bottles will melt in the dishwasher, so they 
are filled with hot water and soaked overnight, cleaned with a scrub brush as needed, rinsed three 
times with hot water, and then rinsed three times with DRO water.

After rinsing, the residual water is shaken out of the bottles, and the bottles are set upside down 
to drain and dry. Caps are dried in a shallow bin lined with an absorbent pad. Once the bottles 
are dry, they are capped and returned to their storage place.

https://www.iisd.org/ela/
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2.5.5 Petri dishes

The tops and bottoms of the 50 mm Petri dishes are washed separately so that they do not attach 
to each other during the cleaning process. Labels are removed and then the tops or bottoms of the 
Petri dishes are placed in a bucket with a lid, rinsed three times with hot water, and rinsed three 
times with DRO. The Petri dishes are laid out upside down on a tray lined with an absorbent 
pad. Once the tops and bottoms are dry, they are reassembled and stored in a large low-density 
polyethylene bag.

Appendix 2A. 10% Hydrochloric Acid Preparation Record

https://www.iisd.org/ela/
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3.0 Labware Calibration and Verification

3.1 Introduction and scope
Volumetric flasks, graduated cylinders, displacement pipettes, and lab balances are calibrated and/
or verified using the following procedures. 

3.2 Occupational health and safety
There are no occupational health and safety concerns associated with these procedures.

3.3 Equipment
	‒ balances

	‒ displacement pipettes (fixed, variable, and repeater)

	‒ Pipette Calibration logbook

3.3.1 Type 2 ultrapure deionized reverse osmosis (DRO) water 

3.3.2 Effluent from an Elix® 20 Water Purification System (> 5 MΩ∙cm purity)

The feedwater for the Elix 20 system is water from Lake 239 that is filtered through a 20", 
5-µm pleated paper filter, UV treated, and then filtered through an Extra Fine Pore Sediment 
Cartridge (Rainfresh), an Ion-Ex Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge 
(MilliporeSigma).

3.3.3 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q® Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

3.4 Laboratory balances
This procedure is based on the ASTM directive E898-88 (1993) Standard Method of testing Top-
Loading, Direct-Reading Laboratory Scales and Balances approved September 30, 1988. 

This calibration checks for off-centre loading errors, repeatability, hysteresis, precision, accuracy, 
and linearity. It is conducted when a new balance has been procured and when the balance has 
been recalibrated due to a daily calibration verification failure. All calibrations are performed 
under typical operating conditions (e.g. temperature, humidity). Additional tests are described in 

https://www.iisd.org/ela/


IISD.org/ela 7

The Chemical Analysis of Fresh Water

ASTM directive E898-88 (1993). Results of calibration checks are recorded in a logbook for each 
balance. 

Turn on the instrument and warm it up to the manufacturer’s specifications. Calibrate the 
balance using the manufacturer’s specifications, then run the internal calibration, if available, and 
perform the following tests. 

3.4.1 Off-centre error (eccentricity)

1.	 Zero the balance.

2.	 Place a weight that is 90–100% of the capacity of the balance in five different locations on 
the balance pan and record the readings:

	‒ centre

	‒ front edge

	‒ back edge

	‒ left edge

	‒ right edge

3.	 Calculate the eccentricity, which is the maximum difference from the centre. If the 
eccentricity exceeds 0.01 g, the balance is recalibrated.

3.4.2 Repeatability

1.	 Zero the balance.

2.	 Repeatedly (at least 8 times) measure a constant load, which is approximately 50% of 
capacity. The standard deviation, σ, of this series is the repeatability. If the repeatability 
exceeds 0.01 g, the balance is recalibrated.

3.4.3 Hysteresis

1.	 The balance reading depends on the direction from which it is approached.

2.	 Zero the balance and record it as Z1.

3.	 Place a weight of about 50% capacity on the balance and, when stable, record the reading 
as W1. 

4.	 Add weights to about 90% of capacity.

5.	 Remove weights added in the previous step to return to a mass of 50% capacity and 
record the reading as W2. 

6.	 Remove all weights and record the reading as Z2.

The hysteresis effect is calculated from equation 3.1:

https://www.iisd.org/ela/
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Equation 3.1	 h =  (W1− W2)+(Z1−Z2)
		

If the hysteresis exceeds 0.01 g, the balance is recalibrated.

3.4.4 Precision

Precision is the sum of h + σ.

3.4.5 Accuracy and linearity

1.	 Zero the balance and, if available, set the full-scale indication.

2.	 Place weights on the pan in increments of approximately 10% of capacity and record the 
readings. Plot the nominal weight versus the observed weight. 

3.	 The difference at any point is the inaccuracy, which by definition cannot be less than the 
precision since every observation has an uncertainty of as much as 3σ.

3.4.6 Daily calibration verification

The balance calibration is verified on a daily basis, prior to use. To verify the balance calibration, 
weigh a 50 g weight and 1.0 g weight and record the results in the balance’s logbook. If the weight 
obtained exceeds a difference of 0.01 g from the expected result, the balance is recalibrated.

3.5 Displacement pipettes
Fixed volume, variable volume, and repeater pipettes are calibrated annually, and the calibrations 
are verified weekly to ensure that they maintain a delivery volume and a coefficient of variation 
that are within the limits specified by the manufacturer. 

Pipettes are individually identified with a unique number and are marked as “Calibrated” with the 
calibration date. 

Different operators should conduct the pipette calibration verifications to ensure that all are using 
them identically. 

3.5.1 Calibration verification

Variable pipettes are tested at three volumes:

	‒ nominal volume (largest volume),

	‒ 50% of the nominal volume, and

	‒ 10% of the nominal volume.

2

https://www.iisd.org/ela/
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A table of weight ranges and target values is provided in the Pipette Calibration logbook (Appendix 
3A) to determine if the weights obtained are acceptable. 

All results are recorded directly in the Pipette Calibration logbook.

1.	 Place a covered beaker of Milli-Q water on the bench overnight so that the water can 
equilibrate to room temperature before use.

2.	 Confirm the balance accuracy by weighing 1 g and 5 g weights. Record the results in 
the balance’s logbook. If the weights obtained exceed the expected value by 0.0005 g, 
recalibrate the balance before proceeding to the pipette verification.

3.	 Place a weighing vessel (e.g. plastic weighing boat) on the balance and tare the balance.

4.	 Place the appropriate tip on the pipette to be verified, and pre-wet it five times to produce 
a humidity balance in the “dead” air volume.

5.	 Hold the pipette vertically and immerse the pipette tip a few millimetres into the water (2 
to 4 mm below the surface for volumes 1 to 1000 µL and 3 to 6 mm for volumes greater 
than 1000 µL). Slowly and evenly aspirate the appropriate volume of water. The filled tip 
is slanted against the wall of the weighing vessel and dispensed into the weighing vessel.

6.	 Once the balance has stabilized, record the weight in the Pipette Calibration logbook.

7.	 Re-zero the balance and repeat steps 5 and 6. At least three readings are required for 
adequate verification.

8.	 Repeat steps 3–7 for each pipette.

Pipettes that do not “Pass” both accuracy and precision requirements as outlined in the Pipette 
Calibration logbook must be taken out of service and have the “Calibrated” label removed. A 
“failed” pipette may have its calibration rechecked to verify that it has “failed” or show that 
the “failure” was in error. “Failed” pipettes must be repaired and/or recalibrated and “Pass” a 
calibration verification before being put back into service.

3.6 References
ASTM directive E898-88. (1993). Standard method of testing top-loading, direct-reading laboratory 
scales and balances (approved September 30, 1988). 

https://www.iisd.org/ela/
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Appendix 3A. Pipette Calibration Logbook

Date

Variable pipette (µL)
Analyst °C Analyst °C Analyst °C Analyst °C Analyst °C

0.6% Accuracy
0.3% Imprecision

Min wt 0.09907 1
Ideal Mean 

wt 0.09967 2

Max wt 0.10027 0.04229 3
0.6% Accuracy
0.2% Imprecision

Min wt 0.49537 1
Ideal Mean 

wt 0.49836 2

Max wt 0.50135 0.04229 3
0.6% Accuracy
0.2% Imprecision

Min wt 9.90739 1
Ideal Mean 

wt 9.96719 2

Max wt 10.02699 0.04229 3

Max diff 
between 
extremes

100 - 1000

100
Max diff 
between 
extremes

500
Max diff 
between 
extremes

1000

Balance ID

Date

0.6% Accuracy Analyst °C Analyst °C Analyst °C Analyst °C Analyst °C
0.2% Imprecision

Min wt 0.49537 1
Ideal Mean 

wt 0.49836 2

Max wt 0.50135 0.00212 3

0.6% Accuracy Analyst °C Analyst °C Analyst °C Analyst °C Analyst °C
0.2% Imprecision

Min wt 0.99074 1
Ideal Mean 

wt 0.99672 2

Max wt 1.00270 0.00424 3

Max diff 
between 
extremes

1000

500
Max diff 
between 
extremes

Pipette (µL)
Balance ID

https://www.iisd.org/ela/
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Date

Variable pipette (µL)
Analyst °C Analyst °C Analyst °C Analyst °C Analyst °C

1.0%
0.4%

Min wt 0.00987 1
Ideal Mean 

wt 0.00997 2

Max wt 0.01007 0.00006 3
0.7%
0.3%

Min wt 0.04949 1
Ideal Mean 

wt 0.04984 2

Max wt 0.05018 0.00021 3
0.6% Accuracy
0.3% Imprecision

Min wt 0.09907 1
Ideal Mean 

wt 0.09967 2

Max wt 0.10027 0.00042 3

10
Max diff 
between 
extremes

50
Max diff 
between 
extremes

10 - 100 

Balance ID

Max diff 
between 
extremes

100

Date

Variable pipette (µL)
Analyst °C Analyst °C Analyst °C Analyst °C Analyst °C

1.0% Accuracy
0.4% Imprecision

Min wt 0.01974 1
Ideal Mean 

wt 0.01993 2

Max wt 0.02013 0.00085 3
0.6% Accuracy
0.3% Imprecision

Min wt 0.09907 1
Ideal Mean 

wt 0.09967 2

Max wt 0.10027 0.00085 3
0.6% Accuracy
0.2% Imprecision

Min wt 0.19815 1
Ideal Mean 

wt 0.19934 2

Max wt 0.20054 0.00085 3

Max diff 
between 
extremes

20 - 200 

20
Max diff 
between 
extremes

100
Max diff 
between 
extremes

200

Balance ID

https://www.iisd.org/ela/
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Date

Variable pipette (µL)
Analyst °C Analyst °C Analyst °C Analyst °C Analyst °C

0.6% Accuracy
0.3% Imprecision

Min wt 0.09907 1
Ideal Mean 

wt 0.09967 2

Max wt 0.10027 0.04229 3
0.6% Accuracy
0.2% Imprecision

Min wt 0.49537 1
Ideal Mean 

wt 0.49836 2

Max wt 0.50135 0.04229 3
0.6% Accuracy
0.2% Imprecision

Min wt 9.90739 1
Ideal Mean 

wt 9.96719 2

Max wt 10.02699 0.04229 3

Max diff 
between 
extremes

100 - 1000

100
Max diff 
between 
extremes

500
Max diff 
between 
extremes

1000

Balance ID

Date

Variable pipette (µL)
Analyst °C Analyst °C Analyst °C Analyst °C Analyst °C

0.6% Accuracy
0.2% Imprecision

Min wt 0.49537 1
Ideal Mean 

wt 0.49836 2

Max wt 0.50135 0.04229 3
0.6% Accuracy
0.2% Imprecision

Min wt 2.47685 1
Ideal Mean 

wt 2.49180 2

Max wt 2.50675 0.04229 3
0.6% Accuracy
0.2% Imprecision

Min wt 9.90739 1
Ideal Mean 

wt 9.96719 2

Max wt 10.02699 0.04229 3

Max diff 
between 
extremes

5000

2500
Max diff 
between 
extremes

Max diff 
between 
extremes

500 - 5000

500

Balance ID

https://www.iisd.org/ela/
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Date

Variable pipette (µL)
Analyst °C Analyst °C Analyst °C Analyst °C Analyst °C

0.6% Accuracy
0.2% Imprecision

Min wt 0.99074 1
Ideal Mean 

wt 0.99672 2

Max wt 1.00270 0.04229 3
0.6% Accuracy
0.2% Imprecision

Min wt 4.95369 1
Ideal Mean 

wt 4.98359 2

Max wt 5.01349 0.04229 3
0.6% Accuracy
0.2% Imprecision

Min wt 9.90739 1
Ideal Mean 

wt 9.96719 2

Max wt 10.02699 0.04229 3

Balance ID

10000
Max diff 
between 
extremes

Max diff 
between 
extremes

5000

1000 - 10000

1000
Max diff 
between 
extremes

https://www.iisd.org/ela/
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4.0 Reference Sample Preparation

4.1 Introduction and scope
Reference samples are included in every analytical run to assess inter-run variability, verify that 
the calibration standards have been prepared properly, and ensure that the method is providing 
accurate results. 

4.2 Occupational health and safety
The muffle furnace, used to bake GF/C filters, is set to 500 °C and thus presents a risk for burns 
when handling the furnace and items baked therein. To reduce the risk of burns, vials and trays 
are placed into the muffle furnace prior to turning it on. Allow the vials and trays to cool down 
and use protective gloves and/or tongs when removing them. Do not leave the muffle furnace 
door open to cool. Post a HOT warning to caution other lab staff about the risk of burns from the 
muffle furnace or items baked in the muffle furnace.

4.3 Equipment
	‒ filtration apparatus with a 47-mm diameter magnetic filter funnel

	‒ vacuum desiccator

	‒ 42.5 mm GF/C filters, baked for 14 hours at 500 °C

	‒ 50-mm Petri dishes

	‒ flat-ended filter forceps

4.4 Purchased reagents

4.4.1 PO4-3 calibration standard stock

Certified commercial PO4-3-P standard

1.0 mL = 50 ± 1 µg PO4-3-P                                     

Store at 2–6ºC until the expiry date on the manufacturer’s label.

4.4.2 NO2 calibration standard stock

Certified commercial NO2-N standard

	 1.0 mL = 0.1 ± 0.01 mg NO2-N
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Standard is stable until the expiry date on the manufacturer’s label.

4.4.3 NH3 calibration standard stock

Certified commercial NH3-N standard

	 1.0 mL = 0.1 ± 0.01 mg NH3-N

Standard is stable until the expiry date on the manufacturer’s label.

4.5 Prepared reagents

4.5.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20”, 5-µm pleated paper filter, 
UV treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-
Ex Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma). 

4.5.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

4.5.3 Desiccant

The silica gel desiccant is baked at 120 °C for at least 24 hours prior to use.

4.6 Procedures

4.6.1 Collection and aging

The reference sample water is collected by pumping Lake 239 surface water into a black 
55-gallon drum and aged for at least one year at 4 °C to ensure that the analytes have reached 
equilibrium and will no longer change over time.

4.6.2 Bottling

Once the reference sample water has been aged for at least one year, it is homogenized as best 
as possible by rolling the barrel on its side. The reference sample is then pumped into pre-rinsed 
2-L glass bottles and stored at 4 °C. Each reference sample bottle is assigned a lot number, in the 
format “Byyyymmdd-#,” wherein yyyymmdd represents the date it was bottled and -# represents 
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each bottle’s unique ID. The collection date, bottling date, assigned lot numbers, and analyst’s 
initials are recorded in the Reagent Preparation logbook.

The aged and bottled reference sample is used for all analyses that are performed on unfiltered 
samples, namely pH, conductivity, turbidity, and dissolved inorganic carbon (DIC). The aged and 
bottled reference sample is also used to prepare the soluble reactive silica reference sample. 

4.6.3 Filtering

Reference sample water that has been aged for at least one year is filtered through 1.2 µm 
GF/C filters that had been baked at 500 °C for 14 hours and stored in pre-rinsed 2-L glass 
bottles at 4 °C. Each filtered reference sample bottle is assigned a lot number, in the format 
“Fyyyymmdd-#,” wherein yyyymmdd represents the date it was filtered and -# represents each 
bottle’s unique ID. The filtration date, bottling date, filtration volume, filter type, filter pore size, 
assigned lot numbers, and analyst’s initials are recorded in the Reagent Preparation logbook.

The filtered reference sample is used for total dissolved nitrogen, absorbance scans, and the 
preparation of the total dissolved phosphorus, nitrite, nitrate, and ammonia reference sample 
preparation. The filtered reference sample for absorbance scans is aliquoted into an amber bottle 
to reduce light exposure. 

4.6.4 Soluble reactive silica

The concentration of soluble reactive silica (SRSi) in the unfiltered reference sample is above 
the concentration range of the SRSi analysis (i.e. 2.5 mg/L; ELA-SRSi_v3.1) and thus requires 
dilution. The reference sample for SRSi is prepared by diluting the unfiltered reference sample 
by a factor of two with Milli-Q water. The SRSi reference sample is assigned a lot number in 
the format SRSiyyyymmdd-#, wherein yyyymmdd represents the date it was filtered and -# 
represents each bottle’s unique ID. The preparation date, filtered reference sample lot number, 
reference sample volume, final volume, dilution factor, assigned lot number, and analyst’s initials 
are recorded in the Reagent Preparation logbook. The SRSi reference sample is stored at room 
temperature.

4.6.5 Total dissolved phosphorus 

The concentration of total dissolved phosphorus (TDP) in the filtered reference sample is below 
the detection limit of the TDP analysis (ELA-TDP_v3.0). As such, the filtered reference sample 
is spiked with 0.5 mL of the 50 µg/mL PO4-3-P calibration standard stock per litre of filtered 
reference sample (final concentration of 25 µg/L). The TDP reference sample is assigned a lot 
number in the format TDPyyyymmdd-#, wherein yyyymmdd represents the date it was filtered 
and -# represents each bottle’s unique ID. The preparation date, filtered reference sample lot 
number, concentration, volume, manufacturer material lot number of the calibration standard, 
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final volume, final concentration, assigned lot number, and analyst’s initials are all recorded in the 
Reagent Preparation logbook. The TDP reference sample is stored at 4 °C. 

4.6.6 Nitrite, nitrate, and ammonia 

The concentration of nitrate in the filtered reference sample is above the concentration range 
of the nitrate analysis (i.e. 100 µg/L; ELA-NOxNH3_v2.0) and the nitrite and ammonia 
concentrations are below the detection limit (i.e. 0.5 and 10.6 µg/L, respectively). As such, 
the reference sample for the ELA-NOxNH3_v2.0 analysis is prepared by diluting the filtered 
reference sample by a factor of two with Milli-Q water and spiked with 0.25 mL of the 0.1 mg/
mL NO2-N calibration standard stock and with 2.5 mL of the 0.1 mg/mL NH3-N calibration 
standard stock per litre of diluted filtered reference sample (final concentration of 25 µg/L and 
250 µg/L for NO2-N and NH3-N, respectively). This NOxNH3 reference sample is then preserved 
with chloroform at a concentration of 1 mL/L and stored at 4 °C. The NOxNH3 reference sample 
is assigned a lot number in the format “NOxNH3yyyymmdd-#,” wherein yyyymmdd represents 
the date it was filtered and -# represents each bottle’s unique ID. The preparation date, filtered 
reference sample lot number, dilution factor, concentration, volume, manufacturer material lot 
numbers of the NO2 and NH3 calibration standards, final volume, final concentrations, assigned 
lot number, and analyst’s initials are all recorded in the Reagent Preparation logbook.

4.6.7 Chlorophyll-a, particulate phosphorus, and particulate iron

The chlorophyll-a (Chl-a), particulate phosphorus (Part P), and particulate iron (Part Fe) 
reference samples are comprised of GF/C filters with retained seston. A water sample is collected 
from the epilimnion of Lake 227 during peak phytoplankton biomass. The collected water sample 
is transferred to a container with a spigot and continuously homogenized with a stir bar and stir 
plate. Fifty-millilitre aliquots are filtered through baked GF/C filters that were pre-rinsed with 
50 mL of Milli-Q water. Each reference sample filter is placed in a labelled 50-mm Petri dish, 
desiccated in the dark in a vacuum desiccator, and stored in the dark at -20 °C. The Chl-a and 
Part Fe reference samples are assigned a lot number in the format “Partyyyymmdd-##”, wherein 
the yyyymmdd represents the date the samples were prepared and the -## represents each filter. 
The sample description (e.g. 227 LA CB 5m), date sampled, filtration date, volume filtered, 
GF/C lot number, assigned lot numbers, and analyst’s initials are all recorded in the Reagent 
Preparation logbook.
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Appendix 4A. Reference Sample Bottling Preparation Record
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Appendix 4B. Reference Sample Filtration Preparation 
Record
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Appendix 4C. Soluble Reactive Silica Reference Sample 
Preparation Record
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Appendix 4D. Total Dissolved Phosphorus Reference Sample 
Preparation Record
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Appendix 4E. Nitrite, Nitrate, and Ammonia Reference 
Sample Preparation Record

https://www.iisd.org/ela/


IISD.org/ela 23

The Chemical Analysis of Fresh Water

Appendix 4F. Chlorophyll-a and Particulate Iron Reference 
Sample Preparation Record
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5.0 Laboratory Information Management 
System – Sample Master®

5.1 Introduction and scope
Laboratory information management software (Sample Master®) is used to track samples 
and record data and metadata for each sample. Each sample that is processed by the IISD 
Experimental Lakes Area Analytical Service Laboratory is logged into Sample Master with its 
requested tests and collection metadata (e.g. Site, Collect Date, etc.) and is assigned a Sample 
ID. Sample Master is also used to generate sample labels, record and track quality control, and 
retrieve data. 

5.2 Equipment
	‒ computer with Windows Server operating system, SQL Server Express, SQL Server 
Management Studio, Sample Master version 10 (Web), and Crystal Reports installed

	‒ Honeywell Intermec Easy Coder PD41 printer equipped with Honeywell Intermec 
Duratherm II Thermal Labels, 1" × 2" (p/n E25762)

	‒ HP Color LaserJet MFP M283 printer.

5.3 Sample login
Samples for each project (e.g. L239 profile) are logged in as an “order,” which is assigned 
an Order ID in the format “yyyymmdd##” wherein the yyyymmdd represents the date that 
the sample was logged in. Each sample in the order is assigned a Sample ID in the format 
“yyyymmdd##-##” wherein the yyyymmdd## represents the Order ID. Blanks should be the 
first order logged in each day. 

Any sample that is attempted to be collected is logged in. If that sample is not available (e.g. 239 
NE@LA is not flowing), that sample is cancelled (not deleted) in the Order Details page (Edit > 
Cancel Sample), and the reason for the cancellation is recorded. This provides a record that the 
collection was attempted but that the sample was not available for the given reason.
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5.3.1 Login order

1.	 Login to Sample Master with username and password and navigate to Sample Tracking > 
Sample Login

This page provides the metadata for the order, which includes the Order ID, Order date, 
user that signed it in, Customer ID, Customer Contact, Billing ID, Billing Contact, and 
Project ID.

2.	 Click New Order ID, select Login, and click Submit

Select appropriate Customer ID (use the “Requested Analyses” spreadsheet) and 
appropriate Project ID (e.g. 239 Profile). Click Yes when prompted by “Would you like to 
add samples and Tests associated with [Project ID]?”

3.	 Click Samples to retrieve the Order Details page

This page lists all of the samples and the associated metadata for each sample, which 
includes the Sample ID, Customer Sample ID, Site, Matrix, Collector, Date Collected, 
Time Collected, Date Received, Start Depth and End Depth (for depth-integrated 
lake samples), and Start Collect Date, End Collect Date, Rain Gauge, and Observed 
Precipitation Volume (for precipitation samples). 

a.	 Ensure that all of the appropriate samples (i.e. correct sites) were added and enter 
all relevant metadata.

b.	 If the order includes a field duplicate, highlight the sample to be duplicated, hover 
over Edit, and click Copy Sample. Ensure that all of the boxes are clicked, except 
Cust. Sample ID, and click OK.

4.	 Verify that the appropriate tests are requested for each sample by selecting a sample and 
clicking Tests to retrieve the Sample Details page, which includes all of the requested tests, 
as well as the metadata for each requested test (i.e. Method, Prep Method, Due Date, 
Preservative, Bottle Type, # Hauls, Equipment Code, Net Diameter, and Total Depth). 

5.3.2 Save Login Report

The Login Report provides a concise record of the details of each order.

Return to the Sample Login page, hover over Edit, and click Calculate Due Dates. 

Retrieve the Login Report by hovering over Print and clicking Login Report. Review it to make 
sure everything is correct. Click the download icon and save the Login Report in \\ela-lab.iisd.
ca\shared\Chem Lab\Sample Master\Login Reports in the format “yyyymmdd##_LoginReport” 
wherein the yyyymmdd## represents the Order ID.
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Figure 5.1. Example login report 
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5.3.3 Print sample labels 

Return to the Sample Login page, hover over 
Print, and click Sample Labels to retrieve the 
sample labels. Click the print icon, ensure that 
EasyCoder PD41 (203 dpi) – IPL is selected, 
and click Print. 

5.3.4 Sample summary 

Continue to log in orders, as outlined above, 
until all the samples for the day have been 
logged in. 

Retrieve the daily Sample Summary by hovering over Print, clicking Summary, selecting the 
appropriate Start of Range and End of Range, and clicking OK. Click the print icon, ensure 
that HP LaserJet 4050 is selected, and click Print. The Sample Summary is then used to 
record filtration volumes, start depths, end depths, start dates, end dates, rain gauges, observed 
precipitation volumes, and any other metadata (e.g. notes/comments) for each sample, which are 
later recorded in Sample Master.

Figure 5.3. Example sample summary

5.3.5 Order signoff

The orders are signed off by hovering over Edit and clicking Order Signoff. Mark all of the orders 
and click Signoff. 

Figure 5.2. Example sample label
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5.4 Sample preparation
The lot numbers of the GF/C filters that are 
used for each test sample are recorded in 
Sample Master.

To enter GF/C lot numbers, navigate to 
Sample Tracking > Sample Preparation, ensure 
that “Unassigned Samples” is checked, and 
query the samples by filtering the test for 
Archive, Chl-a, Part C/N, Part Fe, and Part P. 
Click the check box to mark the appropriate 
sample(s), select the appropriate GF/C 
lot number from the drop-down menu (if 
available), and click Add to Batch. 

If not available, add the GF/C lot number by clicking New…, entering the GFC lot number in the 
Prep Filter Lot field and the date the first GF/C from that lot was used in the Date Prepared field 
(leave Matrix, Test, Method, and Supply Name blank), and clicking OK.

5.4.1 Enter prep volumes

The Analysis Volumes recorded in Sample Master are configured with the default volumes for the 
Archive, Chl-a, Part C/N, Part Fe, and Part P tests. If the actual volume filtered is adjusted from 
the default filtration volume, the Analysis Volume needs to be revised to the adjusted filtration 
volume. 

To revise the Analysis Volume, navigate to Sample Tracking > Enter Prep Volumes, and query the 
samples by filtering by the appropriate Order ID(s) or Sample ID(s).

Revise the “AnalysisVolume” of any test samples that had filtration volumes that were adjusted 
from the default and click Update.

5.4.2 Create QC Batch

A QC Batch is created prior to data entry to assign quality control (QC) samples (e.g. reference 
standards, duplicates, etc.) to the batch of samples in the analytical run.

To create a QC Batch, navigate to Sample Tracking > Create QC Batch, ensure that “Unassigned 
Samples” is checked, select the appropriate Test from the drop-down menu, and click Retrieve.

Mark the samples to be included in the batch and click New… to create a new QC Batch ID.

Table 5.1. Default filtration volumes

Test Default Vol. (mL)

Archive 200

Chl-a 200

Part C/N 200

Part Fe 100

Part P 100
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Note: To mark all of the samples, click the box in the header between “Test” QC Batch 
ID.” Alternatively, batches of samples can be marked by typing or selecting a number in 
the drop-down menu next to Mark and clicking Mark.

Ensure that the appropriate Instrument, Matrix, and Test are selected and select the appropriate 
Method from the drop-down menu. 

Ensure that the appropriate QC Types are marked and click Create Run Sequence (do not click 
OK) to reach the QC Batch – Edit Sequence page, wherein the sample sequence order and number 
of QC Types (e.g. Method Blank, Instrument Duplicate, etc.) can be adjusted. 

Adjust the number of each QC Type by choosing the QC Type from the “Add QC:” menu and 
clicking the right-arrow to add it to the Batch Sequence. 

To adjust the sequence order, highlight the sample or QC Type to be adjusted and use the up 
arrow or down arrow to move it to the desired sequence number.

Once the Batch Sequence includes all of the samples, the appropriate number of each QC Type, 
and the desired sequence order, click OK.

Note: If Create Run Sequence is not clicked, the Run Sequence is not created, and the run 
sequence order and QC Samples can never be adjusted. If this occurs, a new QC Batch 
ID needs to be created. To return to the Run Sequence page, hover over Edit and click 
Edit Run Sequence.

For each required duplicate, select the 
appropriate Order ID and Sample ID to be 
duplicated from the drop-down menus. 

To print the Run Sequence BenchSheet, 
ensure that the samples are still marked, hover 
over Print, and click Run Sequence BenchSheet. 
Click the print icon, ensure that HP LaserJet 
4050 is selected, and click Print.

5.4.3 Enter data

Once the analysis is complete and a QC Batch has been generated, navigate to Data Entry > 
Result Entry to record the results of the analysis. 

Samples that have passed the analytical quality control parameters are Entered into Sample 
Master along with the results of the associated quality control parameters. Samples that have 
passed the trend analysis are Validated. Samples that have undergone external peer review are 
Approved. A process for external peer review has not yet been developed. 

Query the appropriate QC Batch ID and click Retrieve. Select Results to Enter. 

Figure 5.4. Drop-down menus for 
duplicates
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In the “Sample Results” tab, enter the “Result” for each sample as well as the “Analysis 
Employee,” “ParamAnalyst,” “Analysis Date,” and “ParamAnalysisDate.” 

In the “Spike Results” tab, enter the results of the reference standards, reference samples, nitrate 
conversions (if applicable), urea conversions (if applicable), and duplicates (e.g. instrument 
duplicate, method duplicate, etc.) as well as the “ParamAnalyst” and the “ParamAnalysisDate.”

In the “Blank Results” tab, enter the results of the blanks (e.g. reagent blanks, method blanks, 
etc.), as well as the “ParamAnalyst” and “ParamAnalysisDate.” 

Once all of the data and metadata have been entered, click Enter. The samples will now be 
transferred to “Results to Validate.” 

5.5 Trend analysis
Trend analysis is conducted on each site/parameter combination using historical data to assess 
data for outliers while taking seasonal dynamics into account. Outliers are investigated and either 
retained or rejected in Sample Master depending on the revelations of the investigation. All of the 
samples that have undergone trend analysis are “Validated” for that site/parameter combination. 

To conduct a trend analysis, navigate to Data Entry > Trend Analysis, query for the appropriate site 
(e.g. L239 EIF) and parameter (e.g. NO2-N), and click Retrieve. Mark all of the samples by 
clicking the box between “Parameter” and “Results” and click Chart. Assess the chart for and 
record any outliers, as well as any information about the outlier (e.g. result is high) in the cell that 
represents the site/parameter combination in the Trend Analysis spreadsheet. If no outliers exist, 
put an “X” in the cell that represents the site/parameter combination. 

Continue conducting the trend analysis for all 
site/parameter combinations.

To “Validate” samples, navigate to Data 
Entry > Result Entry, query for the samples 
by filtering by the site and parameter 
combination, and click Retrieve. Click Results 
to Validate, mark all of the samples, except for 
the outliers, and click Validate. 

5.6 Data retrieval
All nutrient chemistry data and associated metadata for samples collected after May 2017 can be 
retrieved from Sample Master. 

There are two ways you can retrieve data using Sample Master: Data Entry > Result Entry and 
Data Entry > Dynamic EDD Generator. Using Result Entry retrieves the analytical results and 
analysis-based metadata (e.g. analysis employee, analysis date, method, instrument, etc.); it 

Figure 5.5. Subsection of Trend Analysis 
spreadsheet
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does not include sample-based metadata (e.g. start depth, end depth, etc.). The Dynamic EDD 
Generator is used when sample-based metadata is required as it provides metadata from any of the 
background tables (e.g. Sample Login, Enter Prep Volumes, etc.). 

5.6.1 Result Entry

Results can be retrieved by navigating to Data Entry > Result Entry and querying for content in 
various fields (e.g. Customer ID, Test, Site, Project ID, Collect Date, etc.). Select the desired 
content you would like to filter for from each of the desired fields using their associated drop-
down menus and/or date fields and click Retrieve. 

Figure 5.6. Result Entry query page

Example: To query for all chlorophyll-a (Chl-a) collected from 239 LA CB Epi from 
January 1, 2020, to December 31, 2021, select “Chl-a” in the Test drop-down menu, “239 
LA CB Epi” in the Site drop-down menu, input 01/01/2020 in the start collect date and 
12/31/2020 in the end collect date fields, and click Retrieve.
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To query for multiple contents within a field (e.g. NO2, NO3, and NH3 in the Test field), click 
the “+” button next to the field to retrieve a list page. Double-click on the empty field below the 
list section to reveal a hidden drop-down menu. Select the desired content to filter for and hit 
Enter to add it to the list. Continue selecting and adding desired content to the list. Once all of 
the desired contents are added to the list, click OK. Continue to add filters to additional fields 
and then click Retrieve. 

Figure 5.7. List page to select multiple tests for addition to the Result Entry query

The retrieved Results Entry page lists the Test Parameter result for each sample, along with the 
associated metadata listed in Table 5.2. When “All Results” is selected, all samples collected, 
regardless of Status (i.e. Awaiting Entry, Awaiting Validation, or Awaiting Approval), are listed. 
When “Results to Enter” is selected, all of the samples that are awaiting entry are listed. When 
“Results to Validate” is selected, all of the samples that have been entered but have not yet 
undergone trend analysis are listed. When “Results to Approve” is selected, all of the samples that 
have been Validated but have not yet been peer-reviewed are listed.

Double click here
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Table 5.2. Sample metadata available in Sample Master in Result Entry

Order ID

Sample ID 

Site (e.g. 239 LA CB Epi)

Date Collected

Test

Parameter

Units

Rep. Limit (LOD)

Instrument

Analysis Employee

Analysis Date

Method

Matrix

Entered By

Entered Date

Validated By

Validated Date

Approved By

Approved Date

QC Status (i.e. Awaiting 
Entry, Awaiting Validation, or 
Awaiting Approval)

To export results to Excel, hover over File > Export to Excel. The exported Excel file will pop up 
and automatically download to the Downloads folder.

Figure 5.8. Example Result Entry page
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5.6.2 Dynamic EDD Generator

The Dynamic EDD Generator is used to retrieve results and metadata from any background 
table. Navigate to Data Entry > Dynamic EDD Generator, query for desired samples in the same 
manner as the Result Entry query, and click Retrieve. A list of samples will appear. Select each 
desired sample by marking the box next to it. To select all samples, click the check box at the top 
of the table. Click EDD Generator. 

Select desired fields from the “FieldName” list by clicking its associated box in the Mark column. 
Please note that the Dynamic EDD Generator lists the default caption for each field rather than 
the user-defined custom caption. Table 5.3 can be used as a guide for selecting the proper default 
caption field.

Once all of the desired fields have 
been added to the list, click either 
the .csv or .xls button and click 
Export. The exported Excel file 
will pop up and automatically 
download to the Downloads folder. 

The list of desired fields can be 
saved as a template. Provide a 
name for the template in the Save 
Template field and click Save 
Template. This template is now 
available for future use.

Table 5.3. Custom captions legend

Default caption Custom caption

OrderDetails_User1 Start Depth (m)

OrderDetails_User2 End Depth (m)

OrderDetails_User3 Comment

OrderDetails_User4 Rain Gauge (mm)

OrderDetails_User5 Observed Precip. Vol. (L)

SampleDetails_User1 # of Hauls

SampleDetails_User2 Equipment code

SampleDetails_User3 Net diameter (cm)

SampleDetails_User4 Total depth (m)

https://www.iisd.org/ela/


IISD.org/ela 35

The Chemical Analysis of Fresh Water

6.0 Sample Preparation and Filtration

6.1 Introduction and scope
Samples are collected in the field in polyethylene bottles and insulated during transport to 
prevent them from heating in the summer and freezing in the winter. Laboratory information 
management software (Sample Master) is used to track samples and record data and metadata 
for each sample. Subsamples are aliquoted into labelled containers for analyses conducted on 
unfiltered water. Additional subsamples are filtered through a series of 1.2-µm glass microfibre 
filters. The filtrate and each filter are retained to conduct analyses on the dissolved and particulate 
fractions, respectively. 

Table 6.1. Chemical constituents analyzed in unfiltered filtered and particulate samples

Unfiltered Filtered Particulate

conductivity

dissolved inorganic carbon

Gran alkalinity

pH

phytoplankton taxonomy

soluble reactive silica

absorbance scan (200-800 nm)

anions (Cl and SO4)

ammonia (as N)

cations (Na, Mg, K, Ca, Mn, and Fe)

dissolved organic carbon

nitrate (as N)

nitrite (as N)

total dissolved nitrogen

total dissolved phosphorus

chlorophyll-a

particulate carbon

particulate iron

particulate nitrogen

particulate phosphorus

6.2 Method principle
It is essential to filter samples as soon as possible (within hours) after collection. This permits 
the distinction between dissolved and particulate phases and minimizes changes in sample 
composition arising from biological uptake and excretion. Since parameters differ in their 
storage condition and time limits, it is useful to subdivide a sample into different containers, 
each receiving appropriate storage treatment. The sample handling scheme found useful in our 
laboratory appears in Figure 6.1.

Particulate samples are obtained for chlorophyll-a, particulate carbon and nitrogen, particulate 
phosphorus, and particulate iron when needed. An archive particulate sample is also obtained 
as a backup for any of these analyses. Filtrate is divided into four portions (Figure 6.1): one 
for nutrients that have short-term storage requirements (Table 6.1); one for absorbance scan, 
which is stored in low light conditions; one for anions and cations, which are outsourced to an 
external laboratory; and one for dissolved organic carbon. The unfiltered sample is sub-divided 
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into dissolved inorganic carbon, which is stored at 4 °C and analyzed within 24 hours; pH and 
conductivity, which is equilibrated to 25 °C in a water bath prior to analysis; soluble reactive 
silica, which is stored at room temperature; phytoplankton taxonomy, which is preserved with 
Lugol’s solution; and alkalinity, which is outsourced to an external laboratory. Dissolved and 
particulate phases are operationally defined by what passes through or is retained on a pre-ignited 
(14 hours at 500 °C) Whatman GF/C glass fibre filter.

While several preservation methods are widely used (Brezonik & Lee, 1966; Hellwig, 1964; 
Moore & Locke, 2013), none are satisfactory for preserving samples for all analyses. Freezing 
samples inevitably produces a freeze concentration causing precipitation of silicon in neutral 
to acidic waters and meta salts in alkaline waters. These precipitates often do not quantitively 
redissolve on thawing. For nutrient analysis, we have found no substitute for rapid analysis. The 
permissible storage times listed in Table 6.1 are a compromise between desirable and logistically 
possible time limits. 

6.3 Occupational health and safety
The muffle furnace, used to bake GF/C filters, is set to 500 °C and thus presents a risk for burns 
when handling the furnace and items baked in the furnace. To reduce the risk of burns, vials 
and trays are placed into the muffle furnace prior to turning it on. Allow the vials and trays to 
cool down and use protective gloves and/or tongs when removing them. Do not leave the muffle 
furnace door open to cool. Post a HOT warning to caution other lab staff about the risk of burns 
from the muffle furnace or items baked therein.

6.4 Sample conditions
The processing and holding times described are designed for dilute Canadian Shield waters (e.g. 
IISD-ELA samples); samples from other sources (e.g. marine) may have other requirements. This 
is discussed with clients who bring samples from other sources. Sampling and adherence to IISD-
ELA sampling protocols are the client’s responsibility.

Samples are stored at 4 ± 2 °C and filtered within 24 hours of sample collection.  

Default filtration volumes are 200 mL for chlorophyll-a, particulate carbon and nitrogen, and 
archive samples and 100 mL for particulate phosphorus samples. If the filter clogs prior to 
reaching these volumes, the volume filtered is reduced accordingly and the actual filtered volume 
is recorded on the sample label, in the Sample Summary, and in Sample Master. Alternative 
filtration volumes are available upon request but are contingent on sufficient sample volume being 
supplied by the client.
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6.5 Equipment
	‒ filtration apparatus with two 47-mm diameter magnetic filter funnels, one 25-mm 
diameter filter funnel, and three rinse water collection bottles. The filtration apparatus is 
set up to collect both the filter and the filtrate.

	‒ vacuum desiccator

	‒ 25-mm GF/C glass fibre filters, baked for 14 hours at 500 °C

	‒ 42.5-mm GF/C glass fibre filters, baked for 14 hours at 500 °C

	‒ flat-ended filter forceps

	‒ 250-mL graduated cylinder

	‒ 500-mL narrow-mouth polyethylene terephthalate glycol (PETG) bottles

	‒ 175-mL square wide-mouth high-density polyethylene (HDPE) bottles

	‒ 125-mL narrow-mouth HDPE bottles with polyethylene caps

	‒ 125-mL narrow-mouth HDPE bottles conical caps

	‒ 50-mL conical tubes

	‒ 20-mL HDPE vials with polypropylene caps

	‒ 20-mL HDPE vials with polypropylene caps – acid washed

	‒ 40-mL glass vials with conical caps

	‒ 15-mL glass vials with polytetrafluoroethylene (PTFE)-lined polypropylene caps – acid 
washed

	‒ 4 × 50-mm Petri dishes

	‒ 500 µL pipette and 1,000 µL pipette tips

6.6 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of the new reagent.

	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

	‒ Reagents and standards are stable at room temperature unless otherwise specified.
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6.6.1 Type 2 ultrapure deionized reverse osmosis water (DRO)

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma). 

6.6.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

6.6.3 Lugol’s solution

	‒ 100 g potassium iodide

	‒ 50 g iodine

	‒ 100 mL glacial acetic acid

Dissolve the potassium iodide, iodine, and glacial acetic acid into ~700 mL Milli-Q water and 
dilute to 1 L with Milli-Q water. Store at room temperature in an amber glass bottle with a cap 
and a conical insert. 

6.6.4 Desiccant

The silica gel desiccant is baked at 120 °C for at least two hours prior to use.

6.7 Quality control
Several provisions are taken to reduce and quantify contamination at various stages of sample 
preparation, as well as to provide an estimation of sample duplication—from sampling through 
analysis. 

6.7.1 GF/C procurement and preparation

Whatman GF/C glass microfibre filters, 42.5 mm, are procured in quantities of at least 40 boxes 
(100 filters/box) from the same lot. The GF/C filters are baked at 500 °C for 14 hours and then 
placed into acid-washed wide-mouth glass jars using forceps. The lot numbers of the GF/C used 
for each test sample are recorded in Sample Master. 

6.7.2 Filter blanks

A filter blank, consisting of a baked 42.5-mm GF/C filter, is collected for particulate phosphorus 
each day that samples are filtered.
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6.7.3 Method blanks

Filter method blanks are prepared by filtering 100 mL of Milli-Q water through 42.5-mm GF/C 
filters for particulate iron and particulate phosphorus and by filtering 200 mL of Milli-Q water 
through a 25-mm GF/C filter for particulate carbon and nitrogen each day that samples are 
filtered for these analyses. 

Method blanks, consisting of Milli-Q water, are collected each day that samples are prepared 
for tests that have greater than one-month storage holding times—i.e. alkalinity, anions, cations, 
dissolved organic carbon, and soluble reactive silica. 

6.7.4 Field duplicate

A field duplicate is collected each day that samples are submitted to the lab and is analyzed for 
the full suite of analyses. 

6.7.5 Duplicate filtration

Duplicate filtrations to collect method duplicates for particulate tests are generally not conducted. 
However, duplicate filtrations are available upon request, provided a sufficient volume of sample 
is supplied. 

6.8 Logging samples into Sample Master
Samples for each project (e.g. L239 profile) are logged in as an “order,” which is assigned 
an Order ID in the format “yyyymmdd##” wherein the yyyymmdd represents the date that 
the sample was logged in. Each sample in the order is assigned a Sample ID in the format 
“yyyymmdd##-##” wherein the yyyymmdd## represents the Order ID. Blanks should be the 
first order logged in each day. 

Any sample that is attempted to be collected is logged in. If that sample is not available (e.g. 239 
NE@LA is not flowing), that sample is cancelled (not deleted) in the Order Details page (Edit > 
Cancel Sample), and the reason for the cancellation is recorded. This provides a record that the 
collection was attempted but that the sample was not available for a given reason.

1.	 Login to Sample Master® and navigate to Sample Tracking > Sample Login.

This page provides the metadata for the order, which includes the Order ID, Order date, 
user that signed it in, Customer ID, Customer Contact, Billing ID, Billing Contact, and 
Project ID.

2.	 Click New Order ID, select Login, and click Submit.

Select the appropriate Customer ID (use Requested Analyses spreadsheet) and appropriate 
Project ID (e.g. 239 Profile). Click Yes when prompted with “Would you like to add 
samples and Tests associated with [Project ID]?”
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3.	 Click Samples to retrieve the Order Details page.

This page lists all of the samples and the associated metadata for each sample, which 
includes Sample ID, Customer Sample ID, Site, Matrix, Collector, Date Collected, Time 
Collected, Date Received, Start Depth, End Depth, Start Collect Date, End Collect 
Date, Rain Gauge, and Observed Precipitation Volume. Ensure that all of the appropriate 
samples (i.e. correct sites) were added and enter all relevant metadata.

If the order includes a field duplicate, highlight the sample to be duplicated, hover over 
Edit, and click Copy Sample. Ensure that all of the boxes are clicked, except Cust. Sample 
ID, and click OK.

4.	 Verify that the appropriate tests are requested for each sample by selecting a sample and 
clicking Tests to retrieve the Sample Details page, which includes all of the requested tests 
as well as the metadata for each requested test (i.e. Method, Prep Method, Due Date, 
Preservative, Bottle Type, # Hauls, Equipment code, Net Diameter, and Total Depth). 

5.	 Return to the Sample Login page, hover over Edit, and click Calculate Due Dates. 

Retrieve the Login Report by hovering over Print and clicking Login Report. Review it 
to make sure everything is correct. Click the download icon and save the Login Report 
in \\ela-camp.iisd.ca\shared\Chem Lab\Sample Master\Login Reports in the format 
“yyyymmdd##_LoginReport” wherein the yyyymmdd## represents the Order ID.

Return to the Sample Login page, hover over Print, and click Sample Labels to retrieve 
the sample labels. Click the print icon, ensure that EasyCoder PD41 (203 dpi) – IPL is 
selected, and click Print. 

6.	 Once all of the Orders have been logged in, retrieve the daily Sample Summary by 
hovering over Print, clicking Summary, selecting the appropriate Start of Range and End 
of Range, and clicking OK. Click the print icon, ensure that HP LaserJet 4050 is selected, 
and click Print. The Sample Summary is then used to record filtration volumes, start 
depths, end depths, start dates, end dates, rain gauges, observed precipitation volumes, 
and any other metadata (e.g. notes/comments) for each sample, which are later recorded 
in Sample Master. 

6.9 Sample preparation and filtration
1.	 Clients are provided with three 125-mL narrow-mouth HDPE bottles, two of which 

should have conical inserts in the caps, and two 500-mL narrow-mouth HDPE bottles 
for each sample. If the sample is anaerobic, a PETG bottle is used instead of the 125-mL 
HDPE bottle with the regular cap to prevent oxygen diffusion into the sample.

2.	 Using the labels generated by Sample Master, label each of the bottles, vials, and Petri 
dishes according to Figure 6.1. The three 125-mL bottles and the two 500-mL bottles 
filled with sample are labelled once they are received from the client.
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3.	 Once the samples arrive, label the dissolved inorganic carbon (DIC), pH/Cond, and 
alkalinity samples according to Figure 6.1. Store the pH/Cond sample in the 25 °C water 
bath and store the DIC and alkalinity samples at 4 °C. Label the two 500-mL unfiltered 
water samples with “Filtration” labels and retain for subsequent filtration.

4.	 Turn on the vacuum line and ensure that the pressure is less than 15 ppm. Rinse each 
filtration apparatus with DRO water.

Figure 6.1. Sample processing and filtering flow chart

5.	 Prepare the filter blank by placing a baked, unused filter into a pre-labelled Petri dish. 

Prepare the filter method blanks for particulate iron (Part Fe) and particulate phosphorus 
(Part P) by filtering 100 mL of Milli-Q water through each 42.5-mm GF/C filter and for 
particulate carbon and nitrogen (Part C/N) by filtering 200 mL of Milli-Q water through 
a 25-mm GF/C filter.

Prepare method blanks for alkalinity, anions and cations (ions), dissolved organic 
carbon (DOC), and soluble reactive silica (SRSi) by rinsing and filling a 125-mL HDPE 
bottle, a 50-mL conical tube, a 175-mL square HDPE bottle, and a 20-mL HDPE vial, 
respectively, with Milli-Q water. 
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6.	 Using Figure 6.1 as a guide, process each 1 L unfiltered water sample as follows:

a.	 To prepare the phytoplankton taxonomy sample, invert the sample several times, 
rinse and fill the labelled 40-mL glass vial with the sample and preserve with 500 µL 
of Lugol’s solution. 

b.	 To prepare the SRSi sample, invert the sample several times, rinse and fill the 
labelled 20-mL HDPE vial with the sample.

c.	 To prepare the Part P sample, place a 42.5-mm GF/C filter onto the filtration 
apparatus and rinse with 50–100 mL of Milli-Q water into a rinse bottle. Switch 
the rinse bottle to the labelled 500-mL PETG bottle (Nutrients), invert the sample 
several times, and then filter 100 mL of sample through the filter and into the 
Nutrients bottle. Use this filtrate to rinse the Nutrients bottle. Using forceps, fold 
the GF/C filter twice lengthwise and transfer it to the labelled 15 mL vial.

d.	 To prepare the Part Fe sample (if requested), place a 42.5-mm GF/C filter onto the 
filtration apparatus and rinse with 50–100 mL of Milli-Q water into a rinse bottle. 
Switch the rinse bottle to the Nutrients bottle, invert the sample several times, and 
filter 100 mL of the sample through the filter and into the Nutrients bottle. Retain 
this filtrate. Using forceps, transfer the GF/C filter to a labelled acid-washed 20-mL 
HDPE vial.

e.	 To prepare the chlorophyll-a (Chl-a) sample, place a 42.5-mm GF/C filter onto 
the filtration apparatus and rinse with 50–100 mL of Milli-Q water into a rinse 
bottle. Switch the rinse bottle to the Nutrients bottle, invert the sample several 
times, and filter 200 mL of sample through the filter and into the Nutrients bottle. 
Retain this combined filtrate. Using forceps, transfer the GF/C filter to a labelled 
50-mm Petri dish. 

f.	 To prepare the Part C/N sample, place a 25-mm GF/C filter onto the filtration 
apparatus and rinse with 50–100 mL of Milli-Q water into a rinse bottle. Switch the 
rinse bottle to the Nutrients bottle, invert the sample several times, and filter 200 
mL of sample through the filter and into the Nutrients bottle. This combined filtrate 
is the Nutrients (NO2, NO3, NH3, TDN, and TDP) sample. Using forceps, transfer 
the GF/C filter to a labelled 50-mm Petri dish.  

g.	 To prepare the absorbance scan sample, rinse and fill the labelled 20-mL HDPE vial 
with the filtered Nutrients sample. 

h.	 To prepare the archive filter, ions, and DOC samples, place a 42.5-mm GF/C filter 
onto the filtration apparatus and rinse with at least 100 mL of Milli-Q water into 
a rinse bottle. Invert the sample several times and measure 200 mL of sample in a 
graduated cylinder. Switch the rinse bottle to the labelled 50-mL conical tube (ions), 
filter ~10 mL of sample, and use this filtrate to rinse the ions bottle. Filter ~45 mL of 
sample into the ions tube. Switch the ions tube to the 175-mL square HDPE bottle 
(DOC), filter ~20 mL of sample, and use this filtrate to rinse the DOC bottle. Filter 
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the remaining sample into the DOC bottle. Using forceps, transfer the GF/C filter to 
a labelled 50-mm Petri dish.

7.	 Rinse the filtration apparatus and graduated cylinder(s) with DRO water. 

8.	 Repeat steps 6 and 7 for all subsequent samples. 

9.	 The Chl-a, Part C/N, and Archive samples all need to be dried in a vacuum desiccator 
prior to being stored at -20 °C. 

Prepare the vacuum desiccator by placing baked desiccant into the glass desiccator and 
applying vacuum grease to the rim, if needed. Place each Chl-a, Part C/N, and Archive 
sample into the desiccator by placing the lid of each Petri dish onto the bottom of the 
Petri dish and then stacking them in the desiccator.

Evacuate the desiccator with the vacuum line and place it in a dark cabinet until the filters 
have dried (at least 24 hours). 

6.10 Sample storage
Samples are analyzed within the storage holding times listed in Table 6.2, and the analysis dates 
are recorded in Sample Master. 

The GF/C filters are dried for at least 72 hours and then the Petri dishes are reassembled. 

Table 6.2. Containers, storage holding times, and storage temperature of each analytical 
test

Test Container Holding time Storage Temp.

absorbance scan 40 amber glass vial 7 days 4°C

alkalinity 125 mL HDPEa 6 months 4 °C

conductivity 125 mL HDPE with 
conical cap

24 hours 25 °C

dissolved inorganic carbon 125 mL HDPE with 
conical cap

24 hours 4 °C

particulate carbon 50 mm Petri dish 12 months -20 °C

particulate iron 20 mL HDPE 12 months room temperature

particulate nitrogen 50 mm Petri dish 12 months -20 °C

particulate phosphorus 15 mL glass vial with 
PTFEb-lined cap

12 months room temperature

pH 125 mL HDPE with 
conical cap

24 hours 25 °C
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Test Container Holding time Storage Temp.

phytoplankton taxonomy 40 mL glass vial with 
conical cap

Indefinitec room temperature

soluble reactive silica 20 mL HDPE 6 months room temperature

anions (Cl and SO4) 50 mL conical tube 6 months 4 °C

ammonia (as N) 500 mL PETG 48 hours 4 °C

cations (Na, Mg, K, Ca, Mn, 
Fe)

50 mL conical tube 6 months 4 °C

dissolved organic carbon 175 mL HDPE 6 months 4 °C

nitrate (as N) 500 mL PETG 48 hours 4 °C

nitrite (as N) 500 mL PETG 48 hours 4 °C

total dissolved nitrogen 500 mL PETG 7 days 4 °C

total dissolved phosphorus 500 mL PETG 7 days 4 °C

chlorophyll-a 50 mm Petri dish 12 months -20 °C

a High-density polyethylene (HDPE); Anaerobic samples are stored in polyethylene terephthalate glycol 
(PETG) to prevent oxygen diffusion into the sample. 
b Polytetrafluoroethylene (PTFE)
c Post Lugol’s preservation

Archive and Chl-a samples are grouped together by test and date collected using white vinyl tape 
with the range of Sample IDs written on the tape.

Samples for Part C/N are placed in individual polyethylene bags. The samples are then grouped 
together in polyethylene bags, the test and range of Sample IDs are written on the outside of the 
bag, and the samples are stored at -20 °C. 

Absorbance scan samples are stored at 4 °C inside a black polyethylene bag to eliminate light 
exposure.

6.11 Clean up
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, all equipment is 
cleaned by rinsing it three times with hot water and three times with DRO water. 
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6.12 Data entry
1.	 For each Order ID, Navigate to Sample Login > Order Details and enter the time collected, 

collector and any comments for each sample, and the start depth and end depth for 
integrated epilimnion and metalimnion samples, as well as the start collect date, end 
collect date, rain gauge, and observed precipitation volume for precipitation samples.

2.	 To enter GF/C lot numbers, navigate to Sample Tracking > Sample Preparation, ensure that 
“Unassigned Samples” is checked, and query for samples by filtering the test for Archive, 
Chl-a, Part C/N, Part Fe, and Part P. 

Click the check box to mark the appropriate sample(s), select the appropriate GF/C lot 
number from the drop-down menu (if available), and click Add to Batch.

If not available, add the GF/C lot number by clicking New, entering the GFC lot number 
in the Prep Filter Lot field and the date the first GF/C from that lot was used in the Date 
Prepared field (leave Matrix, Test, Method, and Supply Name blank), and clicking OK. 

3.	 The Analysis Volumes recorded in Sample Master are configured with the default volumes 
for the Archive, Chl-a, Part C/N, Part Fe, and Part P tests. If the actual volume filtered is 
adjusted from the default filtration volume, the Analysis Volume needs to be revised to the 
adjusted filtration volume. 

To revise the Analysis Volume, navigate to Sample Tracking > Enter Prep Volumes and query 
the samples by filtering by the appropriate Order ID(s) or Sample ID(s).

Revise the “Analysis Volume” of any test samples that had filtration volumes that were 
adjusted from the default and click Update.
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Appendix 6A. Lugol’s Solution Preparation Record
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7.0 Outsourced Analyses

7.1 Introduction and scope
This method outlines sample storage, transport, and data management for outsourced analyses. 
The following analyses (Table 7.1) are outsourced to the Biogeochemical Analytical Service 
Laboratory (BASL) at the University of Alberta, which is accredited to ISO/IEC 17025 by the 
Canadian Association for Laboratory Accreditation.

Table 7.1. Analyses outsourced to the University of Alberta

alkalinity

anions (Cl and SO4)

cations (Na, Mg, K, Ca, Mn, Fe)

particulate carbon and nitrogen

total dissolved solids

total suspended solids

7.2 Occupational health and safety
There are no occupational health and safety concerns associated with the storage and transport of 
the outsourced analyses. 

7.3 Sample conditions and storage
Samples are logged into Sample Master®, where they are assigned a Sample ID, and all relevant 
metadata is recorded (see Section 6, Sample Preparation and Filtration). The processing and 
holding times described are designed for dilute Canadian Shield waters (e.g. IISD-ELA samples); 
samples from other sources (e.g. marine) may have other requirements. This is discussed with 
clients who bring samples from other sources. Sampling and adherence to IISD-ELA sampling 
protocols are the client’s responsibility.

Samples are stored at 4 ± 2 °C and filtered within 24 hours of sample collection.

The default filtration volume for particulate carbon and nitrogen is 200 mL. If the filter clogs 
prior to reaching this volume, the volume filtered is reduced accordingly, and the actual filtered 
volume is recorded on the sample label, the Sample Summary, and in Sample Master®. 
Alternative filtration volumes are available upon request but are contingent on a sufficient sample 
being supplied by the client.
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Table 7.2. Containers, storage holding times, and storage temperature of each analytical 
test

Test Container Holding time Storage Temp.

alkalinity 125 mL HDPEa 6 months 4 °C

anions (Cl and SO4) 50 mL conical tube 6 months 4 °C

cations (Na, Mg, K, Ca, Mn, Fe) 50 mL conical tube 6 months 4 °C

particulate carbon and nitrogen 50 mm Petri dish 12 months -20 °C

total dissolved solids 500 mL HDPE 6 months 4 °C

total suspended solids 500 mL HDPE 6 months 4 °C

a HDPE = high density polyethylene; Anaerobic samples are stored in polyethylene terephthalate glycol 
(PETG) to prevent oxygen diffusion into the sample

7.4 Equipment
	‒ refrigerator set to 4 °C for sample storage

	‒ coolers for sample transport

	‒ ice packs

	‒ 25 mm GF/C glass fibre filters, baked at 500 °C for 14 hours

	‒ 50 mm Petri dishes

	‒ silica gel desiccant

	‒ 50 mL conical tubes

	‒ 500 mL high-density polyethylene (HDPE) narrow-mouth bottles

	‒ 125 mL HDPE narrow-mouth bottles

7.5 Prepared reagents

7.5.1 Type 2 ultrapure deionized reverse osmosis (DRO) water 

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma). 
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7.5.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

7.6 Quality control

7.6.1 Blanks

A method blank is collected for alkalinity, anions and cations, and particulate carbon and nitrogen 
(Part C/N) each day that a sample is received and processed for these analyses. The alkalinity 
method blank consists of Milli-Q water stored in a 125 mL HDPE narrow-mouth bottle. The 
anions and cations method blank consists of Milli-Q water that has been filtered through a baked 
and rinsed 42.5 mm GF/C filter. The Part C/N method blank is a baked 25 mm GF/C filter that 
had 200 mL of Milli-Q water filtered through it. See Section 6, Sample Preparation and Filtration, 
for additional details on sample filtration.

7.6.2 Field duplicates

A field duplicate, wherein a sample is collected in duplicate, is collected and processed for 
alkalinity, anions and cations, and Part C/N each day that a sample is received and processed for 
these analyses. 

7.7 Alkalinity
Alkalinity samples from aerobic water are collected in 125 mL HDPE narrow-mouth bottles. 
Alkalinity samples from anaerobic water are collected in 125 mL polyethylene terephthalate glycol 
bottles to prevent oxygen diffusion into the sample. Samples are stored at 4 °C until they are 
shipped to the BASL at the University of Alberta. 

Alkalinity samples are analyzed using U.S. Geological Study Method 09-A6.6 Alkalinity and 
acid neutralizing capacity (Rounds & Wilde, 2012), and the American Public Health Association 
4500-H+ B pH Value – Electrometric Method (Baird & Bridgewater, 2017) with the Mantech PC-
Titration Plus System (Mantech Inc.) and PC-Titrate instrumentation software (Mantech Inc.). 

7.8 Anions and cations
Anion and cation samples are processed according to Sample preparation and filtration. Briefly, 
samples collected in 500 mL HDPE narrow-mouth bottles are filtered through a baked and 
rinsed 42.5 mm GF/C filter into a 50 mL conical tube with a screw-cap lid. Samples are stored at 
4 °C until they are shipped to the BASL at the University of Alberta.
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The anions chloride (Cl-) and sulfate (SO42-) are analyzed using U.S. Environmental 
Protection Agency (EPA) Method 300.1: Determination of Inorganic Anions in Drinking Water 
by Ion Chromatography (Pfaf et al., 1997) with the Dionex™ DX-600 Ion Chromatograph 
(ThermoFisher™ Dionex™). 

The cations sodium (Na), magnesium (Mg), potassium (K), calcium (Ca), manganese (Mn), 
and iron (Fe) are analyzed using the U.S. EPA Method 200.7: Determination of Metals and Trace 
Elements in Water and Wastes by Inductively Coupled Plasma-Atomic Emission Spectrometry (Martin et 
al., 1994) with the Thermo Scientific ICAP-6300 Inductively Coupled Argon Plasma – Optical 
Emission Spectrometer (ThermoFisher™ Scientific). 

7.9 Particulate carbon and nitrogen
The Part C/N samples are processed according to Section 6, Sample Preparation and Filtration. 
Briefly, samples collected in 500 mL HDPE narrow-mouth bottles are filtered through a baked 
and rinsed 25 mm GF/C filter. The filter with retained particulates is placed in a Petri dish and 
desiccated in the dark in a glass vacuum desiccator with silica gel desiccant. Once the filters are 
dry, the lids are attached to the Petri dish and the Petri dishes are then placed into polypropylene 
zipper-top bags, which are subsequently consolidated into polyethylene Whirl-Pak® bags and 
stored at -20 °C until they are shipped to the BASL at the University of Alberta. 

Part C/N is analyzed using U.S. EPA Method 440.0, Determination of Carbon and Nitrogen in 
Sediments and Particulates of Estuarine/Coastal Waters Using Elemental Analysis (Zimmerman et al., 
1997) with the Exeter CE 440 Elemental Analyzer (Exeter Analytical, Inc.).

7.10 Total dissolved solids and total suspended solids
Samples for total dissolved solids (TDS) and total suspended solids (TSS) are collected in 500 
mL HDPE narrow-mouth bottles and stored at 4 °C until they are shipped to the BASL at the 
University of Alberta. 

The TDS is analyzed using US EPA Method 160.1: Total Dissolved Solids (Gravimetric, Dried at 
180 °C) (U.S. EPA, 1983a) and TSS is analyzed using US EPA Method 160.3: Residue, Total 
(Gravimetric, Dried at 103-105 °C) (U.S. EPA, 1983b). 

7.11 Data entry
The lab manager at BASL will email an Excel report that includes the analytical data, the 
detection limit, the data analyzed, and the instrument used. The data and metadata are entered 
into Sample Master (see Section 5, Laboratory Information Management System – Sample 
Master). A QC Batch is not created for outsourced analyses. To enter outsourced analytical 
data, navigate to Data Entry > Result Entry, query for the appropriate “Parameter” and range of 
“Date Collected,” and click Retrieve. Select Results to Enter. In the “Sample Results” tab, enter 
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the analytical result into Result field, the 
detection limit into the Report Limit field, the 
analysis date into both the Analysis Date and 
ParamAnalysisDate fields, and enter “BASL – 
UofAlberta” into both the Analysis Employee 
and ParamAnalyst fields. Ensure that the 
instrument and method listed in Sample 
Master are correct (see Table 7.3 for methods 
of outsourced analyses). 

Once all of the data and metadata have been 
entered, click Enter. The samples will now be 
transferred to “Results to Validate.” 

7.12 Trend analysis
Trend analysis is conducted on each site/parameter combination to assess the data for outliers. 
A request is submitted to BASL to reanalyze any samples with outliers. The outlier data are 
either updated with the reanalysis data, retained, or rejected in Sample Master depending on the 
revelations of the reanalysis and subsequent investigation. All of the samples that have undergone 
trend analysis are “Validated” for that site/parameter combination. 

To conduct a trend analysis, navigate to Data Entry > Trend Analysis, query for the appropriate site 
(e.g. L239 EIF) and parameter (e.g. Na), and click Retrieve. Mark all of the samples by clicking 
the box between “Parameter” and “Results” 
and click Chart. Assess the chart for outliers; 
record any outliers and any information about 
them (e.g. result is high) in the cell that 
represents the site/parameter combination in 
the Trend Analysis spreadsheet. If no outliers 
exist, put an “X” in the cell that represents the 
site/parameter combination. 

Continue conducting the trend analysis for all 
site/parameter combinations.

To “Validate” samples, navigate to Data Entry > Result Entry, query for the samples by filtering 
by the site and parameter combination, and click Retrieve. Click Results to Validate, mark all of the 
samples, except for the outliers, and click Validate. 

Figure 7.1. Subsection of Trend Analysis 
spreadsheet

Table 7.3. Method recorded in Sample 
Master for each outsourced analysis

Analysis Method

gran alkalinity UA-Alk

anions UA-ClSO4

cations UA-ICP

particulate carbon and 
nitrogen

UA-C/N

total dissolved solids UA-TDS

total suspended solids UA-TSS
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7.13 Clean up
The HDPE bottles used for alkalinity, TDS, and TSS samples are scrubbed of any adhered 
particulate and washed at a high temperature in a dishwasher without detergent, rinsed three 
times with DRO water, and air dried.
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8.0 Dissolved Oxygen

8.1 Introduction and scope
This method is used to determine dissolved oxygen in freshwater and precipitation samples. In 
situ samples are stored at the original temperature of the sample and analyzed within three hours 
of sample collection using the Winkler titration method. 

Dissolved oxygen concentrations are generally measured using in situ dissolved oxygen sensors 
(e.g. XRX-620, RBR Ltd., etc.), which are managed by the Lake Sampling department and 
are not included in Sample Master. Winkler titrations are performed on in situ Lake 239 profile 
samples monthly and used to verify the calibration of the dissolved oxygen sensors.

8.2 Method principle
The lab measurements of dissolved oxygen are based on the classic Winkler titration of oxygen 
that was first developed by Lajos Winkler in 1888 and later modified and validated by James 
Carpenter (Carpenter, 1965a, 1965b; Carritt & Carpenter, 1966). Manganous sulfate reacts 
with potassium or sodium hydroxide to give a white precipitate of manganous hydroxide. In the 
presence of oxygen, basic brown manganic oxide is formed, i.e.:

Mn+2SO4 + 2 KOH = Mn+2(OH)2 + K2SO4

2Mn+2(OH)2 + O2 = 2Mn+4O(OH)2

The addition of sulfuric acid dissolves the brown manganic oxide, yielding manganic sulfate, 
which reacts instantly with iodide to yield iodine, i.e.:

Mn+4O(OH)2 + 2H2SO4 = Mn+4(SO4)2 + 3H2O

Mn+4(SO4)2 + 2Kl = Mn+2(SO4) + K2SO4 + I2

In effect, oxygen oxidizes Mn+2 to Mn+4, which oxidizes I- to I2. Iodine is then determined 
titrimetrically using thiosulfate. The reaction of thiosulfate with iodine in acidic conditions is 

2S2O3-2 +I2 = S4O6-2 +2I-

Overall, the relation between O2 and thiosulfate is

4Na2S2O3 = O2
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Four moles of thiosulfate are titrated for each mole of molecular oxygen (O2). Thus 1 mL of 
0.025 N thiosulfate (normality is the same as molarity for thiosulfate) is equivalent to 0.025 
meq of oxygen. This value is multiplied by 8 mg/meq to convert to mg O2. When 200 mL of the 
original 300 mL sample is titrated, then 1 mL of 0.025 N thiosulfate equals 1 mg/L O2.

200 mL/1,000 mL = 0.2 mg O2 and 8 mg/meq × 0.025 = 0.2 mg O2

Interferences occur from other oxidants in the sample that can liberate or absorb iodine (e.g. 
brown precipitate in alkaline iodide and manganous reagents or dissolved organic carbon in water 
samples). The effect of nitrite is eliminated with the addition of sodium azide.

The thiosulfate solution is not stable and therefore must be standardized with a standard, 
specifically potassium iodate (KIO3). Standardization is based on the co-proportionation reaction 
of iodide with iodate, thereby forming iodide: 

KIO3 + 5NaI + 6H+ = 3I2 +3H2O + K+ + 5Na+

One mole of iodate produces 3 moles of iodine, which are consumed by 6 moles of thiosulfate:

KIO3 = 6S2O3-2

Interferences occur from other oxidants in the sample that will liberate iodine. The effect of nitrite 
is eliminated with the addition of sodium azide.

8.3 Occupational health and safety
The NaI reagent is very alkaline and must be handled with care. 

NaN3 is very poisonous—keep away from acids.

The concentrated sulfuric acid (H2SO4) is very corrosive and must be handled carefully. Avoid 
contact with skin. Wear gloves, goggles, and a lab coat when handling. Always pour acid into water 
slowly while stirring. Never pour water into acid.

8.4 Validation

8.4.1 Operating range

0 – 20 mg/L O2

8.4.2 Detection limit

Method detection limit 0.2 mg/L O2
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8.5 Sample conditions
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. Sampling 
technique is critical for this method. The sample analyzed must be

	‒ collected in specially designed glass or polyethylene terephthalate glycol (bottles with a 
capacity of approximately 300 mL and ground glass stoppers with conical ends to prevent 
trapping air bubbles,

	‒ collected without exposure to atmosphere,

	‒ stored in a sealed bottle at the temperature sampled,

	‒ analyzed within three hours of sample collection, and 

	‒ free of chemical reductants and oxidants (other than oxygen).

8.6 Equipment
	‒ manufacturer-calibrated glass or PETG dissolved oxygen bottles with a 300-mL capacity

	‒ burette with 0.1-mL readability

	‒ magnetic stir plate and stir bars

	‒ balance with 0.01-g readability

	‒ repeater pipette, set to 4

	‒ three 25 mL capacity Eppendorf™ Combitips—one each for manganese sulfate, alkaline 
iodide, and sulfuric acid

	‒ 200-mL volumetric flask

	‒ QC Bach Run Sequence BenchSheet

Note: It is important that each Combitip is only used for one reagent and that the caps for 
the reagent bottles are not mixed up. A brown precipitate in the reagents indicates that the 
alkaline iodide and the manganous reagents have become cross-contaminated. Reagents 
must be replaced if cross-contamination is suspected.

8.7 Purchased reagents

8.7.1 Sulfuric acid (H2SO4), ACS grade 

Store in an acid cabinet at room temperature. Stable as per manufacturer’s specifications.
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8.8 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.

	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

	‒ Reagents and standards are stable at room temperature unless otherwise specified.

8.8.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

8.8.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

8.8.3 Manganese sulfate or manganese chloride

Dissolve

	‒ 480 g MnSO4 4H2O, (2.15M), or 

	‒ 400 g MnSO4 2H2O, (2.14M), or

	‒ 364 g MnSO4 H2O, (2.15M), or

	‒ 425 g MnCl2 4H2O, (2.15M)

in ~500 mL Milli-Q water and dilute to 1 L with Milli-Q water. Stable for two years, or until 
contaminated, at room temperature. 
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8.8.4 Alkaline iodide azide 

Dissolve either

	‒ 500 g sodium hydroxide and 135 g sodium iodide, or

	‒ 700 g potassium hydroxide and 150 g potassium iodide

In ~500 mL of Milli-Q water and dilute to 1 L with Milli-Q water. To this, add 10 g sodium azide 
that has been dissolved in 40 mL of Milli-Q water. Stable for two years, or until contaminated, at 
room temperature. 

8.8.5 10% H2SO4

Dilute 10 mL of sulfuric acid into 100 mL of Milli-Q water. Stable indefinitely at room 
temperature.

8.8.6 Starch indicator

Prepare a paste of 1 g potato starch in 5 mL of Milli-Q water and add 100 mL of boiling Milli-Q 
water. Stable until the solution turns grey/violet at 5 ± 3 °C.

8.8.7 Sodium thiosulfate – 0.025 N

Commercially available concentrated standard solution is diluted to 0.025 N with Milli-Q water. 
Stable for one year. 

8.8.8 Calibration standard

Add 

	‒ 12 g KI

	‒ 12 ml 10% H2SO4

	‒ 8 ml potassium iodate (KIO3) solution.

to ~150 mL of Milli-Q water and dilute to 200 mL with Milli-Q water. Prepared daily.

8.9 Quality control 
This method utilizes a calibration standard and a field duplicate. If the result of the calibration 
standard does not meet expectations, the thiosulfate and/or calibration standard are remade and 
re-tested. The quality control (QC) results are recorded in Sample Master. 
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8.9.1 Calibration standard

A calibration standard, consisting of a known concentration of iodine, is used to validate the 
thiosulfate concentration. 

8.9.2 Field duplicate

A random duplicate is included in every sampling event. 

8.9.3 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibration and 
Verification. The calibrations of the Eppendorf™ pipettes are verified on a weekly basis or prior to 
making standards using methods outlined in Labware Calibrations and Verifications. Glassware is 
cleaned according to Section 2,  Labware Cleaning.

8.10 Quality assurance
Proficiency testing for the dissolved oxygen analysis is not currently conducted.

8.11 Sample preparation
1.	 Create a QC Batch in Sample Master (see Section 5.4.2. Laboratory Information 

Management System – Sample Master: Create QC Batch) for the samples and print the Run 
Sequence BenchSheet.

2.	 Ensure that there are no air bubbles in the sample bottle and that the sample is less than 
three hours old.

8.12 Analysis

8.12.1 Calibration

1.	 Weigh 200 ± 0.1 g of the calibration standard into a 250 mL Erlenmeyer flask. Create 
a gentle vortex using the stir bar and stir plate and titrate with thiosulfate until colour is 
reduced to a pale straw yellow.  

2.	 Add several drops of starch solution and titrate with thiosulfate until the first 
disappearance of the blue colour.

Note: Adding the starch to an excessive concentration of I2 degrades the starch. Hence it 
is added after the I2 concentration has been reduced.

Note: Iodine is present in the form of the I3- complex. This complex decomposes to 
release I2, which regenerates the blue colour with the starch indicator.
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3.	 Record the volume of thiosulfate used, as well as any other pertinent comments, on the 
Run Sequence BenchSheet. 

8.12.2	Analysis

1.	 To each water sample within a calibrated dissolved oxygen bottle, add 2 mL of manganese 
sulfate, followed by 2 mL of alkaline iodide azide, immediately re-stoppering the bottle 
after each addition and taking care not to entrap any air bubbles. Pour off the 4 mL of 
displaced O2 containing sample water and invert several times to mix reagents and sample.

Note: These reagents should be injected well below the liquid surface, with sample bottles 
being un-stoppered for as short a time as possible. It is at this stage that these two reagents 
can become cross-contaminated.

2.	 Permit the precipitate to settle and then mix the samples again.

3.	 After the precipitate has settled to the bottom of each sample a second time, inject 2 mL 
of sulfuric acid into each sample, immediately re-stoppering the bottle after each addition. 
Pour off the 2 mL of displaced O2-free water (all of the O2 is bound in the precipitate) 
and invert several times to mix.

Note: It is essential in the above manipulations that none of the precipitate or iodine 
arising from acidification of the precipitate escapes from the bottle.

4.	 Weigh 200 ± 0.1 g of I2 solution from a sample bottle into a 250 mL Erlenmeyer flask.   

5.	 If the colour of the sample is pale yellow to begin with, as with low O2 waters, continue to 
step 7.

If the colour of the sample is deep orange, titrate the sample with thiosulfate until the 
colour is reduced to a pale straw yellow.

Note: Some water samples are naturally yellow coloured due to organic compounds in 
the water. Iodine is present in the form of the I3- complex. When exposed to starch, this 
complex decomposes to release I2, which regenerates the blue colour and provides the 
distinction between iodine and natural water colouring.

6.	 Add several drops of starch solution and titrate until the first disappearance of the blue 
colour.

Note: Adding the starch to an excessive concentration of I2 degrades the starch. Hence, it 
is added after the I2 concentration has been reduced by thiosulfate.
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7.	 Record the volume of thiosulfate used. Record any other pertinent comments on the 
sample or the titration. Record the volume of thiosulfate used, as well as any other 
pertinent comments, on the Run Sequence BenchSheet.

8.	 Repeat steps 4 through 7 for the remaining samples.

8.13 Clean up
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, all of the labware is 
cleaned by rinsing three times with hot water and three times with DRO water.

8.14 Calculations
The calculation of O2 in samples is performed by using the “O2 Calculation Template.xls” located 
at \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\O2\O2 Calculation Template.xls.

Concentrations of O2 are calculated using equation 8.1:

Equation 8.1.	 CO2 =  VT 
×

    VS

where VT is the volume, in mL, of the thiosulfate titrated, VS is the volume of sample that was 
titrated, and CF is the conversion factor of the standardized 0.025N thiosulfate:

Equation 8.2.	
CF =

   8   
×

    VStd

where VStd is the volume of KIO3 standard that was titrated. 

This spreadsheet template should be saved to a new file name to record the data. The file name 
should be in the format of yyyymmdd_O2.xls (e.g. 20201203_O2.xls) and saved in the directory 
\\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\O2.

To calculate the O2 concentrations in the samples, fill in each of the yellow fields with the Sample 
ID, sample volume (i.e. weight), and volume of thiosulfate titrated. 

The analysis date, analyst, and QC Batch ID are also recorded in the yellow fields of this 
spreadsheet.

8.15 Data entry
The O2 concentrations of each sample, which are calculated using the “O2 Calculation Template.
xls”, as well as the QC data, are entered into the Sample Master®LIMS. The completed O2 
Calculation Template and Run Sequence BenchSheet are filed into the O2 folder. 

(  )CF (     )200mL

(  )CF (     )200mL

https://www.iisd.org/ela/


IISD.org/ela 61

The Chemical Analysis of Fresh Water

8.16 References			    
Carpenter, J. H. (1965a). The accuracy of the Winkler method for dissolved oxygen analyses. 

Limnology and Oceanography, 10, 135–140.

Carpenter, J. H. (1965b). The Chesapeake Bay Institute technique for the Winkler dissolved 
oxygen method. Limnology and Oceanography, 10, 141–143.

Carritt, D. E., & Carpenter, J. H. (1966). Comparison and evaluation of currently employed 
modifications of the Winkler method for determining dissolved oxygen in seawater: A NASCO 
report. Journal of Marine Research, 24(3), 286–318.

https://www.iisd.org/ela/


IISD.org/ela 62

The Chemical Analysis of Fresh Water

Appendix 8A. Manganese Sulfate/Chloride Preparation 
Record
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Appendix 8B. Alkaline Iodide Azide Preparation Record
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Appendix 8C. 10% Sulfuric Acid Preparation Record
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Appendix 8D. Starch Indicator Preparation Record
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Appendix 8E. Sodium Thiosulfate Preparation Record
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Appendix 8F. Calibration Standard Preparation Record
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Appendix 8G. QC Batch Run Sequence Benchsheet
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9.0 Specific Conductance

9.1 Introduction and scope
The following method is used in the IISD Experimental Lakes Area Analytical Service Laboratory 
for the determination of specific conductance of freshwater and precipitation samples.

9.2 Method principle
Solutions of dissociated ions can conduct an electrical current. The resistance, R, of electrolyte 
solutions is a function of electrode surface area, A; the distance between electrodes, l; the solution 
temperature; and the concentration and nature of the ion in solution. For a given solution and 
temperature:

Equation 9.1.	
R α

  l

if l is in cm and A is in cm2 then the resistance, R, is in ohms. 

Resistance is measured with platinum electrodes using a bridge circuit with an alternating current 
supply at 60-3999 Hz to minimize polarization effects. Under these conditions, Ohm’s law is 
obeyed.

A more commonly used measurement than resistance is conductance, L, measured in Siemens, S, 
where

Equation 9.2.	 L = R-1

From equations 9.1 and 9.2 we get

Equation 9.3.	  
L α

  l

or

Equation 9.4.	
L = K

  l

where K is a proportionality constant termed the specific conductance and is the observed 
conductance of a solution measured with a cell of unspecified geometry (A and l) normalized 
to the conductance one would obtain with a cell having A = 1 cm2 and l = 1 cm. K is usually 
measured at 25 °C.

A

A

A
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From equation 9.4, setting l = 1 cm, we get

Equation 9.5.	
K = L

  1

1/A is the cell constant, which varies with the geometry of the cell (i.e. the area of electrode plates) 
and their separation. Commercially prepared cells are labelled with an approximate cell constant 
but must be calibrated before use by measuring the conductance L of a KCl solution of known 
specific conductance K at 25 °C and calculating  from equation 9.5. Specific conductance of 
samples is obtained by measuring L for samples at 25 °C and calculating K using equation 9.5 
and the calibrated cell constant.

In low ionic strength waters, typical of Precambrian Shield lakes, conductance is highly influenced 
by dissolved CO2 levels. This method is designed to measure in situ conductance. 

9.3 Occupational health and safety
There are no occupational health and safety concerns associated with this analysis.

9.4 Validation

9.4.1 Operating range

This is dependent on the instrument used and the cell constant of the electrode.

Cell constant = 0.1 cm-1, range = 0.1 μS – 150 mS

Cell constant = 1.0 cm-1, range = 1 μS – 1500 mS

9.4.2 Detection limit

Method detection limit 0.05 µS/cm

Limit of quantitation 0.16 µS/cm

9.5 Sample conditions
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. The sample 
analyzed must be

	‒ collected in a manner that avoids contact with the atmosphere (i.e. an in situ sample) using 
a 125-ml polyethylene bottle with a conical cap insert that is completely filled without air 
bubbles,

A
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	‒ unfiltered,

	‒ equilibrated to 25 ± 1 °C in a water bath,

	‒ analyzed within 24 hours of sample collection, and 

	‒ not acidified or frozen.

9.6 Equipment
	‒ Radiometer CDM 3

	‒ Radiometer CDC 314 flow-through conductivity cell

	‒ cell constant 0.316

	‒ peristaltic pump fitted with 1.85 mm I.D. tubing

	‒ water bath to maintain samples at 25 ± 1 °C

9.7 Prepared reagents
	‒ Preparation information for all reagents and standards are recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.

	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

	‒ Reagents and standards are stable at room temperature unless otherwise specified.

9.7.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

9.7.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.
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9.7.3 Potassium chloride calibration standard – 0.2 N

Dissolve 14.912 g of dry KCl into 1 L of Milli-Q water. Stable at room temperature indefinitely.

9.7.4 Potassium chloride calibration standard – 0.01 N

Dilute 50 ml of 0.2 N KCl to 1 L with Milli-Q water. Specific conductance at 25 °C = 1411μS/
cm (Kortum & Bockris, 1951). Stable at room temperature indefinitely.

9.7.5 Potassium chloride calibration standard – 0.001 N (LKCl)

Dilute 1.0 ml of 0.2N KCl to 200 ml with Milli-Q water. Specific conductance at 25 °C = 
147 μS/cm (Kortum & Bockris, 1951). Stable at room temperature indefinitely.

9.7.6 Potassium chloride reference standard – 0.001 N KCl

Dissolve 14.912 g of dry KCl from a different manufacturer than the calibration standard into 
1 L of Mill-Q water to make 0.2N KCl. Dilute 1.0 mL of this 0.2N KCl to 200 mL with Milli-Q 
water. 

9.7.7 Reference sample

Reference samples are prepared in bulk according to Section 4, Reference Sample Preparation. The 
conductivity reference sample consists of water from Lake 239 that has been aged for at least one 
year and equilibrated to 25 ± 1 °C in a water bath.

9.8 Quality control
This method has a number of conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data is 
recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the non-
conformance is investigated and reported in the Non-Conformance log, and appropriate corrective 
action is taken before testing is resumed.

9.8.1 Blanks

A Milli-Q water blank and a DRO water blank are included at the beginning of a run. The specific 
conductance for blanks should be < 10 μS/cm.
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9.8.2 Potassium chloride calibration and reference standards – 0.001 N

The 0.001 N KCl calibration and reference standards should have a specific conductance in the 
147 µS/cm ± 5%. The calibration and reference standards should agree to within 5.0% of each 
other.

9.8.3 Potassium chloride calibration standard – 0.01 N

The 0.01 N KCl standard is not normally required for IISD-ELA samples. However, occasionally, 
a sample requiring verification at the higher range is encountered. This calibration standard is 
also included as a routine standard to gain experience with it. The specific conductance should be 
1412 µS/cm ± 5%.

9.8.4 Reference sample

A reference sample is included at the beginning of every run. The conductivity must be within 
5.0% of the expected value. Results for check sample performance are charted and assessed for 
drift and bias. The conductivity range for the L239 reference sample is between 30–40 µS/cm.

9.8.5 Duplicates

A random duplicate is included in each run and after every 15 samples. Duplicates must agree to 
within 5.0% of each other. If duplication is inadequate, samples bracketed by the duplicates are 
reanalyzed.

9.9 Quality assurance
Quality assurance for conductivity is maintained through annual participation in the Environment 
and Climate Change Canada Proficiency Testing Program (ECCC-PT). Non-compliance is 
defined by ECCC-PT and is reported directly to the Research Chemist. Samples analyzed during 
the period of non-compliance are flagged in the database.

9.10 Sample preparation
1.	 Place calibration standards, reference standard, blanks, and samples in the 25 ± 1 °C 

water bath for at least 30 minutes. 

Note: Conductivity analysis must be conducted prior to pH analysis since 200 µl of 3N 
KCl is added for the pH analysis.

2.	 Create a QC Batch in Sample Master (see Section 5, Laboratory Information Management 
System – Sample Master) for the samples and print the Run Sequence BenchSheet.

3.	 Secure the tubing on the peristaltic pump and tighten the clamp. Place the tubing into a 
beaker filled with Milli-Q water and turn the pump on.
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9.11 Analysis

9.11.1 Calibration

The following steps are used to verify that the Radiometer CDM 3 is providing accurate 
conductivity measurements prior to analyzing samples.

1.	 Place the tubing into and pump the 0.001 N KCl (LKCl) standard until the Radiometer 
stabilizes and record the conductance. The conductance should be in the 147 µS/cm ± 
5%. Return the tubing to the Milli-Q water and pump until the conductance is stabilized.

2.	 Repeat step 1 two more times and record the average conductance in the Conductivity 
logbook.

3.	 Pump 0.001 N reference standard until the conductivity is stable and record the 
conductance in the Conductivity logbook. Return the tubing to the Milli-Q water and 
pump until the conductance is stabilized.

4.	 Repeat step 3 for the 0.01 N KCl, the reference sample, Milli-Q, and DRO. Record 
the conductivity of the reference sample, Milli-Q, and DRO on the Run Sequence 
BenchSheet in addition to the Conductivity logbook. 

9.11.2 Analysis

1.	 Pump the sample into the Radiometer until the conductivity is stable and record the 
conductance on the Run Sequence BenchSheet.

2.	 Pump Milli-Q water into the Radiometer until the conductivity is stable.

3.	 Repeat steps 1 and 2 for each sample. Run at least one sample in duplicate and additional 
duplicates every 15 samples.

9.12 Clean up
The tubing is removed from the peristaltic pump and the equipment is cleaned according to 
Section 2, Labware Cleaning. Briefly, the 125 mL bottles and conical caps are cleaned by rinsing 
three times with hot water and three times with DRO water.  

9.13 Calculations
Calculate the conductivity cell constant, K, from equation 9.6:

Equation 9.6.	
K =

 1411 
LKCI
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where 1411 is the accepted specific conductance of a 0.01 N KCl solution at 25 °C and LKCl is 
the observed conductance of a 0.01 N KCl solution at 25 °C.

Multiply all sample conductance readings (Ls) by the cell constant obtained above to give specific 
conductance values for samples.

9.14 Data entry
The conductivity of each sample, as well as QC samples, are entered into the Sample Master  
LIMS. The completed Run Sequence BenchSheet is filed into the conductivity folder. 

9.15 References
Barrow, G. M. (1966). Physical chemistry. McGraw-Hill.

Kortum, G., &  J. O’M. (1951). Textbook of electrochemistry (vol. 1). Elsevier Press, Inc.

Radiometer Copenhagen. (n.d.) CDM3 Conductivity Meter: Operating Instructions. 
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Appendix 9A. 0.2 N Potassium Chloride Standard 
Preparation Record
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Appendix 9B. 0.01 N Potassium Chloride Standard 
Preparation Record
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Appendix 9C. 0.001 N Potassium Chloride Standard 
Preparation Record
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Appendix 9D. 0.001 N Potassium Chloride Reference 
Standard Preparation Record
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10.0 Hydrogen Ion Concentration – pH

10.1 Introduction and scope
The following method is used in the IISD Experimental Lakes Area Analytical Service Laboratory 
to determine the pH of fresh water and atmospheric precipitation.

10.2 Method principle
The pH of an aqueous solution is defined operationally by equation 10.1:

Equation 10.1.	
pH = pHs + 

  (E − Es)

Here, pHs is the assigned pH of a buffer used to standardize the system. E and Es are the 
electromotive force (EMF) of a suitable cell arrangement with unknown and buffer, respectively, 
and T is the temperature (Kelvin). Usually, the cell arrangement consists of a glass electrode 
with an electrolyte bridge to a saturated calomel electrode. Cell EMF is measured with a high-
impedance voltmeter, with the usual response being 59 mV per pH unit at 25 °C.

The glass electrode assembly is fragile and requires careful use and frequent calibration to obtain 
meaningful results. Since electrode response may be non-linear, it is important to standardize 
using buffers that have a pH close to and preferably bracket the pH of samples. Suitable time 
must be allowed for the electrode to come to equilibrium with solutions before a reading is taken.  

pH values are influenced by several variables that must be controlled to give meaningful results. 
These variables include temperature, CO2, ionic strength, and the condition of the reference 
junction in the combination electrodes. 

Temperature affects both the electrode performance (the millivolt value produced by a 
given hydrogen ion concentration) and the actual pH of the sample (influence on carbonate 
equilibrium). Most modern pH electrode/meter combinations correct for the temperature 
response of the electrode. However, the sample temperature must be controlled (usually to 25 °C) 
to provide comparable data.

CO2 content significantly affects pH in most natural waters (pH > 4.5). Natural water samples 
can be oversaturated or undersaturated with respect to atmospheric CO2 levels. Hence any gas 
exchange that allows samples to equilibrate with the atmosphere will change the observed pH 
from the “true” in situ value. Gain in CO2 will lower the pH, while a loss of CO2 will raise the pH. 
This problem is addressed by collecting, storing, and analyzing samples with minimal exposure to 
the atmosphere.

0.000198T
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Ionic strength influences the stability of pH electrode performance. Low ionic strength water, 
typical of lakes of the Precambrian Shield, can be a particularly difficult medium to measure pH. 
Changes in streaming potential generated at the reference junction through stirring or turbulence 
produce an unstable electrode response. This problem is addressed through the addition of KCl, 
which raises the ionic strength of the sample without changing the pH. Electrode performance in 
dilute waters is validated by measuring the pH of a 100 mL Milli-Q water sample containing 200 
µl of 3N KCl and equilibrated with the atmosphere. For an atmospheric CO2 concentration of 
350 ppm, the pH should be 5.65.

Essentially, pH electrode problems can be traced to problems with their reference junction, the 
semi-permeable linkage between the reference electrode filling solution, and the glass electrode 
filling solution. This junction can be either ineffective (poor electrical contact causing a slow or 
erratic response) or can change following a calibration, essentially establishing a new reference 
electrode potential (electrode slope remains the same but different absolute voltage and hence 
pH). The reference junction may be affected by the growth of biological material (algae, bacteria, 
or fungi) or contaminated by samples or buffers. Problems with reference junctions have been 
largely eliminated by electrode designs that allow for quick cleaning and the re-establishment of a 
“new” reference junction (e.g. the Orion “Sur Flo” electrode).

10.3 Occupational health and safety
There are no occupational health and safety concerns associated with this analysis.

10.4 Validation

10.4.1 Operating range

1–14 pH units

10.4.2 Detection limit

Method detection limit N/A

Limit of quantitation N/A
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10.5 Sample condition
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. The sample 
analyzed must be

	‒ collected in a manner that avoids contact with the atmosphere (i.e. an in situ sample),

	‒ stored in a 125-ml polyethylene bottle with a conical cap that is filled completely without 
air bubbles,

	‒ unfiltered,

	‒ equilibrated to 25 ± 1 °C in a water bath,

	‒ analyzed within 24 hours of sample collection, and

	‒ not acidified or frozen.

10.6 Equipment
	‒ Orion™ Ross™ type “Sur Flow” electrode. This electrode is fitted with a silicon stopper 
that allows the electrode to be inserted into the sample bottles while maintaining an 
effective seal against atmospheric invasion. This stopper must be equipped with a vent 
hole through which the sample is allowed to escape when the electrode is inserted into the 
sample bottles. Without this vent hole, a positive pressure would develop inside the sample 
bottle, forcing some of the sample into the electrode reference junction. This would 
invalidate the electrode calibration.

	‒ Fisher Scientific “Accumet” meter with multi-point calibration

	‒ 200 µl pipette

	‒ water bath set to 25 ± 1 °C

	‒ stir plate and small Teflon stir bars

	‒ Run Sequence BenchSheet

10.7 Purchased reagents

10.7.1 Calibration buffer solution, pH 4.00

Stable at room temperature until the expiry date on the manufacturer’s label.

10.7.2 Calibration buffer solution, pH 6.00

Stable at room temperature until the expiry date on the manufacturer’s label.
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10.7.3 Calibration buffer solution, pH 8.00

Stable at room temperature until the expiry date on the manufacturer’s label.

10.7.4 Electrode storage buffer solution, pH 7.00

Stable at room temperature until the expiry date on the manufacturer’s label.

10.7.5 Orion Ross pH electrode filling solution

Stable at room temperature indefinitely.

10.8 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.

	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

	‒ Reagents and standards are stable at room temperature unless specified otherwise.

10.8.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

10.8.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

10.8.3 3N KCl solution

Dissolve 223.68 g of dry KCl into 1 L of Milli-Q water. Stable at room temperature indefinitely.

https://www.iisd.org/ela/


IISD.org/ela 84

The Chemical Analysis of Fresh Water

10.8.4 Electrode storage solution

Dilute 100 mL of pH 4.00 buffer into 400 mL of Milli-Q water. 

10.8.5 Reference sample

Reference samples are prepared according to Section 4, Reference Sample Preparation. Briefly, the 
pH reference sample consists of water from Lake 239 that has been aged for at least one year, 
equilibrated to 25 ± 1 °C, and spiked with 200 µl 3N KCl.

10.9 Quality control
This method has a number of conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data is 
recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the non-
conformance is investigated and reported in the Non-Conformance log, and appropriate corrective 
action is taken before testing is resumed.

10.9.1 Blanks

A Milli-Q water blank and a DRO water blank are included at the beginning of a run. 

10.9.2 Reference sample

A reference sample is included at the beginning of every run. The pH must be within 5.0% of the 
expected value. Results for check sample performance are charted and assessed for drift and bias.

10.9.3 Duplicates

A random duplicate is included in each run and after every 15 samples. Duplicates must agree to 
within 5.0% of each other. If duplication is inadequate, samples bracketed by the duplicates are 
reanalyzed.

10.10 Quality assurance
Quality assurance for pH is maintained through annual participation in the Environment and 
Climate Change Canada Proficiency Testing Program (ECCC-PT). Non-compliance is defined 
by ECCC-PT and is reported directly to the Research Chemist. Samples analyzed during the 
period of non-compliance are flagged in the database.
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10.11 Sample preparation
1.	 Place calibration buffers, blanks, and samples in the 25 ± 1 °C water bath for at least 30 

minutes. 

2.	 Blanks and samples are spiked with 200 µl of 3N KCl prior to pH measurement.

Note: Conductivity analysis must be conducted prior to adding KCl to the sample.

3.	 Create a QC Batch in Sample Master® (see Section 5, Laboratory Information Management 
System – Sample Master) for the samples and print the Run Sequence BenchSheet.

10.12 Analysis

10.12.1 Calibration

1.	 Flush the reference junction of the electrode with electrode filling solution by pressing the 
spring-loaded top of the electrode (see Section 10.16 for additional information). 

2.	 Fill the reference chamber to just below the fill hole with electrode filling solution, rinse 
the outside of the electrode with DRO water, and wipe dry with a Kimwipe™. The fill hole 
must be uncovered during measurements.

3.	 Touch the screen to wake it up. Click the Std button. Click Clear to clear the previous 
standards. 

4.	 Place a stir bar and the electrode into the pH 8.00 buffer and turn on the stir plate. Click 
Std twice to start calibrating the first standard (pH 8.00). Enter the standard’s pH (e.g. 
8.000) when prompted.

5.	 Record the mV, slope (%), and standard pH (i.e. what it reads once you enter in 8.000) in 
the pH logbook (Table 10.1).  

6.	 Repeat steps 4 and 5 for pH 6.00 and pH 4.00, rinsing the electrode with DRO water and 
drying with a Kimwipe in between standards. The mV for pH 8.00, 6.00, and 4.00 should 
be around -59, 59, and 177 mV, respectively, but more importantly, the slope should be 
between 92-102%. 

7.	 Once the pH meter has been calibrated with the three standards, measure each of the 
buffers by clicking Measure. Record the measured reading in the pH logbook. The 
measured reading must be ± 0.02 of the standard. If it is not, clear the standards and start 
over.  

8.	 Record the water bath temperature (°C) in the pH logbook (Table 10.1).
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Table 10.1. Calibration parameters to record in the pH logbook

mV Slope (%) Standard
Measured 
reading QA/QC

Water bath 
temp (°C)

pH 8.00 DRO: 

pH 6.00 MQ: 

pH 4.00 L239: 

10.12.2 Analysis

1.	 Place a stir bar in the KCl-spiked DRO water and measure the pH by placing the 
electrode into the bottle and clicking Measure. Once stabilized, record the measured pH in 
the pH logbook and in the Run Sequence BenchSheet.

2.	 Repeat step 1 for Milli-Q water and the reference sample (L239), rinsing the electrode 
with DRO water and drying with a Kimwipe in between samples.

3.	 Place a stir bar into the KCl-spiked sample and measure the pH by placing the electrode 
into the bottle and clicking Measure. Once stabilized, record the measured pH on the Run 
Sequence BenchSheet.

4.	 Repeat step 3 for each sample, rinsing the electrode with DRO water and drying with a 
Kimwipe in between samples.  

5.	 Duplicate the measurement of at least one sample in the run and make additional 
duplicate measurements every 15 samples.

10.13 Clean up
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, the 125 mL bottles 
and conical caps are cleaned by rinsing three times with hot water and three times with DRO 
water. The outside of the electrode is rinsed with DRO water, dried with a Kimwipe, and stored in 
the electrode storage solution with the fill hole sealed.

10.14 Calculations
No additional calculations are required.

10.15 Data entry
The pH of each sample, as well as QC samples, are entered into the Sample Master LIMS by 
querying for the QC Batch ID. The completed Run Sequence BenchSheet is filed into the pH 
folder. 
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10.16 Maintenance
Use caution when handling the Orion “Sur Flow” pH electrode to avoid damaging the surface 
of the reference junction. Scratches or KCl deposits on the junction surface can affect the 
instrument’s ability to equilibrate with the sample solution and may influence results. Prior to 
starting up each day, carefully inspect the electrode for scratches or salt buildup. Use a Kimwipe 
to clear away any salt or bacterial matter that may be accumulating on the reference junction. 
Press the top of the electrode to open the seal of the junction and flush it with electrode filling 
solution. With the top of the electrode held down, a Kimwipe can be used to clean the inner 
surface of the electrode thoroughly. Once the reference junction has been properly cleaned, the 
electrode must be filled with electrode filling solution.

To prevent bacteria from growing on the electrode, regularly change the pH 7.00 buffer solution in 
which the electrode is stored. Periodic soaking in a weak acid solution followed by thorough washing 
with DRO water will help to alleviate problems with bacterial growth on the reference junction.
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Appendix 10A. 3 N Potassium Chloride Solution Preparation 
Record
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Appendix 10B. Electrode Storage Solution Preparation 
Record 
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Appendix 10C. QC Batch Run Sequence Benchsheet
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11.0 Dissolved Inorganic Carbon

11.1 Introduction and scope
This method is used to determine dissolved inorganic carbon (DIC) in freshwater and 
precipitation samples. In situ samples are stored at 4 °C and analyzed within 24 hours of sample 
collection using a Li-Cor 850 CO2/H2O gas analyzer. 

11.2 Method principle
Samples containing H2CO3, HCO-3, CO2 and CO3-2 are acidified using a non-volatile acid 
converting carbonate and bicarbonate to CO2. The CO2 is extracted into a nitrogen stream and 
measured as CO2 on an infrared carbon dioxide analyzer.

11.3 Occupational health and safety
The concentrated sulfuric acid (H2SO4) is very corrosive and must be handled carefully. Avoid 
contact with skin. Wear gloves, goggles, and a lab coat when handling and diluting. Always pour 
acid into water slowly while stirring. Never pour water into acid.

11.4 Validation

11.4.1 Operating range

0–3,000 µM

11.4.2 Detection limit and limit of quantitation

The detection limit, which is based on the residuals along the standard curve, is calculated for 
each run using equations 11.1 through 11.3:

Equation 11.1	
Cdl =

  yd−b  

where b is the y-intercept, m is the slope, and yd is the instrument response detection limit, which 
is calculated using equation 11.2:

Equation 11.2.	 yd = 3sy + b

m
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Where sy is based on the residuals between the measured instrument response for each standard 
concentration and the calibration curve-predicted response for each standard concentration and 
is calculated using equation 11.3:

Equation 11.3.	
sy =

   ∑di2 

where n is the number of standards in the calibration curve, and di is the difference between 
the measured instrument response for each standard concentration and the calibration curve-
predicted response for each standard concentration.

The limit of quantitation is calculated in the same manner as the detection limit, except equation 
11.2 is replaced with equation 11.4:

Equation 11.4.	 yq = 10sy + b

The averages of the detection limits and limits of quantitation for samples run between 2019 and 
2021 were as follows:

Detection limit 7.6 ± 3.8 µmol/L

Limit of quantitation 25.2 ± 12.8 µmol/L

11.5 Sample conditions
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. The sample 
analyzed must be 

	‒ collected in a manner that avoids contact with the atmosphere (i.e. an in situ sample),

	‒ stored in a 125-ml polyethylene bottle with a conical cap insert that is filled completely 
without air bubbles,

	‒ unfiltered,

	‒ stored at 4 ± 2 °C,

	‒ analyzed within 24 hours of sample collection, and

	‒ not acidified or frozen.

n−2

https://www.iisd.org/ela/


IISD.org/ela 93

The Chemical Analysis of Fresh Water

11.6 Equipment
	‒ LI-850 Li-Cor CO2 analyzer

	‒ manifold with sparge tube plumbed to ultra-high-purity (UHP) nitrogen gas and CO2 
analyzer (Figure 11.1)

	‒ a tank of UHP nitrogen (carrier gas) and regulator (CGA 580)

	‒ a tank of CO2 balanced with nitrogen and regulator (CGA 320) with an outlet line fitted 
with a septum for collecting CO2 gas standards with a syringe

	‒ 1 µm filter assembly

	‒ several syringes (1.0 ml to 3.0 ml); one set is used for gas standards, and the other set is 
used for the liquid samples

	‒ Peak Simple integration system to measure peak areas

Figure 11.1. Schematic of dissolved inorganic carbon analytical system

11.7 Purchased reagents

11.7.1 Calibration CO2 gas standard 

Tank of 1700–2000 ppm CO2, balanced with N2. Stable at room temperature indefinitely.

11.7.2 UHP nitrogen

A tank of UHP nitrogen gas. Stable at room temperature indefinitely.

11.7.3 Sulfuric acid, ACS grade

Store in an acid cabinet at room temperature. Stable as per manufacturer’s specifications.
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11.8 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

	‒ Reagents and standards are stable at room temperature unless otherwise specified.

11.8.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

11.8.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

11.8.3 0.01 N Sulfuric acid

Caution: ALWAYS pour acid into water slowly while stirring. NEVER pour water into acid.

Slowly pour 8.3 mL of concentrated ACS-grade sulfuric acid into ~975 mL of Milli-Q water. 
Cool and dilute to 1 L with Milli-Q water. Store at room temperature. Stable indefinitely.

11.8.4 Reference sample 

Reference samples are prepared in bulk according to Section 4, Reference Sample Preparation. 
Briefly, the DIC reference sample consists of water from Lake 239 that has been aged for at least 
one year. The reference sample is stored at 4 ± 2 ºC.

11.9 Quality control
This method has a number of conditions for calibration standards, reference standards, and 
reference samples that must be met before samples can be analyzed and the resulting data is 
recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the non-
conformance is investigated and reported in the Non-Conformance log, and appropriate corrective 
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action is taken before testing is resumed. If reanalysis is not possible, the samples are cancelled in 
Sample Master, with the non-conformance issue recorded during cancellation. 

11.9.1 Calibration curve

Calibration standards are run at the beginning and end of the run. Each standard is injected 
in duplicate, which must be within 5.0%. The linear correlation coefficients obtained from the 
calibration standards must have an R2 ≥ 0.995 with a first order fit. 

11.9.2 Reference sample

A reference sample is included at the beginning of every run. The concentration obtained must 
be within 5.0% of the expected value. Results for check sample performance are charted and 
assessed for drift and bias.

11.9.3 Duplicates

Each standard and sample is injected in duplicate, and the resulting peak areas must be within 
5.0%. A random duplicate, wherein two duplicate injections are conducted, is included in 
each run and after every 15 samples. Duplicates must agree to within 5.0% of each other. If 
duplication is inadequate, samples bracketed by the duplicates are reanalyzed.

11.9.4 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibration and 
Verification. The calibrations of the Eppendorf™ pipettes are verified on a weekly basis or prior 
to making standards using methods outlined in Section 3, Labware Calibrations and Verifications. 
Glassware is cleaned according to Section 2, Labware Cleaning.

11.10 Quality assurance
Quality assurance for DIC is maintained through annual participation in the Environment and 
Climate Change Canada Proficiency Testing Program (ECCC-PT). Non-compliance is defined 
by ECCC-PT and is reported directly to the Research Chemist.

11.11 Sample preparation
Ensure that there are no air bubbles in the sample bottle and that the sample is less than 24 
hours old.
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11.12 Analysis
1.	 Ensure the septum is sealed properly on the manifold and the LI-850 has been on for at 

least 30 minutes.

2.	 Create a new folder in the \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\DIC 
directory with the yyyymmdd_DIC format (e.g. 20200129_DIC).

3.	 Open the PeakSimple icon on the desktop

4.	 Open the control file (File > Open control file…) and open the DIC.con file located either 
on the desktop or at \\ela-lab.ca\shared\Chem Lab\Analysis Results\DIC.

5.	 Edit the default data file path field (Edit > Overall…) to equal the new directory name 
created in step 2. This tells the software where to save the files.

6.	 Edit the Post Run settings (Edit > Channels > PostRun (of channel1):

a.	 Edit the Save file as field to yyyymmdd_DIC01.chr.

b.	 Edit the Results log field to yyyymmdd_DIC

7.	 Save control file (File > Save control file…) as DIC.con (yes on overwrite).

8.	 Turn on N2 and CO2 gases. The manifold should read ~100 psi, and N2 should read ~11 psi.

9.	 Open the Excel template (“DIC calculation template.xls”) on the desktop. Enter the lab 
barometric pressure (inHg × 25.4 = mmHg) and lab air temperature. Then save the file as 
yyyymmdd_DIC.xls in the folder you created for that day. 

10.	 Click the spacebar to start the run.

11.	 Inject 0.5 mL 0.01N H2SO4 into the column. 

12.	 Using a syringe, inject a series of CO2 gas standard volumes (0.25, 0.5, 1.0, 1.5, 2.0, 
2.5, and 3.0 mL) in duplicate into the manifold, ensuring that the standard is not 
warmed by hands/fingers and that each standard volume is replicated within 5.0%. Label 
the components as “0.5 std”, etc. Copy the results (View > Results) to the calculation 
template. Ensure that the standard curve has an R2 ≥ 0.995.

13.	 Inject 0.25 mL of the L239 reference sample, in duplicate. Ensure that the replication is 
within 5.0% and the L239 reference sample concentration is within 5.0% of the expected 
value. Record the L239 reference sample concentration in the Reference Sample log  
\\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\Reference sample log.xls.

14.	 Inject 0.25 mL of each sample, in duplicate, with replication within 5.0%. Label the 
components with the sample number (e.g. 2020012902-01). If the peak area of the samples 
is not within the range of the calibration curve, adjust the injection volume accordingly 
and add the volume injected to the component label (e.g. 2020012902-01 1.0 mL). The 
sparging column can only handle a maximum cumulative volume of 2.0 mL of 
liquid. Once 2.0 mL of liquid has been injected into the column, remove the liquid through 
the septum using a syringe and inject another 0.5 mL 0.01N H2SO4 into the column.
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15.	 Analyze at least one sample in duplicate (i.e. two duplicate injections) for every 15 
samples.

Table 11.1. Typical sequence of standards, reference samples, and samples. A sample is 
duplicated at least every 15 samples, and a standard curve is run at the beginning and 
end of the run

16.	 Remove the liquid from the column and inject another 0.5 mL 0.01N H2SO4 into the 
column. Repeat step 12 with gas standards.

17.	 End the PeakSimple run by pressing ctrl + end on the keyboard. 

18.	 Ensure that the files are saved.

19.	 Remove the acid from the column and turn off the gases.

Inject. # Sample description

1–2 0.25 mL calibration standard

3–4 0.5 mL calibration standard

5–6 1.0 mL calibration standard

7–8 1.5 mL calibration standard

9–10 2.0 mL calibration standard

11–12 2.5 mL calibration standard

13–14 3.0 mL calibration standard

15–16 reference sample

17–18 sample 1

19–20 sample 2

21–22 sample 3

23–24 sample 4

25–26 sample 5

27–28 sample 6

29–30 sample 7

31–32 sample 8

33–34 sample 9

35–36 sample 10

Inject. # Sample description

37-38 sample 11

39-40 sample 12

41-42 sample 13

43-44 sample 14

45-46 sample 15

47-48 random duplicate from sample 
1-15

49-50 sample 16

51-52 sample 17

n-n+1 …etc., running a duplicate every 
15 samples 

n-n+1 reruns of problem samples

n-n+1 0.25 mL calibration standard

n-n+1 0.5 mL calibration standard

n-n+1 1.0 mL calibration standard

n-n+1 1.5 mL calibration standard

n-n+1 2.0 mL calibration standard

n-n+1 2.5 mL calibration standard

n-n+1 3.0 mL calibration standard
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11.13 Clean up
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, the sample bottles, 
volumetric flasks, etc. are cleaned by rinsing three times with hot water and three times with DRO 
water. Do not dispose of samples until the results are deemed satisfactory or the sample is more 
than 24 hours old. 

11.14 Calculations
The calculation of DIC in samples is performed by using the “DIC Calculation Template.xls” 
worksheet located at \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\DIC\DIC Calculation 
Template.xls or on the Desktop.

The concentration of CO2 in the DIC standards is calculated using equation 11.5, which utilizes 
the ideal gas law (i.e. PV = nRT):

Equation 11.5.	 	
C =

  PV

where C is the concentration of CO2 in the standard, P is the barometric pressure (atm) of the 
room, V is the volume (L) of gas injected, R is the ideal gas constant (L·atm/mol·K), and T is the 
room temperature (K). 

The concentration of DIC in the samples is calculated using equation 11.6:

Equation 11.6.	 C =      Asamp−b   ×    Vsamp

Where C is the concentration of the sample, Asamp is the sample peak area, Vsamp is the volume of 
sample injected into the column, b is the intercept, and m is the slope of the calibration curve. The 
sample concentration is reported to the nearest integer.

11.15 Data entry
The DIC concentrations for each sample, which are calculated using the DIC Calculation Template, 
as well as the QC data, are entered into the Sample Master LIMS to the nearest integer. The 
completed DIC Calculation Template is printed and filed into the DIC folder. 

(  )RT

(      )m (     )0.5

https://www.iisd.org/ela/


IISD.org/ela 99

The Chemical Analysis of Fresh Water

Appendix 11A. 0.01 N Sulfuric Acid Preparation Record
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12.0 Dissolved Organic Carbon – Non-
Purgative Organic Carbon (NPOC)

12.1 Introduction and scope
The following method is used in the IISD Experimental Lakes Area Analytical Service Laboratory 
for the determination of dissolved organic carbon (DOC) in fresh water and precipitation.

12.2 Method principle
Filtered water samples (Whatman GF/C filters or otherwise specified) are acidified with HCl to a 
pH of 2–3. The inorganic carbon component is removed by sparging with hydrocarbon-free ultra-
high-purity (UHP) compressed air. The remaining carbon in the sample is oxidized at 720 ºC 
in a combustion tube to carbon dioxide. The UHP air carries the combustion products to a 
dehumidifier to cool and dehydrate. Subsequently, a halogen scrubber removes chlorine and other 
halogens. A non-dispersive infrared analyzer then measures the carbon dioxide content in the gas 
and an analog detection signal (peak) is produced. 

12.3 Occupational health and safety

12.3.1 Acids and oxidants

This method requires the use of strong acids and oxidants. Hand and eye protection must be used 
when mixing and handling these reagents. Mixing should be performed in the fume hood.

12.3.2 Compressed gas

This method requires the use of compressed air to remove dissolved inorganic carbon (DIC) from 
samples and carry CO2 from DOC oxidation into the infrared detector. The cylinder in use must 
be properly secured vertically at all times.

12.4 Validation
This method is fit for the determination of DOC in fresh water. The method is still under 
validation in terms of the recovery of carbon from various DOC sources.

12.4.1 Operating range

40.8–2,000 µM
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12.4.2 Detection limit and limit of quantitation

The detection limit, which is based on the residuals along the standard curve, is calculated for 
each run using equations 12.1 through 12.3:

Equation 12.1.	
Cdl =

 yd−b

where b is the y-intercept, m is the slope, and yd is the instrument response detection limit, which 
is calculated using equation 12.2:

Equation 12.2.	 yd = 3sy + b

where sy is based on the residuals between the measured instrument response for each standard 
concentration and the calibration curve-predicted response for each standard concentration and 
is calculated using equation 12.3:

Equation 12.3.	
sy =

   ∑di2 
 

where n is the number of standards in the calibration curve, and di is the difference between 
the measured instrument reponse for each standard concentration and the calibration curve-
predicted response for each standard concentration.

The limit of quantitation is calculated in the same manner as the detection limit, except equation 
12.2 is replaced with equation 12.4:

Equation 12.4.		  yq = 10sy + b

The averages of the detection limits and limits of quantitation for samples run between 2018 and 
2018 were

Detection limit 40.8 ± 9 µmol/L

Limit of quantitation 136 ± 30 µmol/L

12.5 Sample conditions
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. The sample 
analyzed must be

	‒ field sampled in a Nalgene polyethylene bottle,

	‒ filtered within 24 hours,

	‒ stored in pre-washed polyethylene bottles (see Section 2, Labware Cleaning),

m

n−2
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	‒ stored at 4 ± 2 ºC, and

	‒ stored for no more than six months after filtration.

The alkaline buffering capacity of the sample must not exceed the acid buffering capacity of the 
hydrochloric acid added. An ideal pH of 2–3 must be achieved to purge inorganic carbon out of 
the sample before analysis. Failure to add adequate acid will result in false high values for DOC. 
DOC is converted to CO2 within the combustion tube of the system. Hence, any remaining 
inorganic carbon within the sample is accounted for as the total DOC of the sample.

12.6 Equipment
	‒ Shimadzu TOC-VCPH + TNM-1 Total Organic Carbon analyzer (TOC)

	‒ Shimadzu ASI-V auto sampler connected to the TOC-VCPH analyzer through a 
proprietary cable (ASI)

	‒ compressed hydrocarbon and CO2-free Air cylinder (UN 1002). (There is too much oil 
vapour in the filtered air lines installed in the building.)

	‒ compressed air regulator (CGA-590, dual-stage, stainless steel diaphragm)

	‒ a computer running Windows XP, or higher, with TOC Control-V installed. The computer 
is connected to the analyzer via a standard serial cable (RS232)

	‒ 24-mL glass vials

	‒ vial racks for auto sampler

	‒ polytetrafluoroethylene-coated septa and plastic caps for vials

	‒ DOC Batch Identification Worksheet (see Appendix 12F DOC Worksheet Shimadzu Full Run). 

12.7 Purchased reagents

12.7.1 Compressed air, UHP grade

A tank of ultra-high-purity compressed air. Stable at room temperature indefinitely.

12.8 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.

	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.
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	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

	‒ Reagents and standards are stable at 4 ºC unless otherwise specified.

12.8.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from a Thermo Scientific Barnstead D8902 Ion Exchange Cartridge, Mixed-Bed 
(> 15 MΩ∙cm purity). The feedwater for the D8902 Ion Exchange Cartridge is effluent from a 
Culligan Reverse Osmosis System. 

12.8.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

12.8.3 2 N Hydrochloric acid

Dilute 85 mL of concentrated HCl to a final volume of 500 mL with Milli-Q water. Stable 
indefinitely at room temperature.

12.8.4 Calibration standard stock – 0.1 M C

Dry potassium hydrogen phthalate (KC8H4O4) for four hours at 100 ºC in an oven. Place in a 
desiccator after drying and cool for at least five minutes. Dissolve 2.54022 g of KC8H4O4 into 
1 L of Milli-Q water. Stable for one year.

12.8.5 Reference standard stock – 
0.1 M C

Dry urea (NH2CONH2) for four hours at 
100 ºC in an oven. Place in a desiccator after 
drying and cool for at least five minutes. 
Dissolve 6.05526 g of NH2CONH2 into 1 L of 
Milli-Q water. Stable for one year.

12.8.6 DOC calibration standard curve

Seven DOC standards are prepared according 
to Table 12.1 in 250 mL quantities, with the 
exception of the 1000 µM standard, which is 
prepared in a 500 mL quantity. Stable for one 
week. 

Table 12.1. Dissolved organic carbon 
calibration standards

Cal std vol  
(µL)

Final vol  
(mL)

DOC conc.  
(µM)

0 250 0

250 250 100

750 250 300

1250 250 500

5000 500 1000

3750 250 1500

5000 250 2000
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12.8.7 Reference standard – 1000 µM C

The reference standard is prepared by diluting 2.5 mL of the 0.1 M reference standard stock to 
250 mL with Milli-Q. Stable for one year.

12.8.8 Reference sample

Reference samples are prepared according to Section 4, Reference Sample Preparation. Briefly, the 
reference sample consists of water from Lake 239 that has been aged for at least one year at 4 ºC. 

12.9 Quality control
This method has a number of conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data is 
recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the non-
conformance is investigated and reported in the Non-Conformance log, and appropriate corrective 
action is taken before testing is resumed.

12.9.1 Physical inspection

At the beginning of each run, all sample and reagent tubing, as well as the syringe, will be visually 
inspected for obstructions, residue, etc.

12.9.2 Blanks

Three blanks, consisting of Milli-Q water, are included at the end of the beginning of a run to 
clear out any residual carbon in the system. Additional blanks are included after the reference 
standard every 15–20 samples and immediately preceding the second calibration curve. 

12.9.3 Reference standard

A reference standard is included at the end of the first calibration curve. These must be within 
5.0% of the calibration standard of the same concentration.

12.9.4 Calibration curve

The linear correlation coefficients obtained from the calibration standards must have an 
R2 ≥ 0.995 with a first order fit. If necessary, new calibration standards should be prepared.
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12.9.5 Reference sample

A reference sample is included toward the beginning of every run. The DOC concentration 
obtained must be within 5.0% of the expected value. Results for check sample performance are 
charted and assessed for drift and bias.

12.9.6 Drift standard

A 1000 µM standard is run every 15–20 samples to assess drift. All 1000 µM standards, including 
those in the calibration curve, must agree within 5.0%.

12.9.7 Duplicates

Random duplicates are run every 15–20 samples. Samples for duplicate analysis are chosen at 
the beginning of the analysis run and must agree to within 5.0% of each other. If duplication is 
inadequate, samples bracketed by the duplicates are re-tested. When dilutions are required, a 
duplicate of each dilution factor is included.

12.9.8 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibration and 
Verification. The calibrations of the Eppendorf™ pipettes are verified on a weekly basis or prior to 
making standards using methods outlined in Section 3, Labware Calibrations and Verifications. All 
glassware is cleaned according to Section 2, Labware Cleaning.

12.10 Quality assurance
Quality assurance for DOC is maintained through bi-annual participation in the Environment 
and Climate Change Canada Proficiency Testing Program (ECCC-PT), as well as the Canadian 
Association for Laboratory Accreditation Inc. (CALA). Non-compliance is defined by these 
external agencies and is reported directly to the Research Chemist. Samples analyzed during the 
period of non-compliance are flagged in the database.

12.11 Sample preparation
1.	 Turn on the Shimadzu TOC-VCPH + TNM−1 instrument using the power button on 

the front of the machine at the bottom right and allow the instrument to warm up for 
45–60 minutes.

2.	 Fill out the DOC Batch Identification Worksheet with the appropriate vial positions of 
each sample. Be sure to include the date and analyst’s name. See Appendix 12F, DOC 
Worksheet Shimadzu Full Run for a typical full run sequence. 
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3.	 Set up the rack on the auto-sampler according to the DOC Batch Identification Worksheet 
as follows: 

a.	 Rinse each 24-mL glass vial with its respective standard or sample.

b.	 Fill vials to approximately 20 mL with standard or sample (just above the height of 
the rack). Filling the vial too full can result in splashing when the standard or sample 
is sparged. 

c.	 With the use of forceps or sterile 
nitrile gloves, place a Teflon-
coated septum in the cap with 
the Teflon side facing the sample. 
The Teflon septa can be reused 
even after having been perforated, 
provided the perforation is of 
reasonable size (less than 4 mm 
in diameter).

i.	 Do not use parafilm to 
seal the vials. Parafilm 
sticks to the needle upon 
acid addition, causing the 
vials to lift from position 
and break when the needle 
ascends.

Figure 12.2. Vial type selectionFigure 12.1. TOC-Control V program 
options

Figure 12.3. Method selection
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d.	 Screw the white plastic caps provided onto the vials to secure the septum in place 
(hand tight) and place the vial in the appropriate position in the rack.

e.	 Once all the standards and samples are in the rack, place the rack into the auto-
sampler and close the lid. The instrument will not function with the lid removed or 
sample rack missing.

12.12 Sample analysis
1.	 Open the compressed air source and set the pressure between 44 and 88 psi. Check to 

ensure there is enough compressed air left in the cylinder (~500 psi) for the complete run.

Figure 12.4. Sample Parameters window Figure 12.5. Calibration Curves window

Figure 12.7. Controls windowFigure 12.6. Calibration Curve Check window
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2.	 Fill up the two water reservoirs with Milli-Q water (amber bottle beside ASI, and small 
plastic container beside TOC).

3.	 Ensure that there is sufficient 2N HCl in the plastic bottle.

4.	 Ensure there is room in the waste container. 

5.	 Fill the humidifier and cooler drain reservoirs to the “Hi” marking. Open the front lid 
of the TOC using the latch on the left side at the bottom. The humidifier reservoir is 
found in the front of the machine and can be accessed by simply removing the reservoir 
cap and filling it up with Milli-Q. A 50-cc syringe and a clear plastic tube that leads to 
the outside of the machine are used to fill the cooler drain (located at the back). Inspect 
these reservoirs for mould or mildew growth and clean them with Milli-Q and brushes or 
Kimwipes™ if necessary. 

6.	 Turn on the PC and login to Windows. 

	‒ Username: chemlab 

	‒ Password: Fisheries1

7.	 Double-click the TOC Control-V icon on the desktop to open the software. The software 
can also be accessed by clicking Start > Programs > TOC-Control. 

8.	 A pop-up box will appear; select Sample Table Editor (Figure 12.1). The program will ask 
for a username; enter your initials and click Enter.

9.	 To create a new run, click File > New. A pop-up box will appear; select Sample Run.

10.	 The program will ask where you want data saved. Create a folder in C:\TOC 3201\Data\
year (i.e. 2019), and save as yyyymmdd_DOC.

11.	 A drop-down box appears requesting which vials are to be used. Select Chemlab24 for  
24-mL vials (Figure 12.2). Click OK.

12.	 From the toolbar, click Insert > Auto Generate. Click the “…” button, navigate to the 
ELA Sample Methods folder, select the “ELA Sample Methods.met” file, and click Next 
(Figure 12.3). This ensures the same parameters are always used for each run.

13.	 In the Sample Parameters window (Figure 12.4), enter the total number of samples 
(including reference and calibration standards, duplicates, and samples) to be included in 
the run in the No. of Samples field, and the number of the first vial in the Start Vial field. 
Leave the Sample Name and Sample ID blank and click Next.

14.	 The calibration is conducted externally from the software using the “DOC Calculation 
Template.xls.” Leave the check boxes blank in the Calibration Curves window and click 
Next (Figure 12.5).

15.	 Leave everything blank in the Calibration Curve Check window and click Next (Figure 12.6.

16.	 Leave everything blank in the Controls window and click Next (Figure 12.7). 
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Figure 12.8. Sparging / Acid Addition window for verification of vials

17.	 In the Sparging / Acid Addition window, check to see that the diagram indicating which vial 
positions are used matches the samples in the rack and click OK (Figure 12.8). 

18.	 Before you change the sample names, connect the instrument so that it can stabilize 
while you enter the sample names. Click on the lightning bolt icon in the toolbar. A pop-up 
window will appear. Select the Use PC Settings option.

19.	 Open the front lid of the Shimadzu TOC-VCPH + TNM-1 instrument and ensure the 
carrier gas flow rate is set to 150 mL/min and the TOC instrument pressure is 200 kPa. 
Adjust if necessary by turning the appropriate knobs. Let the system stabilize for a 
minimum of one hour (flow rate/
pressure gauges will not be active until 
the flow has been started by the 
software after the lightning bolt icon is 
clicked and the computer is connected 
to the machine).

20.	 In the toolbar select Instrument > 
Background Monitor. The Background 
Monitor will appear, giving details on 
the machine’s status (Figure 12.9). 
Wait until all options display a check 
mark before starting the run. If a 
checkmark does not appear within 
45 minutes in all options, the catalyst 
might need to be regenerated (see 
Section 12.16).

Figure 12.9. Background Monitor window
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Figure 12.10. Main Sample window

21.	 While waiting for the furnace to heat up and the background noise to stabilize, enter the 
Sample ID for each sample in the “Sample Name” column (Figure 12.10) of the Main 
Sample window. 

22.	 Inspect all flow lines for any 
precipitates or residues. From 
the toolbar, select Instrument > 
Maintenance > Washing. Ensure that 
there is water in the reservoirs before 
starting this procedure. Select TC Port, 
ASI Port, and IC Port. 

Note: The maintenance options are 
only available when the Background 
Monitor window is closed.

23.	 Wash all other components of the 
system from residues by selecting 
Instrument > Maintenance > Residue 

Figure 12.11. Standby window
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Removal in the toolbar. Ensure that there is enough acid in the reagent containers before 
starting this procedure.

24.	 Once the Background Monitor indicates the machine has stabilized and the Sample 
Names are entered in the Main Sample window, click the green traffic light button in 
the toolbar to start the analysis. The Standby pop-up window will appear (Figure 12.11) 
asking which components to shut down once the run is complete. Select Shut Down 
Instrument. This shuts down the furnace before the fan to ensure that the instrument does 
not melt. Click Standby.

Note: Do not shut down the instrument using the power button on the 
Shimadzu TOC-VCPH + TNM-1 instrument. This will turn off the cooling fan at 
the inlet to the combustion column, which keeps the plastic components of the injection 
mechanism from melting. 

25.	 The sparging/acid addition window will 
appear. Check the box for acid addition 
and click OK. The analysis will now 
begin. Samples are processed at a rate 
of ~11 min/sample. 

26.	 If you want to watch or check the peak 
profile or area as samples are analyzed, 
click View > Sample Window. This is 
a good way to check that the samples 
are running normally before you 
leave for the night. Expected values 
for various standards are provided in 
Table 12.2.

27.	 Once the run is complete, turn off the gas valve on the compressed air.

12.13 Clean up
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, the vials, caps, 
and septa are cleaned by rinsing three times with hot water and three times with DRO water. 
Vials are placed upside down in the rack and air dried. Lids and septa are air dried in a metal 
mesh container with aluminum foil placed on top to prevent exposure to dust particles. Visually 
inspect the vials, lids, and septa for cracks, large perforations, residues, etc., and discard them if 
compromised.

12.14 Calculations
The calculation of DOC in samples is performed by using the “DOC Calculation Template-
updated 2019Apr.xls” located at C:\TOC 3201\Data\DOC Calculation Template.xls.

Table 12.2. Approximate peak areas 
expected with some of the standards 
analyzed

Standard Peak area

1000 ref ~195

1000 cal ~190

2000 cal ~380

Milli-Q ~2-4

Lake 239 ~80-90 (conc. = ~460)
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Concentrations of DOC are calculated using equation 12.5:

Equation 12.5.	
C =

  Asamp − Ablk − b

where C is the concentration of the sample, Asamp is the sample absorbance, Ablk is the reagent 
blank absorbance, m is the slope, and b is the intercept of the calibration curve after correcting for 
the reagent blank absorbance. The sample concentration is reported to three decimals.

If a dilution has been made, the concentration of the sample needs to be corrected for the 
concentration of DOC in the dilution water using equation 12.6:

Equation 12.6.	 C = (C0 × D) − ((Cdil  × (D − 1)) 

where C0 is the concentration of DOC in the diluted sample, Cdil is the concentration of DOC in 
the dilution water, and D is the dilution factor, which is calculated using equation 12.7:

Equation 12.7	
D =

  V1

 

where V1 is the volume of the diluted sample, and V0 is the volume of the undiluted sample.

To retrieve the data:

1.	 In TOC Control V Sample Table window, export the data by selecting File > Export to 
ASCII > Sample Table and Each Injection.

2.	 Navigate to the folder you created in Section 12.12, step 11 (C:\TOC 3201\Data\
year\yyyymmdd_DOC), and save the file in the yyyymmdd_DOC_Raw format (where 
yyyymmdd is the analysis date; e.g. 20201207_DOC_Raw.txt). Right-click on the 
yyyymmdd_DOC_Raw.txt file and select Open with Excel. Move the .pkt and .t32 files into 
this folder as well.

3.	 Copy the “Sample Name” and “Mean Area” columns to the “RAW” and “dup removal” 
tabs in the “DOC Calculation Template.xls.”

4.	 In the “dup removal” tab, remove the duplicates by selecting Data > Filter > Advanced, 
then place a check mark in the “Unique Values Only” box and click OK.

5.	 Use the contents of the “dup removal” tab to populate the yellow cells in the “Calc” tab 
with the Sample ID, dilution factor and mean peak areas of each of the blanks, calibration 
standards, reference standards, reference samples, and samples.

6.	 Information on the date, analyst’s initials, standard lot numbers, expiry date and stock 
concentrations, number of calibration standards (n), reference standard preparation date, 
and reference sample check batch number are also recorded in this spreadsheet in the 
yellow fields. 

m

V0
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Note: Do not use the first three Milli-Q samples, as these are used to flush the system 
prior to the run.

Save the completed “DOC Calculation Template.xls” as yyyymmdd_DOC.xls (e.g. 20201207_
DOC.xls) in the directory C:\TOC 3201\Data\year\yyyymmdd_DOC. There should be four files 
in each sample run folder (i.e. a .pkt, a .t32, a .txt, and a .xls). 

12.15 Data entry
The DOC concentrations for each sample, which are calculated using the DOC Calculation 
Template and QC data are entered into the Sample Master LIMS. The completed DOC 
Calculation Template is printed and filed into the DOC folder. 

12.16 Troubleshooting and maintenance
If the instrument needs to be shut down due to an error (e.g. Vertical Arm Position Error), follow 
these steps:

1.	 Briefly (~5 seconds) turn off the Shimadzu TOC-VCPH + TNM-1 instrument using the 
power button on the front right-hand side.

2.	 Immediately turn the instrument back on using the same power button. This will shut off 
the alarm, but the fans are not off long enough to melt the inside of the instrument. 

3.	 Close the TOC-Control V software and save whatever data was processed before the error 
occurred. 

4.	 Re-launch the program and follow steps 7–19 in Section 12.12.

5.	 Connect the PC to the instrument using the lightning bolt icon.

6.	 Ensure no samples are listed in the main sample window. Select Instrument > Standby 
and select Shut Down Instrument. This will shut down the instrument over a period of 30 
minutes in the appropriate order ensuring the safety of the instrument. 

Note: If the instrument will not connect properly, repeat steps 7–19 of the 12.12 Sample 
analysis section again after the program has been closed.

If the reproducibility of the machine is poor, the catalyst might need to be regenerated. From the 
toolbar select, Instrument > Maintenance > Regeneration of Catalyst. Ensure that there is enough 
acid and water (at least half full) in the reservoirs before performing this step. If the problem is 
still not resolved after performing this step, the catalyst may need to be replaced. See TOC-V 
User’s Manual for the replacement of the catalyst.

If the PC loses connection with the system for any reason, both the PC and the machine must 
be reset. Shut down and restart the PC, then turn off the power on the TOC/TN system, wait 15 
seconds, and turn the power on again. 

https://www.iisd.org/ela/


IISD.org/ela 114

The Chemical Analysis of Fresh Water

If the needle of the autosampler does not return to its home position, go to Instrument > 
Maintenance > Mechanical Check > ASI / 8Port Sampler (Tab) > Arm Vertical Reset.

The halogen scrubber must be changed once half of the column changes colour from blue to 
white. The halogen scrubber’s main function is to absorb HCl gas within the sample lines to 
prevent corrosion within the system.

If a stable baseline cannot be achieved after one hour from the time the carrier gas was turned 
on, the CO2 absorber of the instrument must be replaced (the aluminum column found on the 
outside of the machine). The CO2 absorber is typically good for one year after its first use.
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Appendix 12A. 2 N Hydrochloric Acid Preparation Record
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Appendix 12B. 0.1 M Carbon Calibration Standard Stock 
Preparation Record
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Appendix 12C. 0.1 M Carbon Reference Standard Stock 
Preparation Record
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Appendix 12D. Carbon Calibration Curve Preparation Record
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Appendix 12E. 1,000 µM Carbon Reference Standard 
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Appendix 12F. DOC Worksheet Shimadzu Full Run
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13.0 Absorbance Scan

13.1 Introduction and scope
The following method is used in the IISD Experimental Lakes Area Analytical Service Laboratory 
for the determination of dissolved organic carbon (DOC) optical characteristics in fresh water 
and precipitation.

13.2 Method principle
DOC in natural waters can be comprised of many different species, all with unique optical 
properties as a result of their differing molecular structures, molecular weights, and sources. 
Certain optical properties can be identified in an ultra-violet visible (UV-VIS) absorbance 
spectrum (200–800 nm). The absorbance ratios at certain wavelengths and the spectral slopes of 
certain sections have been shown to be indicative of the molecular properties of the DOC species. 
There are several reportable values with differing levels of significance and relation to the physical 
properties of carbon. The reportable values for the natural waters of boreal lakes are:

	‒ Log-transformed spectral slopes of 275–295 nm (S275−295) and 350–400 nm (S350−400), 
and the slope ratio (Sr) of these slopes, respectively;

	‒ Absorbance ratios of a250/a365 and a255/a436 (E2:E3 and E2:E4);

	‒ Spectral slopes in the UV-A, UV-B, and UV-C range (250–280 nm, 280–315 nm, and 
315–400 nm); and

	‒ Specific UV-absorbance at 254 nm (SUVA254). 

Sr has been found by Helms et al. (2007) to be inversely related to the molecular weight of DOC. 

Lei et al. (2019) split the UV portion of absorbance (250nm–400nm) into its three components—
UV-A, UV-B, and UV-C—for better resolution on the behaviour of DOC in that range. Lei et al. 
(2019) also found that E2:E3 and E2:E4 correlate with Suv-b and Suv-a, respectively.

SUVA254 has been shown by Weishaar et al. (2003) to be strongly correlated to % aromaticity of 
DOC species in aquatic waters (R2 = 0.97). 

13.3 Occupational health and safety
There are no occupational health and safety concerns associated with this analysis. 
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13.4 Validation

13.4.1 Operating range

200 nm–800 nm

13.5 Sample conditions
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. The sample 
analyzed must be 

	‒ filtered through a 1.2 µm GF/C filter within 24 hours of sample collection,

	‒ stored in pre-washed amber glass vials (refer to Section 2, Labware Cleaning for details),

	‒ stored in the dark at 4 ± 2 ºC, and

	‒ stored for no more than 14 days.

pH has occasionally had a significant effect on absorbance scans, which Weishaar et al. (2003) 
found to be negligible outside of a range of 2.0–8.6. For IISD-ELA waters, which range primarily 
from ~ 4.5 to 8.5, a pH adjustment is unnecessary. 

Both Fe2+ and Fe3+ are known to display characteristics in the UV-C absorption range. Weishaar 
et al. (2003) tested this and found that for most natural waters (< 0.5 mg/L Fe), interference 
was negligible. NO3 can also interfere: Weishaar et al. (2003) found that the tail of the peak 
for NO3 was relevant only in concentrations above 40 mg/L. For these reasons, Fe and NO3 
concentrations in samples should be monitored and noted if they are above these concentrations.

13.6 Equipment
	‒ Shimadzu UV-1800 scanning spectrophotometer

	‒ a computer running UV probe software

	‒ two 10 mm pathlength quartz cuvettes

	‒ two 100 mm pathlength quartz cuvettes

13.7 Prepared reagents
	‒ Preparation information for reference samples is recorded in the Reagent Preparation 
logbook.

	‒ Reference sample containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reference samples before pouring in the bulk of new reference samples.
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13.7.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

13.7.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

13.7.3 Reference sample

Reference samples are prepared in bulk according to Section 4, Reference Sample Preparation. 
Briefly, the reference sample consists of water from Lake 239 that has been aged for at least one 
year at 4 ºC, filtered through a 1.2 µm GF/C filter, and stored in the dark.  

13.8 Quality control
This method has a number of conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data is 
recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the non-
conformance is investigated and reported in the Non-Conformance log, and appropriate corrective 
action is taken before testing is resumed.

13.8.1 Blanks

An instrument blank containing solely Milli-Q water will be run at the beginning of each run, 
ensuring that at no point during the spectrum the blank registers more than 0.005 absorbance 
units.

13.8.2 Reference sample

A reference sample of aged Lake 239 water is included in every analytical run. The values 
obtained must be within 5.0% of the expected values. Results for check sample performance are 
charted and assessed for drift and bias.

13.8.3 Instrument duplicate

Instrument duplicates are run every 16 samples to ensure replicability of the instrument. 
Duplicates must agree to within 5.0% of each other. If duplication is inadequate, samples 
bracketed by the duplicates are reanalyzed. 
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13.8.4 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibration and 
Verification. The calibrations of the Eppendorf™ pipettes are verified on a weekly basis or prior to 
making standards using methods outlined in Section 3, Labware Calibrations and Verification. All 
glassware is cleaned according to Section 2, Labware Cleaning.

13.9 Quality assurance
Proficiency testing is not currently conducted for the absorbance scans. 

While solid-state standards are not currently used to confirm the absorbance wavelength on the 
spectrophotometer, this practice will be implemented in future studies.

13.10 Sample preparation
1.	 A subsample of filtered sample is transferred to a pre-labelled, 20 mL polyethylene vial 

and stored in the dark at 4 ± 2 ºC.

2.	 Remove samples from the refrigerator ~30 minutes prior to analysis to avoid condensation 
buildup on quartz cuvettes; keep samples in the dark.

13.11 Analysis
1.	 Turn on the power to the Shimadzu UV-1800 Spectrophotometer and allow it to warm up 

for at least 45 minutes. Once warm, on the spectrophotometer, click Enter followed by F4 
to allow for PC control.

2.	 On the desktop PC, double-click the UV Probe Absorbance scan method shortcut.

3.	 Click the Connect button at the bottom of the UV Probe window. 

4.	 Create a new folder in the \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\Absorbance 
scan\yyyy_Absorbancescan directory with the yyyymmdd_Absorbancescan format with 
yyymmdd reflecting the analysis date (e.g. 20200601_Absorbancescan). This folder will 
function as the direct saving location for spectrum and text files. 

5.	 Once the lamp is warm, rinse two 10-mm quartz cuvettes with Milli-Q water. Use a 
Kimwipe™ to ensure there is no smudging or dust particles.

6.	 Fill both quartz cuvettes with Milli-Q water and visually inspect them to confirm the 
cleanliness of the light path of the cell. Place both cuvettes filled with Milli-Q in the two 
holders in the spectrophotometer. 

7.	 Select the Baseline option at the bottom of the screen. Confirm baseline from 800 nm to 
200 nm and click OK.		
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8.	 Confirm that the front cuvette is still free from contaminants, and then click Auto Zero at 
the bottom of the screen.

9.	 Click Start at the bottom of the PC screen. A filepath will be presented to you. Select the 
filepath by clicking ... , and direct it to the folder created for this analysis. Change your 
filename from File_xxxxx_xxxxx to yyyymmdd_MQ_abscan, click Open, then OK. 

10.	 When the spectrum for the Milli-Q has finished, ensure that the absorbance has not gone 
above 0.005 at any point during the spectrum. If successful, continue to step 11. If not, 
rinse both cuvettes well and repeat steps 6–10.

11.	 Go to the Operation tab at the top of the window. Select Data Print, and the wavelengths 
and absorbances should appear in the centre of the screen. 

12.	 Select all the wavelengths by clicking RawData at the top of the table and then open the 
“File” tab and click Save As. Save two copies, one as “Spectrum Files (*.spc)” and one as 
“Data Print Table (.txt).” If the filepath was set up correctly in step 9, you should be able 
to click Save. If not, find the correct folder and create the correct name for the sample and 
then proceed to save.  

13.	 Rinse the front cuvette at least three times with Milli-Q water, and then rinse and fill with 
the reference sample. Repeat step 9, but save the file as yyyymmdd_L239_abscan. 

14.	 While the sample is running, begin to calculate your reportable values. Minimize the UV 
Probe window, go to \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\Absorbance scan, 
and open “Absorbance Scan Calculation Template.xls.”

15.	 Open the yyyymmdd_MQ_abscan.txt file in Notepad. Select All (Ctrl-A on the keyboard 
or select from the Edit tab), and Copy (Ctrl C on the keyboard or select from the Edit tab). 

16.	 Navigate to the “Raw Data” tab in the “Absorbance Scan Calculation Template.xls” and 
select the square in the spreadsheet with “Paste Special Here.”

17.	 Paste the .txt file by clicking on the arrow below the Paste button on the top left of the 
screen and select “Use Text Import Wizard.” A window will open. Ensure that “Delimited” 
is selected, and click Next. In the next window, select “comma” in the “Delimiters” section 
and click Finish.

18.	 Ensure that the data has properly pasted and then save the file as yyyymmdd_MQ_abscan.
xlsx in the folder created in step 4. 

Note: Each sample should now have three files associated with it: .spc, .txt., and .xlsx. 

19.	 Copy the yellow squares (S275–S295 to a254) in the “Reportable values” tab and open 
the Absorbance Scan Benchsheet in the \\ela-lab.iisd.ca\shared\Chem Lab\Analysis 
Results\Absorbance scan directory. Select the cell to the right of the appropriate “Sample 
ID” (e.g. the S275-295 cell in the MQ row) and right-click Paste Special with “Values” 
and “Transpose” selected. 

20.	 Once the scan of the reference sample has finished, if satisfactory results are obtained, 
repeat step 12 to save the .txt and .spc files for the reference sample. 
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21.	 Rinse the front cuvette at least three times with Milli-Q water, and then rinse and fill with 
sample. Repeat step 9 but save the file as SampleID_abscan. 

22.	 While the sample is running, repeat steps 14–19, but for the reference sample (e.g. 
yyyymmdd_L239_abscan). 

23.	 Once the scan of the sample has finished, repeat step 12 to save the .txt and .spc files for 
the sample.

24.	 Repeat step 21. 

25.	 While the sample is running, repeat steps 14–19, but for the sample (e.g. SampleID_
abscan). 

26.	 Repeat steps 23–25 until all of the samples have been analyzed, including a duplicate 
every 16 samples, and reported values are copied to the Absorbance Scan Benchsheet.

27.	 Enter the analyst and analysis date in Absorbance Scan Benchsheet and save it as 
yyyymmdd_absorbancescans in the folder created in step 4. 

13.12 Clean up
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, the cuvettes and 
vials are cleaned by rinsing three times with hot water, followed by three times with DRO water.

13.13 Calculations
All calculations of the reportable values from the absorbance scans are performed by using the 
“Absorbance Scan Calculation Template.xls” worksheet located in the \\ela-lab.iisd.ca\shared\Chem 
Lab\Analysis Results\Absorbance scan directory and following steps 14–19 in Section 13.11.

Calculations are done using the Napierian absorption coefficient, which returns values in m-1. 
This is calculated using equation 13.1.

Equation 13.1.	
aλ =

 2.303Aλ

where λ = the wavelength in nm, a = the absorption coefficient, A = absorbance, and l = path 
length of the cell (m). 

Two absorption ratios are reported – a2:a3 and a2:a4. These are calculated by equations 13.2 and 
13.3, respectively:

Equation 13.2.	
a3 =

 a255

Equation 13.3.	
a2:a4 =

 a255

l

a355

a456
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where the subscripts denote the wavelength of the absorption coefficients in nm. 

Absorbance spectrums function similarly to exponential decay functions, thus they can be log 
transformed, and spectral slopes can be reported in this manner. The entire spectrum can be log 
transformed in Microsoft Excel by reporting value lna for all values a. The slopes are determined 
for all parameters, S275-295, S350-400, Suv-a, Suv-b, and Suv-c by using the line of best fit calculated 
by Microsoft Excel over those wavelengths. Sr is then calculated by equation 13.4:

Equation 13.4.	
SR =

  S275-295

SUVA254 is calculated by normalizing the Napierian absorption coefficient at λ =254 nm to the 
DOC concentration (eq. 13.5):

Equation 13.5.	
SUVA254 =

   a254

13.14 Data entry
The reportable values for each sample, which are calculated using the “Absorbance Scan 
Calculation Template.xls,” as well as the QC data, are entered into the Sample Master LIMS. The 
completed Absorbance Scan Benchsheet (saved as yyyymmdd_absorbancescans) is printed and 
filed into the “Absorbance Scan” folder. 
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14.0 Nitrite, Nitrate, and Ammonia: 
Colourimetric method

14.1 Introduction and scope
The following method is used in the IISD Experimental Lakes Area Analytical Service Laboratory 
for the determination of nitrite, nitrate, and ammonia in fresh water and precipitation.

14.2 Method principle
This automated procedure is based on methods designed for the analysis of nitrite, nitrate, and 
ammonia using the SEAL Analytical AutoAnalyzer 3 HR Continuous Segmented Flow Analyzer 
(SEAL Analytical, 2015; SEAL Analytical, 2016). The nitrate analysis uses the method whereby 
nitrate is reduced to nitrite by a copper-cadmium reduction column (Bendschneider, 1952; 
Brewer & Riley, 1965; Morris and Riley, 1963; Stainton, 1974; Stainton et al., 1977; Woods et al., 
1967). Under appropriate conditions, nitrite complexes with an N-(1-Naphthyl)ethylenediamine 
dihydrochloride (NNED), sulfanilamide and a phosphoric acid-based reagent. Extreme care is 
taken while handling the phosphoric acid to avoid phosphorus contamination in labware. When 
the nitrite reacts with this colour reagent under acidic conditions, it forms a diazo compound, 
which couples with the N-1-NNED to form a purple azo dye. The colour intensity is proportional 
to the amount of nitrite in the sample. The absorption maximum is 543 nm. Under appropriate 
conditions, ammonia complexes with an ethylenediamine tetra-acetic acid (EDTA) and tri-
sodium citrate dehydrate-based reagent. When the ammonia and complexing reagent react with 
the phenol and hypochlorite, an indophenol blue is formed. The colour intensity is proportional 
to the amount of ammonia in the sample. The absorption maximum is 660 nm.

14.3 Occupational health and safety
The phenol reagent used is corrosive, toxic and a health hazard. Avoid contact with skin. Handle 
in a fume hood and wear a face shield and gloves when handling and diluting. 

Cadmium is toxic and should be handled carefully. Avoid contact with skin or inhaling. Wear 
gloves and use a handle in the fume hood.

The concentrated hydrochloric acid (HCl) used for reagent preparation is corrosive and reacts 
violently with water. Handle in a fume hood to avoid HCl vapours. Avoid contact with skin. Wear 
goggles and gloves when handling and diluting. Always pour acid into water slowly while stirring. 
Never pour water into acid.
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14.4 Validation

14.4.1 Operating range

0.50–50 µg/L NO2-N

1.4–100 µg/L NO3-N 

10.6–500 µg/L NH3-N

14.4.2 Detection limit and limit of quantitation

The detection limit, which is based on the residuals along the standard curve, is calculated for 
each run using equations 14.1 through 14.3:

Equation 14.1.	
Cdl =

  yd-b

where b is the y-intercept, m is the slope, and yd is the instrument response detection limit, which 
is calculated using equation 14.2:

Equation 14.2.	 yd = 3sy + b

where sy is based on the residuals between the measured instrument response for each standard 
concentration and the calibration curve-predicted response for each standard concentration. It is 
calculated using equation 14.3:

Equation 14.3.	
sy =

   ∑di2

where n is the number of standards in the calibration curve, and di is the difference between 
the measured instrument response for each standard concentration and the calibration curve-
predicted response for each standard concentration.

The limit of quantitation is calculated in the same manner as the detection limit, except equation 
14.2 is replaced with equation 14.4:

Equation 14.4.	 yq = 10sy + b

The averages of the detection limits and limits of quantitation for samples run between 2019 and 
2020 were as follows: 

m

n−2
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Table 14.1. Average (± standard deviation) detection limit and limit of quantitation for 
nitrite, nitrate, and ammonia analyses conducted in 2019 and 2020

Detection limit (µg/L) Limit of quantitation (µg/L)

NO2-N 0.5 ± 0.2 1.6 ± 0.6

NO3-N 1.4 ± 1.1 4.6 ± 3.7

NH3-N 10.6 ± 6.3 35 ± 21

14.5 Sample condition
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. The sample 
analyzed must be

	‒ field sampled in a Nalgene polyethylene bottle,

	‒ filtered within 24 hours,

	‒ stored in a sealed Nalgene polyethylene bottle,

	‒ stored and analyzed within two days, and

	‒ stored at 4 ± 2 °C. 

14.6 Equipment
	‒ SEAL AutoAnalyzer 3 HR 

	‒ three digital colorimeters

	‒ high-precision pump outfitted with the pump tubes outlined in the system maps 
(SEAL Analytical, 2015, 2016).

	‒ three multitest manifolds

	‒ auto sampler

	‒ computer running AACE 7.09 software

	‒ 11 mL plastic tubes for samples (sample cups)

	‒ 14.5 mL plastic tubes for standards

14.7 Purchased reagents

14.7.1 NO2 calibration standard stock

Commercial certified (traceable to NIST) NO2-N standard
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1.0 mL = 0.1 ± 0.01 mg NO2-N

The standard is stable until the expiry date on the manufacturer’s label.

14.7.2 NO2 reference standard stock

Commercial certified (traceable to NIST) NO2-N standard

1.0 mL = 1 ± 0.01 mg NO2-N 

The standard is stable until the expiry date on the manufacturer’s label. It must be from a 
different manufacturer than the standard used for calibration standards.

14.7.3 NO3 calibration standard stock

Commercial certified (traceable to NIST) NO3-N standard

1.0 mL = 0.1 ± 0.01 mg NO3-N

The standard is stable until the expiry date on the manufacturer’s label.

14.7.4 NO3 reference standard stock

Commercial certified (traceable to NIST) NO3-N standard

1.0 mL = 1 ± 0.01 mg NO3-N

The standard is stable until the expiry date on the manufacturer’s label. It must be from a 
different manufacturer than the standard used for calibration standards.

14.7.5 NH3 calibration standard stock

Commercial certified (traceable to NIST) NH3-N standard

1.0 mL = 0.1 ± 0.01 mg NH3-N

The standard is stable until the expiry date on the manufacturer’s label.

14.7.6 NH3 reference standard stock

Commercial certified (traceable to NIST) NH3-N standard

1.0 mL = 1 ± 0.01 mg NH3-N
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The standard is stable until the expiry date on the manufacturer’s label. It must be from a 
different manufacturer than the standard used for calibration standards.

14.7.7 Cadmium – 20–60 mesh size

Cadmium is stable indefinitely at room temperature.

14.8 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.

	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

14.8.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

14.8.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

14.8.3 Mixed calibration standard stock – 0.5 µg/mL NO2-N, 0.5 µg/mL NO3-N, 
and 5 µg/mL NH3-N

Dilute 0.5 mL of the 0.1 mg/mL NO2-N, 0.5 mL of the 0.1 mg/mL NO3-N, and 5.0 mL of the 
0.1 mg/mL NH3-N to 100 mL with Milli-Q water in a volumetric flask. Make fresh weekly.
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Table 14.2. Mixed calibration standard stock preparation volumes

Analyte
Stock conc. 

(mg/mL)
Vol. added  

(µL)
Flask vol  

(mL)
Final conc.  

(µg/mL)

NO2 0.1 500 100 0.5

NO3 0.1 500 100 0.5

NH3 0.1 500 100 5.0

14.8.4 Mixed reference standard stock – 10 µg/mL NO2-N, 10 µg/mL NO3-N, and 
100 µg/mL NH3-N

Dilute 1.0 mL of the 1.0 mg/mL NO2-N, 1.0 mL of the 1.0 mg/mL NO3-N, and 10.0 mL of the 
1.0 mg/mL NH3-N reference stocks to 100 mL with Milli-Q water in a volumetric flask. Make 
fresh monthly. 

Table 14.3. Mixed reference standard stock preparation volumes

Analyte
Stock conc. 

(mg/mL)
Vol. added  

(µL)
Flask vol  

(mL)
Final conc.  

(µg/mL)

NO2 1000 1000 100 10

NO3 1000 1000 100 10

NH3 1000 10 000 100 100

14.8.5 Mixed reference standard – 25 µg/L NO2-N, 50 µg/L NO3-N, and 250 µg/L 
NH3-N

Dilute 0.25 mL of mixed reference standard stock to 100 mL with Milli-Q water in a volumetric 
flask. Make fresh weekly.

14.8.6 NO2 standard – 50 µg/L NO2-N

Dilute 0.05 mL of the 0.1 mg/mL NO2-N to 100 mL with Milli-Q water in a volumetric flask. 
Make fresh weekly.

14.8.7 NO3 standard – 50 µg/L NO3-N

Dilute 0.05 mL of the 0.1 mg/mL NO3-N to 100 mL with Milli-Q water in a volumetric flask. 
Make fresh weekly.
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14.8.8 NO2 standard – 2000 µg/L NO2-N

Dilute 0.2 mL of the 0.1 mg/mL NO2-N to 100 mL with Milli-Q water in a volumetric flask. 
Make fresh monthly.

14.8.9 NO3 standard – 2000 µg/L NO3-N

Dilute 0.2 mL of the 0.1 mg/mL NO3-N to 100 mL with Milli-Q water in a volumetric flask. 
Make fresh monthly.

14.8.10 Colour reagent

	‒ 10 g sulfanilamide

	‒ 0.5 g NNED

	‒ 100 mL concentrated phosphoric acid

Dissolve sulfanilamide, NNED, and concentrated phosphoric acid into 1 L of Milli-Q water. Heat 
if necessary. Stored in an amber bottle; it is stable for one month.

14.8.11 Ammonium chloride

40 g ammonium chloride

710 µL ammonium hydroxide

Dissolve ammonium chloride and ammonium hydroxide into 1 L of Milli-Q water. The pH of 
this reagent should be 7.5 ± 0.1. Adjust the ammonium hydroxide as necessary using high-purity 
hydrochloric acid or ammonium hydroxide to achieve this pH. It is stable for one month.

14.8.12 Complexing reagent

	‒ 15 g EDTA

	‒ 120 g tri-sodium citrate dihydrate

	‒ 0.5 g sodium nitroprusside

	‒ 3 mL Brij-35, 22–30% solution

Dissolve EDTA, tri-sodium citrate dihydrate, and sodium nitroprusside into 1 L of Milli-Q water 
and then add Brij-35, 22–30% solution. Store in an amber bottle; it is stable for two weeks. 

Note: If the calcium or magnesium concentrations of samples are likely to exceed 
0.005 m/L and 0.04 mol/L, respectively, the EDTA should be increased to 30 g/L. 
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14.8.13 Hypochlorite

Dilute commercial unscented bleach (preferably Chlorox) with 10 parts Milli-Q water to 1 part 
bleach. It is stable for 24 hours.

14.8.14 Phenol

	‒ 50 g phenol

	‒ 30 g sodium hydroxide

Dissolve phenol and sodium hydroxide into 1 L of Mill-Q water. Store in an amber bottle. It is 
stable until the solution turns brown.

Note: Final pH should be 11.5–11.9. If the final pH is too high, reduce the sodium 
hydroxide concentrations. If the pH is too low, increase the sodium hydroxide 
concentration.

14.8.15 Brij-35 – 1mL/L

Dilute 1 mL of Brij-35, 22–30% solution to 1 L with Milli-Q water. It is stable indefinitely.

14.8.16 Brij-35 – 2 mL/L

Dilute 2 mL of Brij-35, 22–30% solution to 1 L with Milli-Q water. It is stable indefinitely.

14.8.17 Brij-35 – 6 mL/L

Dilute 6 mL of Brij-35, 22–30% solution to 1 L with Milli-Q water. It is stable indefinitely.

14.8.18 Copper sulfate solution – 2%

Dissolve 2 g of copper sulfate in 1 L of Milli-Q water. It is stable indefinitely. 

14.8.19 Hydrochloric acid – 6 N

Cautiously, while swirling, add 495 mL of concentrated hydrochloric acid to ~400 mL of Milli-Q 
water. Cool to room temperature. Dilute to 1 L with Milli-Q water. It is stable indefinitely.

14.8.20 Cadmium column

Place ~10 g of cadmium mesh in a 250-mL beaker. Add 50 mL of 6 N HCl to the beaker and 
swirl to clean the cadmium for at least one minute. Decant the HCl into waste, add another 50 
mL of 6 N HCl, and swirl to clean for another minute. Decant the HCl and rinse the cadmium 
with at least three successive rinses of Milli-Q water. Decant the Milli-Q and add 50 mL of 
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copper sulfate solution and swirl until the blue colour is gone from the supernatant. Decant the 
copper sulfate and rinse the cadmium with at least three successive rinses of Milli-Q water. Add 
another 50 mL of copper sulfate and swirl until the blue colour is gone from the supernatant. 
Decant the copper sulfate and gently rinse with Milli-Q until all of the floating precipitate is gone. 

Close one end of an 18-cm piece of 0.110" I.D. Tygon tubing with glass wool. Connect the 
other end of the tubing to a small funnel using a small piece of 1/8" I.D. tubing. Elevate the 
funnel using a ring stand and attach a 50-mL syringe to the end with wool. Fill the funnel with 
ammonium chloride and use the syringe to pull the ammonium chloride into the tubing. Ensure 
there are no air bubbles in the tubing and transfer the prepared cadmium into the tubing using 
the funnel. Be careful not to expose the cadmium to air, do not allow air bubbles to be trapped 
in the column, and ensure that the cadmium is packed tightly with no dead space. Remove the 
funnel and close the tubing with glass wool and an N6 nipple. Remove the syringe and close the 
tubing with a N6 nipple. 

Attach the column to the manifold and condition the column with ~2000 µg/L NO3-N for five 
minutes, followed by ~2000 µg/L NO2-N for five minutes. 

14.8.21 NOx and NH3 calibration standard curves

The standard curve is created using the “Build Standards” option in the AACE software. See step 
8 in Section 14.12, Analysis for how the standard curve is created using the AACE software.

14.8.22 Reference sample

Reference samples are prepared in bulk according to Section 4, Reference sample preparation. 
Briefly, the reference sample consists of water from Lake 239 that has been aged for at least 
one year, diluted by a factor of 2, and spiked with 25 µg/L of NO2 and 250 µg/L of NH3. The 
reference sample is stored at 4 ± 2 °C.

14.9 Quality control
This method has a number of conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data is 
recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the non-
conformance is investigated and reported in the Non-Conformance log, and appropriate corrective 
action is taken before testing is resumed.

14.9.1 Cadmium column conversion efficiency

The conversion efficiency of the cadmium column is checked prior to conducting an analytical 
run by measuring the peak areas of 100 µg/L NO3-N (ANO3) and 100 µg/L NO2-N (ANO2) 
standards. The cadmium column efficiency, which is calculated using equation 14.5, must be 
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greater than 0.95. If the cadmium column conversion efficiency (XCd) is less than 0.95, the 
column needs to be either reconditioned or remade and conditioned. 

Equation 14.5.	
XCd =

  ANO3

14.9.2 Blanks

A reagent blank, consisting of Milli-Q water and the reaction reagents, is incorporated as a 
baseline, which is run every 5–10 samples.

14.9.3 Reference standards

A mixed reference standard is run twice every run, once before samples are run and once 
afterward. The NOx and NH3 concentrations must be within 5.0% of the calibration standard, 
representing the same concentration. 

14.9.4 Calibration curve

The linear correlation coefficients obtained from the calibration standards must have an 
R2 ≥ 0.995 with a first order fit. If necessary, new calibration standards should be prepared.

14.9.5 Reference sample

A reference sample is included at the beginning of every run. The NOx and NH3 values obtained 
must agree to within 5.0% of the expected value. Results for check sample performance are 
charted and assessed for drift and bias.

14.9.6 Duplicates

Random duplicates are run every 15 samples. Samples for duplicate analysis are chosen at the 
beginning of the analysis run (before the first analysis is done). Duplicates’ relative percent 
difference (RPD) must agree to within 5.0%. If duplication is inadequate, samples bracketed by 
the duplicates are re-tested.  

14.9.7 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibration and 
Verification. The calibrations of the Eppendorf™ pipettes are verified on a weekly basis or prior to 
making standards using methods outlined in Section 3, Labware Calibrations and Verifications. All 
glassware is cleaned according to Section 2, Labware Cleaning.

ANO2
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14.10 Quality assurance
Proficiency testing is conducted for the NOx and NH3 analyses via the Environment and Climate 
Change Canada Proficiency Testing (ECCC-PT) program.

14.11 Sample preparation
No additional sample preparation is required prior to analysis.  

14.12 Analysis 
1.	 Turn on power on the SEAL 

AutoAnalyzer 3 HR by turning on the 
power bar.

2.	 On the desktop of the PC, double-click 
the AACE 7.09 shortcut.

3.	 Click the Charting button displayed in 
the Sys. 1 [AA3 HR] system window 
(Figure 14.1.). Select the appropriate 
analysis (.anl) file. 

Note: When charting is started, the 
Base, Gain, and Light Power values 
that were used the last time this .anl 
file was run are downloaded to the 
colorimeters.

4.	 Replace Milli-Q water in the wash 
bottles, washpot bottle, and syringe 
diluter receptacle.

5.	 Pump system wash solutions (6 mL/L 
Brij-35 for NOx and 2 mL/L Brij-35 
for NH3) through the reagent lines for 
10–15 minutes to “wet” the tubes with 
surfactant. 

6.	 Pump Milli-Q water through the lines 
and allow the baseline to stabilize, 
checking the bubble pattern for the 
proper bubble shape. Set the base to 
5% (right-click in the channel charting 
window and click Set Base). 

Figure 14.1. The Sys. 1 [AA3 HR] system 
window

Figure 14.2. The Syringe Diluter control 
window
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7.	 Check reagents’ absorbance of each 
channel by setting the Gain (double 
click on channel icon in the system 
window) to 10 and setting the base to 
5%. Then pump reagents, open the 
cadmium column, and let the NH4Cl 
run through to prepare the column for 
the conversion of NO3 to NO2. Once 
the baseline on each channel stabilizes, 
record the reagent absorbance as the 
percent difference between baseline 
absorbance and reagent absorbance.

8.	 Standards are created by diluting the 
mixed calibration standard stock using 
the built-in syringe diluter. Ensure 
that there is fresh Milli-Q water in the 
syringe diluter receptacle and empty 
vials in slots 901 through 908 of the 
autosampler standard tray. Place a 14-
mL tube of mixed calibration standard 
in slot 910.  

Click on the Syringe Diluter icon in the 
system window, click the Reset button 
and then click the Prime button to 
prime the syringe diluter with fresh 
Milli-Q water.   

Select the Build Standards icon from 
the system window and select the 
190503A.run file in the “Nitrogen 
stds” directory. Ensure that the 
concentration field is set to 500 and 
that the calibrants are set as shown 
in the Build Standards image (Figure 
14.3). 

9.	 Verify the Gain on each channel by 
sampling the highest calibrant for 120–
180 seconds. Click the Sampler icon 
in the system window, type the cup 
position of the highest calibrant, and 
click Sample. After 120–180 seconds 
have elapsed, click Wash to move the 

Figure 14.3. The Build Standards set up 
window

Figure 14.4. The Set Up: Analysis – New 
Run window 
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sampler back to the wash receptacle. Once the plateau of the standard peak has been 
reached and stabilized set the Gain (right-click on the channel charting window and click 
Set Gain). Make sure enough standard remains for the run. If not, it may be necessary to 
make more standard.

10.	 Double-check the channel QC parameters, such as light power, reference energy, 
sensitivity, and smoothing, if necessary. 

11.	 Click Set Up and Analysis/Run on the top bar of the window and navigate to the NOxNH3 
directory, select the “NOxNH3.anl” file and click New Run. 

12.	 The Set Up: Analysis – New Run window will open wherein the analytical run is configured. 
The following settings are stipulated on the Main page tab.

	‒ Sample Time: 150

	‒ Wash Time: 75

	‒ Samples per Hour: 16

	‒ Sample to Wash: 2.0 

	‒ Channels

	‒ Channel 1: NO2

	‒ Channel 2: NO2 + NO3

	‒ Channel 3: NH3

	‒ Virtual 1: (NO3)

	‒ Data fields: 

	‒ (Weight)

	‒ Dilution 

	‒ Note: A field in parentheses 
indicates that the field is set 
as inactive. 

	‒ Auto Dilution (Post Dilution): 
Syringe

	‒ Pre-Dilution: Syringe

13.	 If any of the samples need to be pre-diluted, the run can be set up to automatically dilute 
samples. Click the Syringe button on the Main Page and click Configure to open the 
Pre-Dilution configuration window. Select the Sample-specific Dilution button, ensure that 
the “Syringe/Max Volume” is set to 10mL/9mL (i.e. the volume of the syringe diluter), 
enter 9.0 for the “Total Volume (mL),” and enter the autosampler tray location of the first 
empty cup and how many empty cups are placed on the autosampler tray. (Note: Make 
sure to put the empty cups in order and that they are different than the empty cup setup 
in the NOx and NH3 Autodilution.anl file). Next, click Virtual channels and open the data 

Figure 14.5. Pre-Dilution configuration 
window
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fields by clicking Change button. Activate the dilution data field by selecting Yes in the 
active column in the dilution row and click OK. Now, the dilution data can be stipulated 
in the tray protocol.

14.	 Click the “Tray Protocol” tab. The 
table should already be populated 
with the calibration standards and 
the recovery standards (Figure 14.6). 
Click the Samples button and stipulate 
the number of samples you would 
like to add to the table and the start 
cup. Stipulate which sample will be 
in each sample cup. The run should 
include a primer (highest calibrant), 
the calibration curve, at least two drift 
standards (highest calibrant), recovery 
standards, a reference standard, a 
reference sample, and at least one 
instrument duplicate for every 15–20 
samples. 

Put an X in the “PD” column of all 
samples that need to be diluted (Figure 
14.7) and stipulate the dilution factor 
in the “Dilution” column (only 
available if Pre-Dilution was set up).  

Click Print Tray to print the Tray 
Protocol and use it to fill each of the 
sample cups with the appropriate 
standard/sample.

15.	 Once the tray protocol is set up, any 
necessary Pre-Dilution settings are set, 
and the sample cups are filled and placed in the correct positions, click Run and select the 
created run from the directory to start the analytical run. 

Note: If the run was set up with Pre-Dilution, a [run name] PREDIL.run file is created 
and the samples are diluted prior to the run. The tray protocol of the original run file (i.e. 
yymmddX.run) is updated with the sample cup locations of the diluted samples.  

16.	 Once the run is complete, click Retrieve on the top bar of the window and select View chart 
to view the peaks of the appropriate run. Any modifications that need to be made to the 
marking of peaks should be done before printing out a report. Peak markers are moved by 
clicking the move marker icon and moving the marker as needed.

Figure 14.6. Example Tray Protocol window

Figure 14.7. Example of Pre-Dilution 
configuration in the Tray Protocol window
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17.	 Click Display Report on the top bar of the window to retrieve the results of the run of 
interest and save a copy of the run report at \\ela-lab.iisd.ca\shared\Chem Lab\Analysis 
Results\AA3\AA3 Runs\NOx and NH3 in the yymmddX_NOxNH3 (X = A, B, C, etc.) 
format.

18.	 Turn off the cadmium column and pump Milli-Q water through the reagent lines for 15– 
20 minutes, followed by pumping air through the lines until dry.

19.	 Shut down the system by turning off the power bar and removing the peristaltic pump 
plaque and the system lines from tension.

14.13 Clean up 
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, the vials are cleaned 
by rinsing three times with hot water and three times with DRO water. 

14.14 Calculations
The calculation of NO2-N and NH3-N in samples is performed by the AACE 7.09 software using 
equation 14.6:

Equation 14.6	
A = lg

  I0   
= C × ɛ × d  or  C =

  A

where C is the concentration of the sample, A is the sample absorbance, lg is the logarithm 
function base 10, l0 is the original measured light intensity, I is the reduced measured light 
intensity, ɛ is the molecular extinction coefficient, which is a constant, and d, which is the path 
length of the flow cell, which is also constant. The sample concentration is reported to the nearest 
integer.

The calculation of NO3-N in the samples is performed by the AACE 7.09 software using 
equation 14.7, which accounts for the use of a mixed calibrant:

Equation 14.7	
NO3 =

  TON × (A × Recovery + B)/(A+B) − NO2

where TON is the total oxidized nitrogen (i.e. NO2 + NO3), A is the NO3 concentration of the 
TON calibrant, B is the NO2 concentration of the TON calibrant, NO2 is the concentration of 
NO2 in channel 1 (i.e. NO2 concentration of the sample), and Recovery is the percentage of NO3 

that was converted to NO2.

ɛ × d(  )l

Recovery

https://www.iisd.org/ela/


IISD.org/ela 143

The Chemical Analysis of Fresh Water

If a dilution has been made, the concentration of the sample needs to be corrected for the dilution 
factor, which is calculated using equation 14.8:

Equation 14.8	
D =

  V1

where V1 is the volume of the diluted sample and V0 is the volume of the undiluted sample.

14.15 Data entry
The NOx and NH3 concentrations for each sample, which are calculated using the AACE 7.09 
software, as well as the QC data, are entered into the Sample Master® LIMS. 
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Appendix 14A. Mixed Calibration Standard Stock 
Preparation Record
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Appendix 14B. Mixed Reference Standard Stock Preparation 
Record
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Appendix 14C. Mixed Reference Standard Preparation 
Record

https://www.iisd.org/ela/


IISD.org/ela 147

The Chemical Analysis of Fresh Water

Appendix 14D. 50 µg/L NO2 and NO3 Standard Preparation 
Record

https://www.iisd.org/ela/


IISD.org/ela 148

The Chemical Analysis of Fresh Water

Appendix 14E. 2000 µg/L NO2 and NO3 Standard 
Preparation Record
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Appendix 14F. Colour Reagent Preparation Record
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Appendix 14G. Ammonium Chloride Preparation Record
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Appendix 14H. Complexing Reagent Preparation Record
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Appendix 14I. Hypochlorite Preparation Record
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Appendix 14J. Phenol Preparation Record
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Appendix 14K. 1 mL/L Brij-35 Preparation Record
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Appendix 14L. 2 mL/L Brij-35 Preparation Record
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Appendix 14M. 6 mL/L Brij-35 Preparation Record
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Appendix 14N. Copper Sulfate Preparation Record
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Appendix 14O. 6 N Hydrochloric Acid Preparation Record
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15.0 Total Dissolved Nitrogen: UV oxidation 
and colourimetry method

15.1 Introduction and scope
The following method is used in the IISD Experimental Lakes Area Analytical Service Laboratory 
for the determination of total dissolved nitrogen (TDN) in fresh water and precipitation.

15.2 Method principle
This automated procedure is based on the method designed for the analysis of ammonia 
using the SEAL Analytical AutoAnalyzer 3 HR Continuous Segmented Flow Analyzer (SEAL 
Analytical, 2016) that was modified for the analysis of TDN by the inclusion of a zinc column. 
Under ideal conditions, organic nitrogen compounds can be oxidized into inorganic constituents 
after a four-hour exposure to high-intensity short-wave UV radiation (Armstrong & Tibbitts, 
1968; Hensricksen, 1970; Stainton et al., 1977). The products of oxidation are nitrite, nitrate, 
and ammonia. These products can be measured after the photo oxidized sample is passed 
through a zinc column that has been conditioned with sulfuric acid, which reduces nitrite and 
nitrate to ammonia (Stainton et al., 1977). If only total inorganic nitrogen species are to be 
measured, simply skip the UV oxidation. Under appropriate conditions (i.e. pH 11.5–12.3), 
ammonia complexes with an ethylenediamine tetra-acetic acid (EDTA) and tri-sodium citrate 
dehydrate-based reagent. When the ammonia and complexing reagent react with the phenol and 
hypochlorite, an indophenol blue is formed (Harwood & Huyser, 1970). The colour intensity of 
the indophenol blue, which is proportional to the amount of ammonia in the sample, is measured 
on a colorimeter measuring absorbance at a wavelength of 660 nm. 

15.3 Occupational health and safety
The short-wave UV irradiator, used for UV oxidation of the samples, can cause serious and 
potentially permanent damage to the eyes. Do not look at or expose skin to the UV light and 
ensure that there is a sign posted in a conspicuous location warning others of this hazard.

Hydrogen peroxide (30% w/w), also used for UV oxidation of the samples, is a strong oxidant that 
can burn skin, eyes, or the respiratory tract if inhaled. Avoid contact with skin. Wear a face shield, 
lab coat, and gloves when handling.

The phenol reagent used for reagent preparation is corrosive, toxic, and a health hazard. Avoid 
contact with skin. Wear a face shield, lab coat, and gloves when handling.

The concentrated sulfuric acid (H2SO4), used for UV oxidation of the samples, is corrosive and 
reacts violently with water. Avoid contact with skin. Wear a face shield, lab coat, and gloves when 
handling. Always pour acid into water slowly while stirring. Never pour water into acid.
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15.4 Validation

15.4.1 Operating range

6.89–1,000 µg/L NH3

15.4.2 Detection limit and limit of quantitation

The detection limit, which is based on the residuals along the standard curve, is calculated for 
each run using equations 15.1 through 15.3:

Equation 15.1	
Cdl =

  yd-b

where b is the y-intercept, m is the slope, and yd is the instrument response detection limit, which 
is calculated using equation 15.2:

Equation 15.2	 yd = 3sy + b

where sy is based on the residuals between the measured instrument response for each standard 
concentration and the calibration curve-predicted response for each standard concentration. It is 
calculated using equation 15.3:

Equation 15.3	
sy =

   ∑di2

where n is the number of standards in the calibration curve, and di is the difference between 
the measured instrument response for each standard concentration and the calibration curve-
predicted response for each standard concentration.

The limit of quantitation is calculated in the same manner as the detection limit, except equation 
15.2 is replaced with equation 15.4:

Equation 15.4	 yq = 10sy + b

The averages of the detection limits and limits of quantitation for samples run between 2019 and 
2020 were as follows:

Detection limit 19 ± 10 µg/L NH3-N

Limit of quantitation 64 ± 34 µg/L NH3-N

m

n−2
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15.5 Sample conditions
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. The sample 
analyzed must be

	‒ filtered within 24 hours of sample collection,

	‒ stored and analyzed within seven days,

	‒ kept away from NH3 environments, and 

	‒ stored at 4 ± 2 °C.

15.6 Equipment
	‒ Short-wave UV irradiator

	‒ 550-watt medium-pressure mercury vapour lamp

	‒ cooling fan

	‒ quartz jacket tube to shield the mercury lamp from the cooling effect of the fan

	‒ a transformer to supply power at the correct voltage

	‒ an hour meter for monitoring lamp life

	‒ on-off automatic timer

	‒ support assembly

	‒ snorkel to vent free radicals and ozone

	‒ SEAL AutoAnalyzer 3 HR

	‒ digital colorimeters

	‒ high-precision pump outfitted with the pump tubes outlined in the System Map 
(SEAL Analytical, 2016) that have been modified to include:

	‒ a 4 way valve connected to the sample pump tube (red/red instead of yel/yel)

	‒ a 0.04N H2SO4 pump tube (blk/blk)

	‒ a zinc column (see section 15.8.15) so that the sample and H2SO4 is pumped 
through the zinc column prior to reaching the manifold

	‒ multitest manifold

	‒ auto sampler

	‒ computer running AACE 7.09 software

	‒ quartz sample tubes: 16 mm I.D. × 18 mm O.D. × 20 cm length, 35 mL capacity, 
calibrated and etched to 25 mL

	‒ carousel for quartz sample tubes
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	‒ 11-mL plastic sample tubes

	‒ 14.5-mL plastic tubes for standards

15.7 Purchased reagents

15.7.1 NH3 calibration standard stock

Commercial certified (traceable to NIST) NH3-N standard

	 1.0 mL = 0.1 ± 0.01 mg NH3-N 

The standard is stable until the expiry date on the manufacturer’s label.

15.7.2 NH3 reference standard stock

Commercial certified (traceable to NIST) NH3-N standard

	 1.0 mL = 1 ± 0.01 mg NH3-N

The standard is stable until the expiry date on the manufacturer’s label. It must be from a 
different manufacturer than the standard used for calibration standards.

15.7.3 Sulfuric acid, high purity

OPTIMA (Fisher Scientific), TraceMetal™ Grade (Fisher Chemical™), Ultrex (J.T. Baker), and 
Aristar (B.D.H.) brands have been found to have acceptable nitrogen levels. Store in an acid 
cabinet at room temperature within a sealed plastic bag. It is stable as per the manufacturer’s 
specifications or until contaminated with phosphorus or nitrogen.

15.7.4 Hydrogen peroxide

Reagent grade, 30% w/w. Caution: This is a dangerous oxidant. Avoid contact with skin. Wear 
gloves and wash hands and arms after handling. 

This reagent deteriorates if left open at room temperature. Store at 4 ± 2 °C. It is stable as per the 
manufacturer’s specifications or until contaminated with phosphorus or nitrogen.

15.7.5 Zinc – 40 mesh

Zinc is stable indefinitely at room temperature.

https://www.iisd.org/ela/


IISD.org/ela 163

The Chemical Analysis of Fresh Water

15.8 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.

	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

15.8.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

15.8.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q® Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

15.8.3 Sulfuric acid – 4 N

Dilute 106 mL of high-purity concentrated sulfuric acid into ~800 mL of Milli-Q water. Cool 
and make up to 1 L with Milli-Q water. It is stable indefinitely, or until contaminated, at room 
temperature.

15.8.4 Sulfuric acid – 1 N

Dilute 26.5 mL of high-purity concentrated sulfuric acid into 1 L of Milli-Q water. It is stable 
indefinitely, or until contaminated, at room temperature.

15.8.5 Sulfuric acid – 0.04 N

Dilute 1.06 mL of high-purity concentrated sulfuric acid into 1 L of Milli-Q water. It is stable 
indefinitely, or until contaminated, at room temperature.
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15.8.6 Complexing reagent

	‒ 15 g EDTA

	‒ 120 g tri-sodium citrate dihydrate

	‒ 0.5 g sodium nitroprusside

	‒ 3 mL Brij-35, 22−30% solution

Dissolve EDTA, tri-sodium citrate dihydrate, and sodium nitroprusside into 1 L with Milli-Q 
water and then add Brij-35, 22−30% solution. Store in an amber bottle. It is stable for two weeks.

Note: If the calcium or magnesium concentrations of samples are likely to exceed 0.005 
m/L and 0.04 mol/L, respectively, the EDTA should be increased to 30 g/L. 

15.8.7 Hypochlorite

Dilute commercial unscented bleach (preferably Chlorox) with 10 parts Milli-Q water to 1 part 
bleach. It is stable for 24 hours.

15.8.8 Phenol

	‒ 50 g phenol

	‒ 30 g sodium hydroxide

Dissolve phenol and sodium hydroxide into 1 L of Mill-Q water. Store in an amber bottle. It is 
stable until the solution turns brown.

Note: Final pH should be 11.5–11.9. If the final pH is too high, reduce the sodium 
hydroxide concentrations. If the pH is too low, increase the sodium hydroxide 
concentration.

15.8.9 NH3 calibration standard – 10 µg/mL

Dilute 10 mL of the 0.1 mg/mL NH3-N to 100 mL with Milli-Q water in a 100 mL volumetric 
flask. Make fresh weekly.

15.8.10 NH3 reference standard – 500 µg/L

Dilute 0.05 mL of the 1 mg/mL NH3-N to 100 mL with Milli-Q water in a 100 mL volumetric 
flask. Make fresh weekly.

15.8.11 NO3 standard – 500 µg/L

Dilute 50 µL of the 1000 µg/L NO3 standard stock to 100 mL in a 100 mL volumetric flask. 
Make fresh weekly.
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15.8.12 Urea check standard stock – 1000 µg/mL (as N)

Dissolve 2.1429 g of Ultrex (J.T. Baker) Urea (CH4N2O) into 1 L of Milli-Q water. Store at 4 ± 
2 °C. It is stable for six months.

15.8.13 Urea check standard – 500 µg/L (as N)

Dilute 0.5 mL of the urea check standard stock to 1 L with Milli-Q water. It is stable for six 
months.

15.8.14 TDN calibration standard curve

The standard curve is created using the “Build Standards” option in the AACE software. See step 
8 in Section 15.12 Analysis for how the standard curve is created using the AACE software.

15.8.15 Zinc column

Close one end of a 30-cm piece of 0.110" I.D. Tygon tubing with glass wool. Connect the other 
end of the tubing to a small funnel using a small piece of 1/8" I.D. tubing. Elevate the funnel 
using a ring stand and attach a 50-mL syringe to the end with wool. Fill the funnel with Milli-Q 
water and use the syringe to pull the Milli-Q water into the tubing ensuring there are no air 
bubbles in the tubing. Place zinc mesh in a small beaker with Mill-Q water and use a rod to stir 
the zinc mesh and dislodge air bubbles that attach to the zinc particles. Transfer the wetted zinc 
into the tubing using the funnel. Do not allow air bubbles to be trapped in the column and ensure 
that the zinc is packed with no dead space. Remove the funnel and close the tubing with glass 
wool and an N6 nipple. Syringe 15 mL of 1 N H2SO4 through the column, followed by 15 mL of 
Milli-Q water. Remove the syringe and close the tubing with a N6 nipple. 

Attach the column to the manifold and condition the column with 0.04 N H2SO4 for 15–20 
minutes. 

15.8.16 Reference sample

Reference samples are prepared according to Section 4, Reference Sample Preparation. The 
reference sample consists of water from Lake 239 that has been aged for at least one year and 
filtered. The reference sample is stored at 4 ± 2 °C.

15.9 Quality control
This method has a number of conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data 
is recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the 
non-conformance is investigated, reported in the Non-Conformance log and appropriate corrective 
action is taken before testing is resumed.
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15.9.1 Zinc column conversion efficiency

The conversion efficiency of the zinc column is checked prior to conducting an analytical run by 
measuring the peak areas of 500 µg/L NO3-N (ANO3) and 100 µg/L NH3-N (ANH3) standards. 
The zinc column efficiency, which is calculated using equation 15.5, must be greater than 0.95. 
If the zinc column conversion efficiency (XZn) is less than 0.95, the column needs to either be 
reconditioned or remade and conditioned. 

Equation 15.5	
XZn =

  ANO3

 

15.9.2 Blanks

A reagent blank, consisting of Milli-Q water and the reaction reagents, is incorporated as a 
baseline, which is run every 5–10 samples.

15.9.3 Calibration curve

The linear correlation coefficients obtained from the calibration standards must have an 
R2 ≥ 0.995 with a first order fit. If necessary, new calibration standards should be prepared.

15.9.4 Urea standard

A urea standard is included on every rack of UV oxidation samples to ensure that UV lamp 
energy is sufficient to oxidize organic nitrogen. The carbon nitrogen bonds found in urea are 
particularly resistant to UV decomposition, making it a good indicator of lamp performance. If 
the urea standard is not within 5.0% of the expected value (i.e. 475-525 µg/L), the UV oxidation 
is non-compliant.

15.9.5 Reference sample

A reference sample is included at the beginning of every run. The TDN value obtained must 
agree to within 5.0% of the expected value. Results for check sample performance are charted 
and assessed for drift and bias.

15.9.6 Duplicates

Random instrument duplicates are run every 15 samples. Samples for duplicate analysis are 
chosen at the beginning of the analysis run (before the first analysis is done). Duplicates’ relative 
percent difference (RPD) must agree to within 5.0%. If duplication is inadequate, samples 
bracketed by the duplicates are re-tested. One method duplicate is included on each rack of UV 
oxidation samples and is included in the analytical run.

ANH3
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15.9.7 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibration and 
Verification. The calibrations of the Eppendorf™ pipettes are verified on a weekly basis or prior to 
making standards using methods outlined in Section 3, Labware Calibrations and Verifications. All 
glassware is cleaned according to Section 2, Labware Cleaning.

15.10 Quality assurance
Quality assurance for TDN is maintained through annual participation in the Environment and 
Climate Change Canada Proficiency Testing Program (ECCC-PT). Non-compliance is defined 
by ECCC-PT and is reported directly to the Research Chemist. Samples analyzed during the 
period of non-compliance are flagged in the database.

15.11 Sample preparation

15.11.1 UV oxidation

Note: Wear gloves when handling the quartz 
tubes, quartz surface of the lamp, or quartz 
jacket. Salt deposits (NaHCO3 in particular) 
will permanently etch quartz surfaces, 
reducing their transparency, and hence their 
photo-digestion efficiency. Quartz surfaces 
should be inspected at least every six months 
for cleanliness and wiped with soft tissue, 
moistened first with Milli-Q water, followed by 
ethanol. 

1.	 Fill out the UV Oxidation BenchSheet, 
which includes the  rack number, 
the UV oxidation instrument used, 
sample order on the numbered rack, 
date and time of UV oxidation, any 
sample dilutions and the initials of the 
analyst. These worksheets are stored 
in a 3-ring binder located next to the 
UV oxidation  instruments. See Figure 
15.1. for an example of how standards/
samples are typically loaded onto the 
UV oxidation rack.

Figure 15.1. Example UV Oxidation 
BenchSheet, which outlines the typical 
sequence of urea, blanks, reference 
sample, samples, and method duplicate
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2.	 Add 25 mL of each QC sample/standard and filtered samples to quartz tubes and place 
them into the UV oxidation rack in the order as written on the UV Oxidation BenchSheet. 

3.	 Use a repeater Eppendorf™ pipette to add 100 µL of 4N H2SO4 (high purity) and 100 µl 
of 30% H2O2 to each 25 mL tube (including urea standard, method blank and reference 
sample). There are two labelled, 50-µL, repeater pipette tips. One is for H2O2, and the 
other is for H2SO4. These repeater tips should be rinsed out with DRO water after each 
use and rinsed with reagent before being used to dispense.

4.	 Stopper the tubes with plastic caps and place the rack into the UV oxidization instrument 
and irradiate for four hours. Turn on the snorkel to vent out free radicals and ozone.

5.	 Once UV oxidation is complete, allow the samples to cool and check for evaporation. If 
evaporation has occurred, top up to the 25 mL line with Milli-Q water.

Caution: Do not look at or expose skin to the UV light and ensure that there is a sign posted in a 
conspicuous location warning others of this hazard.

15.12 Analysis 
1.	 Turn on power on the SEAL 

AutoAnalyzer 3 HR by turning on the 
power bar.

2.	 On the PC, double-click the AACE 
7.09 shortcut.

3.	 Click the Charting button displayed in 
the Sys. 1 [AA3 HR] system window 
(Figure 15.2.). Select the appropriate 
analysis (.anl) file. 

Note: When charting is started, the 
Base, Gain, and Light Power values 
that were used the last time this .anl 
file was run are downloaded to the 
colorimeters.

4.	 Replace Milli-Q water in the wash 
bottles, washpot bottle, and syringe 
diluter receptacle.

5.	 Pump system wash solution (2 mL/L 
Brij-35) through all of the reagent lines, except for 0.04 N H2SO4, for 10–15 minutes to 
“wet” the tubes with surfactant. The surfactant ensures proper flow and bubble pattern. 

	‒ Bubbles must completely fill the tubing. Their length should be approximately 1.5 
times the inner diameter of the tubing. 

Figure 15.2. The Sys. 1 [AA3 HR] system 
window
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	‒ Bubbles must be the same size, 
shape, and distance apart. 

	‒ Bubble shape in all plastic tubing 
must be round at the front and 
back. If the bubble looks straight 
or square at the back, there is 
insufficient wetting agent. 

6.	 Pump Milli-Q water through the lines 
and allow the baseline to stabilize, 
checking the bubble pattern for proper 
bubble shape. Set the base to 5% 
(right-click on the channel charting 
window and click Set Base). 

7.	 Check the reagent absorbance of each 
channel by setting the Gain (double 
click on the Channel icon in the system 
window) to 10 and setting the base to 
5%. Then pump reagents until a stable 
baseline is reached. Once the baseline is 
reached, open the zinc column and let 
the H2SO4 run through to prepare the 
column for the conversion of NOx to 
NH3. Record the reagent absorbance.

8.	 Standards are created by diluting the 
10 µg/mL NH3 stock standard using 
the built-in syringe diluter. Ensure 
that there is fresh Milli-Q water in 
the syringe diluter receptacle, empty 
vials in slots 901 through 908 of 
the autosamplers standard tray, and 
ensure that a 14 mL tube of 10 µg/mL 
NH3 stock standard is placed in slot 
910. Click on the Syringe Diluter icon 
in the system window, click the Reset 
button and then the Prime button 
to prime the syringe diluter with the 
fresh Milli-Q water.  
Select the Build Standards icon from 
the system window and select the 
“TDN standards.run” file in the 

Figure 15.3. The Syringe Diluter control 
window

Figure 15.4. The Build Standards set up 
window
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“TDN stds” directory. Ensure that the concentration field is set to 10 000 and that the 
calibrants are set as shown in the Build Standards image (Figure 15.4). 

9.	 Verify the Gain on each channel by sampling the highest calibrant for 120 to 180 seconds. 
Click the Sampler icon, type the cup position of the highest calibrant (901, 902, or 903), 
and click Sample. After 120 to 180 seconds have elapsed, click Wash to move the sampler 
back to the wash receptacle. Once the plateau of the standard peak has been reached and 
stabilized, set the Gain (right click in the channel charting window and click Set Gain). 
Make sure enough standard remains for the run. If not, it may be necessary to make more 
standard.

10.	 Double-check the channel QC parameters such as light power, reference energy, 
sample:reference, and smoothing if necessary. 

11.	 The efficiency of the Zn column to convert NOx to NH3 is checked prior to conducting 
the run. To check the Zn efficiency: 

a.	 Create a new run. Click Set Up > Analysis/Run, navigate to the Zn conversion 
directory, highlight the .anl file at the top and click New Run. The Set Up: Analysis – 
New Run window will open, wherein the analytical run is already configured for the 
Zn conversion test. Click OK.

b.	 Place a 500-µg/L NO3 standard into slot 60 of the autosampler tray and ensure that 
there is sufficient 500 µg/L NH3 in slot 905 (created in the standard build).

c.	 Click Run and select the newly created Zn conversion file.

d.	 Once the run is complete, retrieve the run Chart by clicking Retrieve > View Chart. 
Any modifications that need to be made to the marking of peaks should be done 
before printing out a report. Peak markers are moved by clicking the move marker 
icon and moving the marker as 
needed. Click Display Report on 
the top bar of the window to 
retrieve the results of the run.

e.	 Change the units to Raw Data 
and calculate the Zn efficiency by 
dividing the 500 NO3 raw data 
by the 500 NH3 Raw Data. 

f.	 If the efficiency is > 0.95 
(equation 15.5), proceed with 
the analytical run. If not, the Zn 
column either needs additional 
conditioning or a new Zn 
column needs to be made and 
conditioned.

Figure 15.5. The Setup Up: Analysis – New 
Run window 
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12.	 To set up the analytical run, click Set Up and Analysis/Run on the top bar of the window, 
navigate to the TDN directory, select the “TDN.anl” file and click New Run.

13.	 The Set Up: Analysis – New Run window (Figure 15.5) will open, wherein the analytical 
run is configured. The following settings are stipulated on the Main tab.

	‒ Sample Time: 126

	‒ Wash Time: 75

	‒ Samples per Hour: 18

	‒ Sample to Wash: 1.7

	‒ Channels

	‒ Channel 3: TDN

	‒ Virtual Channels: none

	‒ Data fields: 

	‒ (Weight)

	‒ Dilution 

	‒ Note: A field in parentheses indicates that the field is set as inactive. 

	‒ Auto Dilution (Post Dilution): Syringe

	‒ Pre-Dilution: Syringe

14.	 If any of the samples need to be pre-
diluted, the run can be set up to 
automatically dilute these samples by 
clicking the Syringe button on the Main 
Page.

15.	 Select Configure to open the Pre-
Dilution configuration window. Select 
the Sample-specific Dilution button, 
ensure that the “Syringe/Max Volume” 
is set to 10mL/9mL (i.e. the volume of 
the syringe diluter), enter 9.0 for the 
“Total Volume (mL),” and enter the 
autosampler tray location of the first 
empty cup and how many empty cups 
are placed on the autosampler tray 
(Figure 15.6).

Note: Make sure to put the empty 
cups in order and that they are 
different than the empty cup setup in 

Figure 15.6. Pre-Dilution configuration 
window 
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the TDN Auto-Dilutions.anl. Next, click Virtual channels and open the data fields by 
clicking the Change button. Activate the dilution data field by selecting Yes in the active 
column in the dilution row and clicking OK. Now, the dilution data can be stipulated in 
the tray protocol. 

16.	 Click the “Tray Protocol” tab. The 
table should already be populated with 
the calibration standards and the 
recovery standards (Recovery std NO2 
is actually NH3). Click the Samples 
button and stipulate the number of 
samples you would like to add to the 
table and the start cup. Stipulate which 
sample will be in each sample cup. The 
run should include a primer (highest 
calibrant), the calibration curve, at 
least two drift standards (highest 
calibrant), recovery standards, a 
reference standard, a reference sample, 
and at least one instrument duplicate 
for every 15–20 samples (Figure 15.7). 

17.	 Put an X in the “PD” column of all 
samples that need to be diluted and 
stipulate the dilution factor in the 
“Dilution” column (Figure 15.8, only 
available if Pre-Dilution was set up).  

18.	 Click Print Tray to print the Tray 
Protocol and use it to fill each of the 
sample cups with the appropriate 
standard/sample.

19.	 Once the tray protocol is set up, any 
necessary Pre-Dilution settings are set 
and sample cups are filled and placed in the correct positions, click Run and select the 
created run from the directory to start the analytical run. 

Note: If the run was set up with Pre-Dilution, a [run name] PREDIL.run file is created 
and the samples are diluted prior to the run. The tray protocol of the original run file (i.e. 
yymmddX.run) is updated with the sample cup locations of the diluted samples.  

20.	 Once the run is complete, click Retrieve on the top bar of the window and select View chart 
to view the peaks of the appropriate run. Any modifications that need to be made to the 
marking of peaks should be done before printing out a report. Peak markers are moved by 
clicking the move marker icon and moving the marker as needed.

Figure 15.7. Example Tray Protocol window 

Figure 15.8. Example of Pre-Dilution 
configuration in the Tray Protocol window 
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21.	 Click Display Report on the top bar of the window to retrieve the results of the run of 
interest and save a copy of the run report at \\ela-lab.iisd.ca\shared\Chem Lab\Analysis 
Results\AA3\AA3 Runs\TDN in the yymmddX_TDN (X = A, B, C etc.) format.

22.	 Turn off the zinc column and pump Milli-Q water through the reagent lines for 15–20 
minutes, followed by pumping air through the lines until dry.

23.	 Shut down the system by turning off the power bar and removing the peristaltic pump 
plaque and the system lines from tension.

15.13 Clean up
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, the vials are cleaned 
by rinsing three times with hot water and three times with DRO water. 

15.14 Calculations
The calculation of NH3-N in samples is performed by the AACE 7.09 software using the 
following equation:

Equation 15.6	
A = lg

  I0   
= C × ɛ × d  or  C =

  A

where C is the concentration of the sample, A is the sample absorbance, lg is the logarithm 
function base 10, l0 is the original measured light intensity, I is the reduced measured light 
intensity, ɛ is the molecular extinction coefficient, which is a constant, and d is the path length of 
the flow cell, which is also constant. The sample concentration is reported to the nearest integer.

If a dilution has been made, the concentration of the sample needs to be corrected for the dilution 
factor (equation 15.7):

Equation 15.7	
D =

  V1

where V1 is the volume of the diluted sample and V0 is the volume of the undiluted sample.

15.15 Data entry
The TDN concentrations for each sample, which are calculated using the AACE 7.09 software, as 
well as the QC data, are entered into the Sample Master LIMS. 

ɛ × d(  )l

V0
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Appendix 15A. 4 N Sulfuric Acid Preparation Record
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Appendix 15B. 1 N Sulfuric Acid Preparation Record
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Appendix 15C. 0.04 N Sulfuric Acid Preparation Record
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Appendix 15D. Complexing Reagent Preparation Record
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Appendix 15E. Hypochlorite Preparation Record
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Appendix 15F. Phenol Preparation Record
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Appendix 15G. 10 µg/mL NH3 Calibration Standard Stock 
Preparation Record

https://www.iisd.org/ela/


IISD.org/ela 182

The Chemical Analysis of Fresh Water

Appendix 15H. 500 µg/L NH3 Reference Standard 
Preparation Record
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Appendix 15I. 500 µg/L NO3 Standard Preparation Record
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Appendix 15J. 1000 µg/mL-N Urea Standard Stock 
Preparation Record
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Appendix 15K. 500 µg/L-N Urea Standard Preparation 
Record
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16.0 Total Dissolved Phosphorus

16.1 Introduction and scope
The following method is used in the IISD Experimental Lakes Area Analytical Service Laboratory 
for the determination of total dissolved phosphorous (TDP), as PO4-3-P, in fresh water and 
precipitation.

16.2 Method principle
Organic phosphorus compounds under acidic conditions and, with adequate oxygen supply, 
can be photo-oxidized to orthophosphate (PO4-3) with short-wave UV radiation (Armstrong & 
Tibbits, 1968; Henriksen et al., 1970; Stainton et al.; 1977). Breakdown is quick (one to four 
hours). This method does not, however, appear to hydrolyze polyphosphate. If significant amounts 
of polyphosphates are suspected to be present, the UV oxidized sample should be boiled with 
HCl prior to the orthophosphate analysis (Strickland & Parsons, 1972). 

The resulting orthophosphate is measured by the soluble reactive phosphorus method (Stainton 
et al., 1977). The UV oxidation procedure is identical to that for total dissolved nitrogen.

Phosphate, silicate, arsenate, and germanate ions react under acidic conditions with molybdate 
to form heteropoly acids that can be converted by suitable reducing agents to blue compounds of 
uncertain composition (Nagul et al., 2015; Stainton et al., 1977).

16.3 Occupational health and safety
The short-wave UV irradiator, used for UV oxidation of the samples, can cause serious and 
potentially permanent damage to the eyes. Do not look at or expose skin to the UV light and 
ensure that there is a sign posted in a conspicuous location warning others of this hazard.

Hydrogen peroxide (30% w/w), also used for UV oxidation of the samples, is a strong oxidant that 
can burn skin, eyes, or the respiratory tract if inhaled. Avoid contact with skin. Wear a face shield, 
lab coat, and gloves when handling.

The phenol reagent used for reagent preparation is corrosive, toxic, and a health hazard. Avoid 
contact with skin. Wear a face-shield, lab coat, and gloves when handling.

The concentrated sulfuric acid (H2SO4), used for UV oxidation of the samples, is corrosive and 
reacts violently with water. Avoid contact with skin. Wear a face shield, lab coat, and gloves when 
handling. Always pour acid into water slowly while stirring. Never pour water into acid.
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16.4 Validation
This method is suitable for determining the TDP in water.

16.4.1 Operating range

3 – 50 µg/L PO4-3-P

16.4.2 Detection limit and limit of quantitation

The detection limit, which is based on the residuals along the standard curve, is calculated for 
each run using equations 16.1 through 16.3:

Equation 16.1	
Cdl =

  yd-b

where b is the y-intercept, m is the slope, and yd is the instrument response detection limit, which 
is calculated using equation 16.2:

Equation 15.2	 yd = 3sy + b

where sy is based on the residuals between the measured instrument response for each standard 
concentration and the calibration curve-predicted response for each standard concentration. It is 
calculated using equation 16.3:

Equation 16.3	
sy =

   ∑di2

where n is the number of standards in the calibration curve, and di is the difference between 
the measured instrument response for each standard concentration and the calibration curve-
predicted response for each standard concentration.

The limit of quantitation is calculated in the same manner as the detection limit, except equation 
16.2 is replaced with equation 16.4:

Equation 16.4	 yq = 10sy + b

The averages of the detection limits and limits of quantitation for samples run between 2019 and 
2021 were as follows:

Detection limit 3.0 ± 1.5 µg/L

Limit of quantitation 10.0 ± 5.0 µg/L

m

n−2
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16.5 Sample condition
Refer to Section 6, Sample Preparation and Filtration for details on sample preparations. The 
sample must be

	‒ stored at 4 ± 2 °C,

	‒ UV oxidized within seven days of sample collection,

	‒ analyzed within seven days of UV oxidation, and

	‒ analyzed at room temperatures < 28 °C.

16.6 Equipment
	‒ short-wave UV irradiator

a.	 550-watt medium-pressure mercury vapour lamp

b.	 cooling fan

c.	 quartz jacket tube to shield the mercury lamp from the cooling effect of the fan

d.	 transformer to supply power at the correct voltage

e.	 hour meter for lamp life monitoring

f.	 on-off automatic timer

g.	 support assembly

h.	 snorkel to vent out free radicals

	‒ quartz sample tubes: 16 mm I.D. × 18 mm O.D. × 20 cm length, 35 mL capacity, 
calibrated and etched to 25 mL

	‒ carousel for quartz sample tubes

	‒ Shimadzu UV-1800 scanning spectrophotometer set at 885 nm

	‒ UV Probe software

	‒ 10-cm pathlength cuvettes

	‒ 50-mL graduated polyethylene conical tubes and rack to hold them

	‒ Eppendorf™ repeater pipette and pipette tip with 5-mL dispensing capacity

16.7 Purchased reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.
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	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

16.7.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

16.7.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

16.7.3 Sulfuric acid, high purity

OPTIMA (Fisher Scientific), TraceMetal™ Grade (Fisher Chemical™), Ultrex (J.T. Baker), and 
Aristar (B.D.H.) brands have been found to have acceptable nitrogen levels. Store in an acid 
cabinet at room temperature within a sealed plastic bag. It is stable as per the manufacturer’s 
specifications or until contaminated with phosphorus or nitrogen.

16.7.4 Sulfuric acid, ACS grade

Store in an acid cabinet at room temperature. It is stable as per the manufacturer’s specifications 
or until contaminated with phosphorus or nitrogen.

16.7.5 Hydrogen peroxide

Reagent grade, 30% w/w. Caution: This is a dangerous oxidant. Avoid contact with skin. Wear 
gloves and wash hands and arms after handling.

This reagent deteriorates if left open at room temperature. Store at 4 ± 2 °C. It is stable as per the 
manufacturer’s specifications or until contaminated with phosphorus or nitrogen.

16.7.6 Calibration standard stock

Commercial certified (traceable to NISCT) PO4-3-P standard:

1.0 mL = 50 ± 1 µg PO4-3-P                                     
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Store at 2–6 ºC until the expiry date on the manufacturer’s label.

16.8 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.

	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

16.8.1 4 N sulfuric acid

Caution: ALWAYS pour acid into water slowly while stirring. NEVER pour water into acid.

Slowly pour 26.5 mL of high-purity concentrated sulfuric acid into ~200 mL Milli-Q water. Cool 
and dilute to 250 mL with Milli-Q water. Store at room temperature. Stable until contaminated 
with phosphorus or nitrogen.

16.8.2 Ammonium molybdate

Caution: ALWAYS pour acid into water slowly while stirring. NEVER pour water into acid.

Dissolve into ~1500 mL of ultrapure water. Add in the order given.

	‒ 15 g of ammonium molybdate ((NH4)6Mo7O24 4H2O) 

	‒ 0.28 g of antimony potassium tartrate (KSbOC4H4O6)

	‒ 176 mL concentrated sulfuric acid, ACS grade

Cool and dilute to 2 L with Milli-Q water. Store at room temperature in a brown polyethylene 
bottle. It is stable for one year.

16.8.3 Ascorbic acid

Dissolve 1.25 g of L-ascorbic acid into 50 mL of Milli-Q water. Prepare fresh.

16.8.4 Mixed molybdate

Mix 50 mL ascorbic acid for every 200 mL ammonium molybdate. Prepare fresh.
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16.8.5 Reference standard stock – 50 µg/mL PO4

Dissolve 0.2197 g potassium dihydrogen phosphate (KH2PO4) in 100 mL of Milli-Q water. 

1.0 mL = 50 μg PO4-3-P

Store at room temperature in a labelled glass bottle. It is stable for one year.

16.8.6 Working calibration standard stock – 25 µg/mL PO4

Dilute 1250 µL of the 50 µg/mL calibration standard stock to 25 mL with Milli-Q water.

1.0 mL = 2.5 μg PO4-3-P 

Prepare weekly.

16.8.7 Calibration curve  

Dilute volumes of the 2.5 µg/mL working calibration standard stock according to Table 16.1 with 
Milli-Q water to make each of the following calibration standard concentrations. Prepare weekly.

Table 16.1. Total dissolved phosphorus calibration standards

Std conc. (µg/L) Working stock vol. (µL) Final vol. (mL)

0 0 100

2.5 100 100

5 200 100

10 400 100

25 1000 100

50 2000 100

16.8.8 Reference standard – 25 µg/L PO4

Dilute 125 µL of the 50 µg/mL reference standard stock to 250 mL with Milli-Q water. Prepare 
weekly.

16.8.9 Reference sample 

Reference samples are prepared in bulk according to Section 4, Reference Sample Preparation. The 
TDP reference sample consists of water from Lake 239 that has been aged for at least one year, 
filtered, and spiked with 25 µg/L PO4-3-P. The reference sample is stored at 4 ± 2 °C.
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16.9 Quality control
This method has a number of conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data is 
recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the non-
conformance is investigated and reported in the Non-Conformance log, and appropriate corrective 
action is taken before testing is resumed. If reanalysis is not possible, the samples are flagged in 
the database as non-compliant.

16.9.1 Calibration curve

The linear correlation coefficients obtained from the calibration standards must have an 
R2 ≥ 0.995 with a first order fit. If necessary, new calibration standards should be prepared.

16.9.2 Blanks

An instrument blank, consisting solely of ultrapure water, and a reagent blank, consisting of 
ultrapure water and reaction reagents, are included at the beginning of a run. A method blank, 
consisting of ultrapure water, reaction reagents, and photo-digestion reagents, is run for each 
photo-digestion rack of samples. The absorbance of the blanks should be no higher than 0.003.

16.9.3 Urea standard

A urea standard is included on every photo-digestion rack of samples to ensure that UV lamp 
energy is sufficient to break down organic nitrogen. The carbon carbon-nitrogen bonds found 
in urea are particularly resistant to UV decomposition, making it a good indicator of lamp 
performance. See Method ELA-TDN for details of this urea standard. If the urea standard is not 
within 5.0% of the expected value (i.e. 475–525 µg/L), the photo-digestion is non-compliant.

16.9.4 Reference standard

A reference standard is run at the beginning and end of an analytical run and every 16 samples 
within. The absorbance of the 25-µg/L reference standard should be within 5.0% of the 25-µg/L 
calibration standard.

16.9.5 Reference sample

A reference sample is included on every photo-digestion rack of samples. The TDP value obtained 
must be within 5.0% of the expected value. Results for reference sample performance are charted 
and assessed for drift and bias.
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16.9.6 Duplicates

A random method duplicate is included on every photo-digestion rack of samples (16 samples or 
less). Instrument duplicates are run every 16 samples. Duplicates must agree to within 5.0% of 
each other. If duplication is inadequate, samples bracketed by the duplicates are reanalyzed.

16.9.7 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibration and 
Verification. The calibrations of the Eppendorf™ pipettes are verified on a weekly basis or prior to 
making standards using methods outlined in Section 3, Labware Calibrations and Verifications. All 
glassware is cleaned according to Section 2, Labware Cleaning.

16.10 Quality assurance
Quality assurance for TDP is maintained through annual participation in the Environment and 
Climate Change Canada Proficiency Testing Program (ECCC-PT). Non-compliance is defined 
by ECCC-PT and is reported directly to the Research Chemist. Samples analyzed during the 
period of non-compliance are flagged in the database.

16.11 Sample preparation

16.11.1 UV oxidation

Note: Wear gloves when handling the quartz tubes, quartz surface of the lamp, or quartz 
jacket. Salt deposits (NaHCO3 in particular) will permanently etch quartz surfaces, 
reducing their transparency and hence their photo-digestion efficiency. Quartz surfaces 
should be inspected at least every six months for cleanliness and wiped with soft tissue, 
moistened first with ultrapure water, followed by ethanol.

Note: If significant amounts of polyphosphates are suspected to be present, the UV 
oxidized sample should be boiled with HCl prior to the orthophosphate analysis 
(Strickland & Parsons, 1968).

This UV oxidation procedure is identical to that used to measure total dissolved nitrogen 
(TDN). The UV oxidation efficiency of TDP samples is evaluated by analyzing the urea 
standard on each rack for TDN using the Section 15, Total Dissolved Nitrogen – UV Oxidation 
and Colourimetry Method.  

1.	 Fill out the UV Oxidation BenchSheet, which includes the rack number, the UV oxidation 
instrument used, sample order on the numbered rack, date and time of UV oxidation, any 
sample dilutions, and the analyst’s initials. These worksheets are stored in a 3-ring binder 
located next to the UV oxidation instruments. See Figure 16.1 for an example of how 
standards/samples are typically loaded onto the UV oxidation rack.
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2.	 Add 25 mL of each QC sample/
standard and filtered samples to 
quartz tubes and place them in the UV 
oxidation rack in the order as written 
on the UV Oxidation BenchSheet. If 
TDP is expected to exceed 50 µg/L, the 
sample should be diluted with Milli-Q 
water at this stage (i.e. prior to UV 
oxidation).

3.	 Use a repeater Eppendorf™ pipette to 
add 100 µL of 4N H2SO4 (high purity) 
and 100 µl of 30% H2O2 to each 25-
mL tube (including urea standard, 
method blank, and reference sample). 
There are two labelled 50-µL, repeater 
pipette tips. One is for H2O2, and the 
other is for H2SO4. These repeater 
tips should be rinsed out with distilled 
water after each use and rinsed with 
reagent before being used to dispense.

4.	 Stopper the tubes with plastic caps, 
place the rack into the UV oxidization 
instrument, and irradiate for four 
hours. Turn on the snorkel to vent out 
free radicals and ozone.

5.	 Once UV oxidation is complete, allow 
the samples to cool and check for 
evaporation. If evaporation has occurred, top up to the 25-mL line with Milli-Q water.

16.11.2 Colorimetric reaction

1.	 Add 25 mL of each of the following into 50-mL conical tubes:

	‒ reagent blank, consisting of Milli-Q water

	‒ calibration standards (i.e. 0, 2.5, 5, 10, 25, and 50 µg/L PO4-3-P)

	‒ 25-µg/L reference standards (prepare enough to run at the beginning and end of an 
analytical run and every 16 samples within).

2.	 Add 5 mL of mixed molybdate to each calibration standard, reference standard, reagent 
blank, method blank, reference sample, sample, and duplicate. Do not add mixed 
molybdate to the urea sample. This is to be analyzed for TDN.

Figure 16.1. Example UV Oxidation 
BenchSheet, which outlines the typical 
sequence of urea, blanks, reference 
sample, samples, and method duplicate
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3.	 Wait 30 minutes for the colorimetric reaction, but no more than three hours prior to 
analysis on the spectrophotometer.

16.12 Analysis 
1.	 Turn on the power on the Shimadzu UV-1800 scanning spectrophotometer and let it 

warm up for at least two hours.

2.	 On the PC desktop, double-click the UV Probe shortcut.

3.	 Click OK.

4.	 Ensure that the Photometric icon is selected (Figure 16.2).

Figure 16.2. The Photometric icon

5.	 Open the UV Probe software from the desktop and open the TDP method (\\ela-lab.iisd.
ca\shared\Chem Lab\Analysis Results\TDP\TDP template.pmd). 

6.	 Click the Connect button at the bottom. If not available, click View > Photometric buttons. 
The UV detector will now go through its startup sequence. 

7.	 After the startup sequence has finished, if the instrument has passed, click OK.

8.	 Rinse two 10-cm pathlength cuvettes at least three times with Milli-Q water and fill them 
with Milli-Q water.

9.	 Wipe the cuvettes with lint-free tissue and place them in the appropriate holders in the 
spectrophotometer (the cuvette farthest away from you is the reference position). Ensure 
that the wavelength is set to 885 nm and click Auto Zero to set the photometric value 
at 885 nm of ultrapure water to an absorbance of 0. Leave the cuvette in the reference 
position for the duration of the analytical run.

10.	 Remove the front cuvette, rinse at least three times with Milli-Q water then rinse and fill 
with the first standard (0 µg/L PO4-3-P). Enter the Sample ID and standard concentration 
(e.g. 0 std and 0.0) and click Read Std.

11.	 Repeat step 10 for the remaining standards.

12.	 Once the calibration curve is complete, remove the front cuvette and rinse at least three 
times with ultrapure water, then rinse and fill with Milli-Q water. Enter the Sample ID 
(e.g. instrument blank) and click Read Unk.

Photometric

https://www.iisd.org/ela/


IISD.org/ela 196

The Chemical Analysis of Fresh Water

13.	 Repeat step 12 for the remaining blanks, QC standard/samples, and samples. Run a 
random duplicate, a reference standard, and a reagent blank every 16 samples. See Table 
16.2 for a typical run sequence of standards/samples.

Table 16.2. A typical sequence of blanks, standards, reference standards, reference 
samples, and samples for one UV oxidation rack. A reference standard, duplicate sample, 
and reagent blank are analyzed at least every 16 samples.

14.	 Once the analytical run is complete, copy and paste the raw data into the TDP 
Calculation Template located at \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\TDP\
TDP Calculation Template.xls and save the file as yyyymmdd_TDP.xls in the \\ela-lab.iisd.
ca\shared\Chem Lab\Analysis Results\TDP\yyyy TDP directory

15.	 Save the photometric file as yyyymmdd_TDP.pho under \\ela-lab.iisd.ca\shared\Chem 
Lab\Analysis Results\TDP\yyyy TDP.

16.	 Click Disconnect and close the UV Probe software.

Scan # Sample description

1 0 µg/L calibration standard

2 2.5 µg/L calibration standard

3 5.0 µg/L calibration standard

4 10 µg/L calibration standard

5 25 µg/L calibration standard

6 50 µg/L calibration standard

7 25 µg/L reference standard

8 instrument blank (Milli-Q water)

9 reagent blank (Milli-Q water + 
mixed molybdate)

10 method blank (UV Milli-Q water)

11 reference sample

12 sample 1

13 sample 2

14 sample 3

15 sample 4

Scan # Sample description

16 sample 5

17 sample 6

18 sample 7

19 sample 8

20 sample 9

21 sample 10

22 sample 11

23 sample 12

24 sample 13

25 sample 14

26 sample 15

27 sample 16

28 method duplicate

29 instrument duplicate

30 25 µg/L reference standard
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16.13 Clean up
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, while wearing gloves, 
clean the quartz tubes, cuvettes, conical tubes, and repeater pipet tips by rinsing three times with 
hot water and three times with DRO water.  

16.14 Calculations
The calculation of TDP in samples is performed by using the “TDP Calculation Template.xls” 
worksheet located at \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\TDP\TDP Calculation 
Template.xls.

Concentrations of TDP are calculated using equation 16.5:

Equation 16.5	
C =

  Asamp − Ablk − b

where C is the concentration of the sample, Asamp is the sample absorbance, Ablk is the reagent 
blank absorbance, m is the slope, and b is the intercept of the calibration curve after correcting for 
the reagent blank absorbance. The sample concentration is reported to three decimals.

If a dilution has been made, the concentration of the sample needs to be corrected for the 
concentration of TDP in the dilution water using equation 16.6:

Equation 16.6	 C = (C0  × D) − ((Cdil × (D − 1)) 

where C0 is the concentration of TDP in the diluted sample, Cdil is the concentration of TDP in 
the dilution water, and D is the dilution factor, which is calculated using equation 16.7:

Equation 16.7	
D =

  V1

 

where V1 is the final volume of the diluted sample, and V0 is the volume of the undiluted sample.

This spreadsheet template should be saved to a new file name to record the data. The file name 
should be in the format of yyyymmdd_TDP.xls (e.g. 20190207_TDP.xls) and saved in the 
directory \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\TDP\yyyy TDP.

To calculate the TDP concentrations in the samples, fill in each of the yellow fields with the 
Sample ID, dilution factor, and absorbance of each of the blanks, calibration standards, reference 
standards, reference samples, and samples.  

Information on the date, analyst’s initials, standard lot numbers, expiry date and stock 
concentrations, number of calibration standards (n), reference standard preparation date, and 
reference sample check batch number are also recorded in this spreadsheet in the yellow fields.  

m

V0
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16.15 Data entry
The TDP concentrations of each sample, which are calculated using the “TDP Calculation 
Template,” as well as the QC data, are entered into the Sample Master® LIMS. The completed 
“TDP Calculation Template.xls” is printed and filed in the TDP folder. 

16.16 References
Armstrong, F. A. J., & Tibbitts, S. (1968). Photochemical combustion of organic matter in sea 

water for nitrogen, phosphorus and carbon determination. Journal of the Marine Biological 
Association of the United Kingdom, 48, 143–152. https://doi.org/10.1017/S0025315400032483

Henriksen, A. (1970). Determination of total nitrogen, phosphorus and iron in freshwater by 
photo-oxidation with ultraviolet radiation. Analyst, 95, 601–605. (U of M Science Library Sci/
Per/543/A532/Ch/v95.) https://doi.org/10.1039/AN9709500601

Nagul, E.A., McKelvie, I.D., Worsfold, P., Kolev, S.D. (2015). The molybdenum blue reaction for 
the determination of orthophosphate revisited: Opening the black box. Analytica Chimica Acta, 
890, 60–82. https://doi.org/10.1016/j.aca.2015.07.030 

Stainton, M. P., Capel, M. J. &. Armstrong, F. A. J. (1977). The chemical analysis of fresh water. 
(2nd ed). (Miscellaneous Special Publication 25). Fisheries Marine Service. https://waves-
vagues.dfo-mpo.gc.ca/library-bibliotheque/110147.pdf

Strickland, J. D. H., & Parsons, T. R. (1972). A practical handbook of seawater analysis. (Bulletin no. 
167). Fisheries Research Board of Canada.

https://www.iisd.org/ela/
https://doi.org/10.1017/S0025315400032483
https://doi.org/10.1039/AN9709500601
https://doi.org/10.1016/j.aca.2015.07.030
https://waves-vagues.dfo-mpo.gc.ca/library-bibliotheque/110147.pdf
https://waves-vagues.dfo-mpo.gc.ca/library-bibliotheque/110147.pdf


IISD.org/ela 199

The Chemical Analysis of Fresh Water

Appendix 16A. 4 N Sulfuric Acid Preparation Record
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Appendix 16B. Ammonium Molybdate Preparation Record
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Appendix 16C. Ascorbic Acid Preparation Record
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Appendix 16D. Mixed Molybdate Preparation Record
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Appendix 16E. 50 µg/mL Reference Standard Stock 
Preparation Record
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Appendix 16F. Calibration and Reference Standards 
Preparation Record
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17.0 Particulate Phosphorus

17.1 Introduction and scope
This method is used in the IISD Experimental Lakes Area Analytical Service Laboratory for 
the determination of particulate phosphorous in fresh water and atmospheric precipitation. 
Particulate is operationally defined as that which is retained by a GF/C filter, which has a nominal 
pore size of 1.2 µm.

17.2 Method principle
Particulate matter that has been collected on a glass fibre filter is combusted to destroy 
organic matter and convert particulate phosphorus into phosphorus oxides by oxidation. 
After combustion, the phosphorus oxides are extracted from the filter and hydrolyzed to 
orthophosphate by heating with dilute hydrochloric acid. The resulting orthophosphate is 
measured using the molybdenum blue method (Nagul et al., 2015; Stainton et al., 1977).

Phosphate, silicate, arsenate, and germanate ions react under acidic conditions with molybdate 
to form heteropoly acids that can be converted by suitable reducing agents to blue compounds 
of uncertain composition, which are then measured spectrophotometrically (Nagul et al., 2015; 
Stainton et al., 1977). 

17.3 Occupational health and safety
The muffle furnace is set to 500 °C, which presents a risk for burns when handling the furnace 
and items baked in the furnace. To reduce the risk of burns, vials and trays should be placed into 
the muffle furnace prior to turning it on. Allow the vials and trays to cool down and use protective 
gloves and/or tongs when removing them. Do not leave the muffle furnace door open to cool. Post 
a HOT warning to caution other lab staff about the risk of burns from the muffle furnace or items 
baked in the muffle furnace.

The concentrated hydrochloric acid (HCl) and sulfuric acid (H2SO4) used for reagent 
preparation are corrosive. Handle in a fume hood to avoid HCl vapours. Avoid contact with skin. 
Wear goggles and gloves when handling and diluting. Always pour acid into water slowly while 
stirring. Never pour water into acid.

17.4 Validation
This method is fit to measure particulate phosphorus in water.
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17.4.1 Operating range

0.05–20 μg PO4-3-P per filter disc

The operating range is in terms of the mass of the sample collected per filter and depends on the 
volume of sample available for filtration or able to be passed through the filter.

17.4.2 Detection limits and limits of quantitation

The detection limit is calculated for each run using equations 17.1 through 17.3:

Equation 17.1	
Cdl =

  yd-b

where b is the y-intercept, m is the slope, and yd is the instrument response detection limit, which 
is calculated using equation 17.2:

Equation 17.2	 yd = 3sy + b

where sy is based on the residuals between the measured instrument response for each standard 
concentration and the calibration curve-predicted response for each standard concentration. It is 
calculated using equation 17.3:

Equation 17.3	
sy =

   ∑di2

where n is the number of standards in the calibration curve, and di is the difference between 
the measured instrument response for each standard concentration and the calibration curve-
predicted response for each standard concentration.

The limit of quantitation is calculated in the same manner as the detection limit, except equation 
17.2 is replaced with equation 17.4:

Equation 17.4	 yq = 10sy + b

The  averages of  the detection limits and limits of quantitation for samples ran between 2017 and 
2019 were:

Detection limit 1.4 µg/L PO4-3-P

Limit of quantitation 4.7 µg/L PO4-3-P

m

n−2
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17.5 Sample condition
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. The sample 
analyzed must

	‒ consist of particulates collected (filtered) onto a pre-baked Whatman 4.25 cm GF/C glass 
fibre filter disc,

	‒ be filtered within 24 hours of sample collection,

	‒ be stored damp in an acid-washed glass vial with a polytetrafluoroethylene (PTFE)-lined 
screw-cap, and

	‒ stored for up to one year at room temperature.

17.6 Equipment
	‒ Cole-Parmer 2100 spectrophotometer

	‒ muffle furnace set at 500 °C

	‒ oven with timer set at 100 °C

	‒ glass screw-cap vials; 16 mL capacity, 70 mm × 21 mm (OD), PTFE-lined screw caps, 
and caps with septa inserts

	‒ numbered metal racks, with rows and columns numbered for identification purposes, to 
hold the vials and capable of withstanding 500 °C

	‒ filtration apparatus to hold 42.5 mm filter discs

	‒ pre-baked Whatman 42.5 mm GF/C glass fibre filter discs (see Section 6, Sample 
Preparation and Filtration for GF/C procurement and preparation)

	‒ bottle-top dispenser set to deliver 12 mL

	‒ 1-cm pathlength glass cuvettes

	‒ Particulate phosphorus BenchSheet

17.7 Purchased reagents

17.7.1 PO4-3 Calibration Standard Stock

Commercial certified (traceable to NIST) PO4-3-P standard

1.0 mL = 50 ± 1 µg PO4-3-P

Store at 2–6 °C until the expiry date on the manufacturer’s label.
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17.8 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.

	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

17.8.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

17.8.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

17.8.3 Hydrochloric acid – 0.16 N

Caution: ALWAYS pour acid into slowly while stirring. NEVER pour water into acid.

Slowly pour 26 mL of concentrated HCl into ~1500 mL of Milli-Q water and make it to 2 L with 
Milli-Q water. Store in a bottle-top dispenser at room temperature for one year.

17.8.4 Ammonium molybdate

Dissolve into ~1500 mL of ultrapure water. Add in the order given.

	‒ 15 g of ammonium molybdate ((NH4)6Mo7O24 4H2O) 

	‒ 0.28 g of antimony potassium tartrate (KSbOC4H4O6)

	‒ 176 mL conc. sulfuric acid

Cool and dilute to 2 L. Store at room temperature in a brown polyethylene bottle. Stable for one 
year.
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17.8.5 Ascorbic acid

Dissolve 1.25 g of L-ascorbic acid into 50 mL of Milli-Q water. Prepare fresh.

17.8.6 Mixed molybdate

Mix 50 mL ascorbic acid for every 200 mL ammonium molybdate. Prepare fresh.

17.8.7 Reference standard stock – 50 µg/mL PO4

Dissolve 0.2197 g potassium dihydrogen phosphate (KH2PO4) in 100 mL of Milli-Q water. 

1.0 mL = 50 μg PO4-3-P

Store at room temperature in a labelled glass bottle. Stable for one year.

17.8.8 Calibration curve  

Dilute the volumes listed in Table 17.1 of 
the 50 µg/mL calibration standard stock with 
0.16 N HCl in 100 mL volumetric flasks 
to make each of the calibration standard 
concentrations. Prepare weekly.

17.8.9 Reference standard – 250 µg/L 
PO4

Dilute 500 µL of the reference standard stock 
into 100 mL with 0.16 N HCl. Prepare weekly.

17.8.10 Reference sample

Reference samples are prepared in bulk 
according to Section 4, Reference Sample 
Preparation. Briefly, the reference sample 
consists of a GF/C filter that has been used to 
filter 50 mL of Lake 227 water collected during the summer bloom. The reference samples are 
vacuum desiccated and stored in the dark at ≤ -20 °C.

17.9 Quality control 
This method has several conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data 

Table 17.1. Dilution volumes of calibration 
standards

Std conc 
(µg/L)

Calibration 
stock vol 

(µL)
Final vol 

(mL)

0 0 100

25 50 100

50 100 100

125 250 100

250 500 100

375 750 100

500 1000 100

1000 2000 100
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recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the non-
conformance is investigated and reported in the Non-Conformance log, and appropriate corrective 
action is taken before the analysis is resumed. If reanalysis is not possible, the test is cancelled for 
each affected sample and the non-compliant issue is recorded in Sample Master (See Section 5, 
Laboratory Information Management System – Sample Master for how to cancel tests).

17.9.1 Calibration curve

The linear correlation coefficients obtained from the calibration standards must have an 
R2 ≥ 0.995 with a first order fit. If necessary, new calibration standards should be prepared.

17.9.2 Blanks

In each run, an instrument blank consisting solely of 0.16 N HCl, a reagent blank consisting of 
0.16 N HCl and reaction reagents, and two method blanks consisting of an unused, ignited GF/C 
filter disc, 0.16N HCl, and reaction reagents are run. The absorbance of the blanks should be no 
higher than 0.003.

17.9.3 Internal standard

A vial containing 12 mL of 50 µg/mL PO4-3-P calibration standard stock is used as an internal 
standard to correct for evaporation should any vial cap seal failures occur.

17.9.4 Reference standard

A reference standard is run at the beginning and end of an analytical run and every 16 samples 
within. The absorbance of the 375 µg/L reference standard should be within 5.0% of the 375 µg/L 
calibration standard.

17.9.5 Reference sample

A reference sample is included on every rack of samples. The value obtained must be within 5.0% 
of the expected value. Results for reference sample performance are charted and assessed for drift 
and bias.

17.9.6 Duplicates

A random method duplicate is included on every rack of samples. A field duplicate, wherein a 
sample is collected in duplicate, is included in every run. Instrument duplicates are run every 16 
samples. Duplicates must agree to within 5.0% of each other for duplicates with a concentration 
of > 20 µg/L; if the average concentration is ≤ 20 µg/L, the difference must be ≤ 1 µg/L. If 
duplication is inadequate, samples bracketed by the duplicates are reanalyzed.
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17.9.7 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibration and 
Verification. The calibrations of the Eppendorf™ pipettes are verified on a weekly basis or prior to 
making standards using methods outlined in Section 3, Labware Calibrations and Verifications. All 
glassware is cleaned according to Section 2, Labware Cleaning.

17.10 Quality assurance
Quality assurance for particulate phosphorus is maintained through inter-laboratory calibrations 
using plant tissue (forest material). The certified reference material, Orchard Leaves (CRM 1571) 
from the National Bureau of Standards, has been used as the organic phosphorous standard to 
check the sample procedure periodically.

17.11 Sample preparation

17.11.1 Filter ignition

1.	 Organize samples in an aluminum 
ignition tray. The ignition tray must 
have labelled rows and columns etched 
into the metal. Multiple trays must 
be numbered. Place two empty vials, 
five vials with an unused ignited GF/C 
filter in each (two method blanks, three 
internal standards), two empty spare 
vials, and a vial with reference sample 
into the first two rows.

2.	 Add vials with sample filters to the 
remaining rows. Record Sample 
IDs and filtration volumes on the 
Particulate Phosphorus BenchSheet.

3.	 Remove the caps from the vials and 
store the caps so that they maintain the 
same order as the vials in the rack. 

4.	 When ready, place the tray in the 
muffle furnace and heat to 500 °C and record the time in the test log. Take care not to 
scrape the sides of the furnace.

5.	 After 1.25 hours (1 h 15 m), turn off the muffle furnace and remove the tray using 
crucible tongs and protective gloves. Avoid touching any vials with the tongs because they 

Figure 17.1. Arrangement of blank, 
standards, and sample vials in labelled 
aluminum tray

Samples

Internal standard

Spare vials

Check sample

Reagent blank

Method blank
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may crack upon cooling. Again, avoid scraping the sides of the muffle furnace. Record 
time in the test log.

6.	 Set the tray aside to cool. Post a sign near the tray to alert others that the tray is hot.

17.11.2 Digestion and extraction

1.	 When the vials have cooled, add 12 mL of 0.16 N HCl to each vial using the calibrated 
bottle-top dispenser.

2.	 For the internal standard vials,

a.	 remove 100 µl of 0.16 N HCl from the vials,

b.	 add 100 µl of 50 µg/mL PO4-3-P calibration standard stock.

3.	 With forceps, place a PTFE-coated septum into each cap, with the white (PTFE) side of 
the septum to the inside of the vial, and put the cap with septum onto the vial. Be sure the 
cap is not cross-threaded on the vials and make it finger-tight.  

Caution. Avoid over-tightening the caps to prevent crushing the vials.

4.	 Digest in an oven at 100 ± 4 °C for 2.2 hours (2 h 10 m). Record start and finish time.

Caution. Do not extract longer than specified to prevent HCl from boiling off and 
possibly extracting Si from the filter into the liquid phase.

5.	 With crucible tongs or, if desired, temperature-resistant (Zetex) gloves, remove the tray 
from the oven and set aside to cool for at least 15 minutes.

Note: Put up a HOT warning to other laboratory staff.

17.11.3 Colorimetric reaction

1.	 Using a 5 mL pipette, transfer blanks, standards, and samples into 15 mL Falcon™ tubes 
and place them in a numbered rack. Record the location of each blank, standard, and 
sample on the Particulate Phosphorus BenchSheet.

2.	 Add 1 mL of mixed molybdate to each blank, standard, and sample tube and vortex each 
tube.

3.	 Wait 30 minutes for the colorimetric reaction, but no more than three hours, prior to 
analysis on the spectrophotometer.

17.12 Analysis
1.	 Turn on the Cole-Parmer spectrophotometer to warm up. Click the Mode button to enter 

“Abso rbance” mode. Set wavelength to 885 nm.

2.	 Rinse and fill cuvettes with Milli-Q water and place them into the spectrophotometer. 
Click Zero/100% Transmission to zero the instrument. The absorbance should read -0.000. 
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Pull the knob toward you to read the absorbance in the sample cuvette. This should also 
show an absorbance of -0.000.

3.	 Leave the rear cuvette with Milli-Q water in the rear slot to serve as the reference 
absorbance. Analyze the blanks, standards, and samples according to Table 17.2. Rinse 
the sample cuvette three times with Milli-Q water and a small amount of sample in 
between absorbance readings. Record the absorbance value in the Particulate Phosphorus 
BenchSheet.

Table 17.2. Analysis sequence order

17.13 Clean up
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, the cuvettes, conical 
tubes, and repeater pipet tips are cleaned by rinsing three times with hot water and three times 
with DRO. The sample vials are rinsed three times with hot water, soaked in 10% HCl for at least 
four hours, and rinsed three times with DRO.

Scan # Sample description

1 instrument blank

2 instrument blank

3 reagent blank

4 reagent blank

5 method blank

6 method blank

7 internal standard

8 internal standard

9 internal standard

10 0 µg/L calibration standard

11 25 µg/L calibration standard

12 50 µg/L calibration standard

13 125 µg/L calibration standard

Scan # Sample description

14 250 µg/L calibration standard

15 375 µg/L calibration standard

16 500 µg/L calibration standard

17 1000 µg/L calibration standard

18 250 µg/L reference standard

19 reference sample

20–35 samples 1 - 15

36 duplicate

37 250 µg/L reference standard

38–53 samples 16 – 30 

54 duplicate

55 250 µg/L reference standard

... etc.
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17.14 Calculations
The calculation of particulate phosphorus in samples is performed by using the “PartP 
Calculation Template.xls” worksheet. 

Concentrations of particulate phosphorus are calculated using equation 17.5:

Equation 17.5	
C =

  Asamp − Ablk − b

where C is the concentration of the sample, Asamp is the sample absorbance, Ablk is the reagent 
blank absorbance, m is the slope, and b is the intercept of the calibration curve after correcting for 
the reagent blank absorbance. The sample concentration is reported to one decimal.

If a dilution has been made, the concentration of the sample needs to be corrected for the 
concentration of phosphorus in the dilution solution (0.16 N HCl) using equation 17.6:

Equation 17.6	 C = (C0  × D) − ((Cdil × (D − 1)) 

where C0 is the concentration of phosphorus in the diluted sample, Cdil is the concentration 
of phosphorus in the dilution solution, and D is the dilution factor, which is calculated using 
equation 17.7:

Equation 17.7	
D =

  V1

 

where V1 is the final volume of the diluted sample and V0 is the volume of the undiluted sample.

This worksheet template should be saved to a new file name to record the data. The file name 
should be in the format of “yyyymmdd_PartP.xls” (e.g. 20200821_PartP.xls) and saved in the 
directory \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\PartP\yyyy_PartP.

To calculate the particulate phosphorus concentrations in the samples, fill in each of the yellow 
fields with the Sample ID, dilution factor, filtration volume, and absorbance of each of the blanks, 
calibration standards, reference standard, reference sample, and samples.  

Information on the date, analyst initials, standard lot numbers, expiry date, stock concentrations, 
number of calibration standards (n), reference standard preparation date, and reference sample 
check batch number are also recorded in this spreadsheet in the yellow fields.  

17.15 Data entry
The particulate phosphorus concentrations of each sample, which are calculated using the “PartP 
Calculation Template.xls,” as well as the QC data, are entered into the Sample Master LIMS. The 
completed “PartP Calculation Template.xls” is printed and filed into the PartP folder. 

m

V0
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Appendix 17A. Hydrochloric Acid Preparation Record
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Appendix 17B. Ammonium Molybdate Preparation Record
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Appendix 17C. Ascorbic Acid Preparation Record
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Appendix 17D. Mixed Molybdate Preparation Record
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Appendix 17E. 50 µg/mL Reference Standard Stock 
Preparation Record
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Appendix 17F. Calibration and Reference Standard 
Preparation Record
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Appendix 17G. Particulate Phosphorus BenchSheet

https://www.iisd.org/ela/


IISD.org/ela 223

The Chemical Analysis of Fresh Water

18.0 Soluble Reactive Silicon: 
Spectrophotometric method

18.1 Introduction and scope
The following method is used in the IISD Experimental Lakes Area Analytical Service Laboratory 
for the determination of soluble reactive silicon in fresh water and precipitation.

18.2 Method principle
Orthosilicate and possibly the dimer (Si2O7-2) react with molybdate in acid solution to form 
heteropoly molybdates, which can be reduced to silicomolybdenum blues (Armstrong, 1951; 
Stainton et al., 1977; Strickland, 1952). The absorption spectrum, intensity and stability of the 
colour depend greatly on the acidity and other experimental conditions (Strickland, 1952). In 
this method, stannous chloride is used as a reductant. Phosphate interference is prevented by the 
addition of tartrate which complexes excess molybdate, preventing its reduction. The absorption 
maximum is in the near infra-red (800–820 mm). This colourimetric procedure is conducted 
using a spectrophotometer set to a wavelength of 820 nm.

18.3 Occupational health and safety
The concentrated hydrochloric acid (HCl) used for reagent preparation is corrosive and volatile. 
Handle in a fume hood to avoid HCl vapours. Avoid contact with skin. Wear goggles and gloves 
when handling and diluting. Always pour acid into water slowly while stirring. Never pour water 
into acid.

18.4 Validation

18.4.1 Operating range

0.003–2.50 mg/L Si

18.4.2 Detection limit and limits of quantitation

The detection limit, which is based on the residuals along the standard curve, is calculated for 
each run using equations 18.1 through 18.3:

Equation 18.1	
Cdl =

  yd-b
m
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where b is the y-intercept, m is the slope, and yd is the instrument response detection limit, which 
is calculated using equation 18.2:

Equation 18.2	 yd = 3sy + b

where sy is based on the residuals between the measured instrument response for each standard 
concentration and the calibration curve-predicted response for each standard concentration. It is 
calculated using equation 18.3:

Equation 18.3	
sy =

   ∑di2

where n is the number of standards in the calibration curve, and di is the difference between 
the measured instrument response for each standard concentration and the calibration curve-
predicted response for each standard concentration.

The limit of quantitation is calculated in the same manner as the detection limit, except equation 
18.2 is replaced with equation 18.4:

Equation 18.4	 yq = 10sy + b

The  averages of  the detection limits and limits of quantitation for samples ran between 2017 and 
2019 were:

Detection limit 0.05 ± 0.01 mg/L

Limit of quantitation 0.18 ± 0.04 mg/L

18.5 Sample conditions
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. The sample 
analyzed must be

	‒ stored in a polyethylene container (do not store in glass),

	‒ unfiltered,

	‒ stored at room temperature, and

	‒ stored for less than six months.

18.6 Equipment
	‒ Shimadzu UV-1800 scanning spectrophotometer set to 820 nm

	‒ a computer running UV probe software

n−2
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	‒ 1 cm plastic cuvettes

	‒ 15 mL polyethylene conical tubes and racks to hold them

	‒ 5 mL transfer pipette and tips

	‒ repeater pipette and three Eppendorf™ Combitips to dispense 0.3 mL, 0.2 mL, and 0.1 
mL of each of the three reagents

	‒ vortex mixer

18.7 Purchased reagents

18.7.1 Calibration standard stock

Commercial certified (traceable to NIST) SiO2-Si standard

1.0 mL = 1 ± 0.01 mg Si

The standard is stable until the expiry date on the manufacturer’s label.

18.7.2 Reference standard stock

Commercial certified (traceable to NIST) SiO2-Si standard

1.0 mL = 1 ± 0.01 mg Si

The standard is stable until the expiry date on the manufacturer’s label. It must be from a 
different manufacturer than the silicone standard used for calibration standards.

18.8 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.

	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.
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18.8.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

18.8.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

18.8.3 Ammonium molybdate

Dissolve 5 g of ammonium paramolybdate into 100 mL of Milli-Q water. Stable for one month.

18.8.4 Hydrochloric acid  – 1 N

Dilute 8.3 mL of concentrated HCl into 100 mL of Milli-Q water. Stable indefinitely.

18.8.5 Mixed molybdate

Add 15 mL of 1N HCl to every 10 mL of molybdate stock as required. Prepare fresh.

18.8.6 Tartaric acid – 10% w/v

Dissolve 10 g of tartaric acid into 100 mL of Milli-Q water. Stable for one month.

Table 18.1. Dilution volumes of calibration standards

Std # Cal std conc (µg/L) Final vol (mL) Conc Si (mg/L)

1 2500 1000 2.50

2 2000 1000 2.00

3 1500 1000 1.50

4 1000 1000 1.00

5 500 1000 0.50

6 250 1000 0.25

7 100 1000 0.10

8 10 mL Std #2 1000 0.02
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18.8.7 Ascorbic acid

Dissolve 1.1 g ascorbic acid to 10 mL of ultrapure water. Stable for two weeks

18.8.8 Si calibration standard curve

Eight Si standards are prepared according to Table 18.1 in 1-L quantities from the 1 mg/mL 
calibration standard stock. Stable for six months.

18.8.9 Reference standard – 1.00 mg/L Si

Dilute 1.0 mL of the 1.0 mg/mL Si reference standard stock into 1 L of Milli-Q water in a 1-L 
plastic volumetric flask. Stable for six months

18.8.10 Reference sample

Reference samples are prepared in bulk according to Section 4, Reference Sample Preparation. The 
reference sample consists of water from Lake 239 that has been aged for at least one year and is 
diluted by a factor of 2. The reference sample is stored at room temperature.

18.9 Quality control 
This method has a number of conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data is 
recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the non-
conformance is investigated, it is reported in the Non-Conformance log, and appropriate corrective 
action is taken before testing is resumed.

18.9.1 Blanks

An instrument blank, consistently solely of Milli-Q water, is included at the beginning of a run. A 
reagent blank, consisting of ultrapure water and reaction reagents, is run every 15 samples.

18.9.2 Reference standard

A reference standard is run every 15 samples. These must be within 5.0% of the calibration 
standard of the same concentration. 

18.9.3 Calibration curve

The linear correlation coefficients obtained from the calibration standards must have an 
R2 ≥ 0.995 with a first order fit. If necessary, new calibration standards should be prepared.
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18.9.4 Reference sample

A reference sample is included at the beginning of every run. The Si value must be within 5.0% 
of the expected value. Results for check sample performance are charted and assessed for drift 
and bias.

18.9.5 Duplicates

Random duplicates are run every 15 samples. Samples for duplicate analysis are chosen at the 
beginning of the analysis run and must agree to within 5.0% of each other for concentrations 
above 0.1 mg/L. For concentrations ≤ 0.1 mg/L, accept differences of 0.005 mg/L. If duplication 
is inadequate, samples bracketed by the duplicates are reanalyzed. 

18.9.6 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibration and 
Verification. The calibrations of the Eppendorf™ pipettes are verified on a weekly basis or prior to 
making standards using methods outlined in Section 3, Labware Calibrations and Verifications. All 
glassware is cleaned according to Section 2, Labware Cleaning.

18.10 Quality assurance
Quality assurance for SRSi is maintained through annual participation in the Environment and 
Climate Change Canada Proficiency Testing Program (ECCC-PT). Non-compliance is defined 
by ECCC-PT and is reported directly to the Research Chemist. Samples analyzed during the 
period of non-compliance are flagged in the database.

18.11 Sample preparation
1.	 Add 5 mL of each of the following into a 15 mL conical tube using a 5 mL transfer 

pipette:

	‒ blanks of Milli-Q water (every 15 samples),

	‒ calibration standards (i.e. 0.00, 0.02, 0.1, 0.25, 0.5, 1.0, 1.5, 2.0, and 2.5 mg/L),

	‒ reference standard (every 15 samples),

	‒ reference (check) samples,

	‒ samples, and

	‒ duplicates (every 15 samples).
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Table 18.2. Typical sequence of blanks, standards, reference standards, reference  
samples, and samples. Reference standards, duplicate samples, and reagent blanks are 
analyzed at least every 15 samples.

2.	 Add 0.3 mL of mixed molybdate to each of the conical tubes; mix with a vortex and wait 
15 minutes.

3.	 Add 0.2 mL of tartaric acid to each of the conical tubes; mix with a vortex and wait two 
minutes.

4.	 Add 0.1 mL of ascorbic acid to each of the conical tubes; mix with a vortex and wait five 
minutes.

Scan # Sample description

1 0.00 mg/L calibration standard

2 0.02 mg/L calibration standard

3 0.10 mg/L calibration standard

4 0.25 mg/L calibration standard

5 0.50 mg/L calibration standard

6 1.00 mg/L calibration standard

7 1.50 mg/L calibration standard

8 2.00 mg/L calibration standard

9 2.50 mg/L calibration standard

10 instrument blank

11 reagent blank

12 1.00 mg/L reference standard 

13 reference sample

14 sample 1

15 sample 2

16 sample 3

Scan # Sample description

17 sample 4

18 sample 5

19 sample 6

20 sample 7

21 sample 8

22 sample 9

23 sample 10

24 sample 11

25 sample 12

26 sample 13

27 sample 14

28 random duplicate from samples 
1-14

29 1.00 mg/L reference standard

30 reagent blank 2

31 Sample 15

… etc.
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18.12 Analysis
1.	 Turn on the power on the Shimadzu UV-2401 PC spectrophotometer and let it warm up 

for at least two hours.

2.	 On the PC desktop, double-click the UV Probe shortcut.

3.	 Click OK.

4.	 Ensure that the Photometric icon is selected (Figure 18.1).

Figure 18.1. The Photometric icon

5.	 Open the UV Probe software from the desktop and open the SRSi method (\\ela-lab.iisd.
ca\shared\Chem Lab\Analysis Results\SRSi\SRSi template.pho). 

6.	 Click the Connect button at the bottom. If not available, click View > Photometric buttons. 
The UV detector will now go through its startup sequence.  

7.	 After the startup sequence has finished, if the instrument has passed, click OK.

8.	 Rinse two 1-cm plastic cuvettes at least three times with Milli-Q water and fill them with 
Milli-Q water. Wipe the cuvettes with lint-free tissue and place them in the appropriate 
holders in the spectrophotometer (the cuvette farthest away from you is the reference 
position). Ensure that the wavelength is set to 820 nm and click Auto Zero to set the 
photometric value at 820 nm of Milli-Q water to an absorbance of 0. Leave the cuvette in 
the reference position for the duration of the analytical run.

9.	 Remove the front cuvette, rinse at least three times with Milli-Q water, and then rinse 
and fill it with the first standard (0.00 mg/L Si). Enter the Sample ID and standard 
concentration (e.g. 0.00 mg/L and 0.0) and click Read Std.

10.	 Repeat step 9 for remaining standards.

11.	 Once the calibration curve is complete, remove the front cuvette and rinse it at least three 
times with Milli-Q water, then rinse and fill it with Milli-Q water. Enter the Sample ID 
(e.g. instrument blank) and click Read Unk.

12.	 Repeat step 11,  replacing the Milli-Q with each of the remaining blanks, QC standard/
samples and samples. Run a random duplicate, a reference standard, and a reagent blank 
every 15 samples.

13.	 Once the analytical run is complete, copy and paste the raw data into the “SRSi 
Calculation Template.xls” located at \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\

Photometric
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SRSi\SRSi Calculation Template.xls and save the file as “yyyymmdd_SRSi.xls” under \\
ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\SRSi\yyyy SRSi.

14.	 Save the photometric file as “yyyymmdd_SRSi.pho” under \\ela-lab.iisd.ca\shared\Chem 
Lab\Analysis Results\SRSi\yyyy SRSi.

15.	 Click Disconnect and close the UV Probe software.

18.13 Clean up
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, the cuvettes, conical 
tubes, and repeater pipet tips are cleaned by rinsing three times with hot water and three times 
with DRO water.

18.14 Calculations
The calculation of Si in samples is performed by using the “SRSi Calculation Template.xls” 
worksheet located at \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\SRSi\SRSi Calculation 
Template.xls.

Concentrations of SRSi are calculated using equation 18.5:

Equation 18.5.
	 C =

  Asamp − Ablk − b

where C is the concentration of the sample, Asamp is the sample absorbance, Ablk is the reagent 
blank absorbance, m is the slope, and b is the intercept of the calibration curve after correcting for 
the reagent blank absorbance. The sample concentration is reported to three decimals.

If a dilution has been made, the concentration of the sample needs to be corrected for the 
concentration of SRSi in the dilution water using equation 18.6:

Equation 18.6.	 C = (C0 × D) − ((Cdil  × (D − 1)) 

where C0 is the concentration of DOC in the diluted sample, Cdil is the concentration of SRSi in 
the dilution water, and D is the dilution factor, which is calculated using equation 18.7:

Equation 18.7	
D =

  V1

 

where V1 is the volume of the diluted sample, and V0 is the volume of the undiluted sample.

This spreadsheet template should be saved to a new file name to record the data. The file name 
should be in the format of “yyyymmdd_SRSi.xls” (e.g. 20190204_SRSi.xls) and saved in the 
directory \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\SRSi\yyyy SRSi.

m

V0
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To calculate the SRSi concentrations in the samples, fill in each of the yellow fields with the 
Sample ID, dilution factor, and absorbance of each of the reagent blanks, calibration standards, 
reference standards, reference (check) samples, and samples.  

Information on the date, the analyst’s initials, standard lot numbers, expiry date and stock 
concentrations, number of calibration standards (n), reference standard preparation date, and 
reference sample check batch number are also recorded in this spreadsheet in the yellow fields.  

18.15 Data entry
The SRSi concentrations of each sample, which are calculated using the “SRSi Calculation 
Template.xls,” as well as the QC data, are entered into the Sample Master LIMS. The completed 
“SRSi Calculation Template.xls” is printed and filed in the SRSi folder. 

18.16 References
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Appendix 18A. Ammonium Molybdate Preparation Record
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Appendix 18B. 1 N Hydrochloric Acid Preparation Record
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Appendix 18C. Mixed Molybdate Preparation Record
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Appendix 18D. Tartaric Acid Preparation Record
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Appendix 18E. Ascorbic Acid Preparation Record
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Appendix 18F. Calibration and Reference Standards 
Preparation Record
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19.0 Particulate Iron

19.1 Introduction and scope
This method is used in the IISD Experimental Lakes Area Analytical Service Laboratory for 
the determination of particulate iron (Part Fe) in fresh water and atmospheric precipitation. 
Particulate is operationally defined as that which is retained by a GF/C filter, which has a nominal 
pore size of 1.2 µm.         

19.2 Method principle
Particulate matter that has been collected on a glass fibre filter is digested with nitric acid to 
liberate the iron from the filter and transfer it into solution. The concentrated acid is then 
diluted with ultrapure water and analyzed for iron with an atomic absorption spectrometer. The 
instrument atomizes iron in the sample using an acetylene flame, meaning that all iron will be 
measured regardless of its oxidation state in solution.

19.3 Occupational health and safety
Concentrated nitric acid is corrosive, a strong oxidizer, can be fatal if inhaled, and can cause 
severe eye, skin, respiratory, and digestive tract burns. Handle in a fume hood, avoid contact with 
skin, and wear goggles and gloves when handling and diluting. Always pour acid into water slowly 
while stirring. Never pour water into acid.

The acetylene flame of the instrument can generate temperatures up to 2800 °C. The acetylene 
flame can emit ultraviolet light. Do not look directly at the flame without UV protective eyewear, 
and do not leave the room while the flame is lit.

19.4 Validation
This method is fit to measure Part Fe in water.

19.4.1 Operating range

0.4–80 μg Fe per filter disc, given a post-digestion dilution of 20 mL.  

The operating range is in terms of the mass of sample collected per filter and depends on the 
volume of sample filtered. A sample filtration volume of 100 mL corresponds to a concentration 
range of 4–800 μg/L in the filtered sample.
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19.4.2 Detection limits

The detection limit is calculated for each run using equations 19.1 through 19.3:

Equation 19.1	
Cdl =

  yd-b

where b is the y-intercept, m is the slope, and yd is the instrument response detection limit, which 
is calculated using equation 19.2:

Equation 19.2	 yd = 3sy + b

where sy is based on the residuals between the measured instrument response for each standard 
concentration and the calibration curve-predicted response for each standard concentration. It is 
calculated using equation 19.3:

Equation 19.3	
sy =

   ∑di2

where n is the number of standards in the calibration curve, and di is the difference between 
the measured instrument response for each standard concentration and the calibration curve-
predicted response for each standard concentration.

The limit of quantitation is calculated in the same manner as the detection limit, except equation 
19.2 is replaced with equation 19.4:

Equation 19.4	 yq = 10sy + b

The averages of the detection limits and limits of quantitation for samples run between 2017 and 
2019 were:

Detection limit 2.6 μg/L Fe

Limit of quantitation 8.7 μg/L Fe

19.5 Sample condition
Refer to Section 6, Sample Preparation and Filtration for details on sample preparation. Briefly the 
sample:

	‒ Consists of particulates collected (filtered) onto a pre-baked Whatman 4.25 cm GF/C 
glass fibre filter disc.

	‒ Must be filtered within 24 hours of sampling.

m

n−2
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	‒ TIs stored in an acid-washed high-density polyethylene screw-cap vial at room 
temperature.

	‒ Can be stored for up to one year at room temperature.

19.6 Equipment
	‒ PerkinElmer Aanalyst 400 Atomic Absorption Spectrometer and WinLab 32™ software

	‒ acid-washed high-density polyethylene screw-cap vials, 20 mL capacity

	‒ filtration apparatus with a 47-mm diameter magnetic filter funnel

	‒ 42.5 mm GF/C glass fibre filters, baked for 14 hours at 500 °C

	‒ repeater pipette

	‒ 25 mL capacity Eppendorf™ Combitip 

	‒ Eppendorf™ micropipettes and tips.

	‒ volumetric flasks (100 mL, acid washed prior to use)

	‒ spatula

	‒ flat-ended filter forceps

19.7 Purchased reagents

19.7.1 High-purity concentrated nitric acid

Stable at room temperature until the expiry date on the manufacturer’s label. 

19.7.2 Calibration standard stock

Commercially-certified iron standard.

1.0 mL = 1000  ± 10 μg Fe

The standard is stable at room temperature until the expiry date on the manufacturer’s label.

19.7.3 Reference standard stock

Commercially-certified iron standard

1.0 mL = 1000 ± 10 μg Fe

The standard is stable at room temperature and may be used past the expiry date on the label. It 
must be from a different manufacturer than the iron standard used for calibration standards.
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19.8 Prepared reagents
	‒ Preparation information for all standards is recorded in the Reagent Preparation logbook.

	‒ All standards are labelled with an expiry date.

	‒ Standard containers are washed according to Section 2, Labware Cleaning and rinsed with 
new reagent before pouring in the bulk of new reagent.

	‒ All standards are prepared with Type 1 ultrapure water (Milli-Q).

	‒ All standards are prepared in volumetric flasks.

19.8.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

19.8.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

19.8.3 Calibration curve

Dilute the volumes of the 1000 µg/mL Fe 
calibration standard stock according to Table 
19.1 with 10 mL of concentrated nitric acid 
and Milli-Q water in 100 mL volumetric flasks 
to make each of the following calibration 
standard concentrations. Add ~80 mL of 
Milli-Q water to your volumetric flasks 
before you add the acid. Prepare weekly.

19.8.4 Reference standard – 2000 
µg/L Fe

Dilute 200 µl of the 1000 µg/mL Fe reference 
standard stock with 10 mL of concentrated 
nitric acid and Milli-Q water in 100-mL 
volumetric flasks. Add ~80 mL of ultrapure 
water to your volumetric flask before you 
add the acid. Prepare weekly.

Table 19.1. Dilution volumes of calibration 
standards

Std conc 
(µg/L)

Calibration 
stock vol 

(µL)
Final vol 

(mL)

0 0 100

125 12.5 100

250 25 100

500 50 100

1000 100 100

2000 200 100

https://www.iisd.org/ela/


IISD.org/ela 243

The Chemical Analysis of Fresh Water

19.8.5 Reference sample

Reference samples are prepared in bulk according to Section 4, Reference Sample Preparation. 
Briefly, 50 mL aliquots of Lake 227 epilimnion water, collected during peak phytoplankton 
biomass, are filtered through GF/C filters. Each filter is placed in a 50-mm Petri dish, desiccated 
in the dark in a vacuum desiccator, and stored in the dark at -20 °C. 

19.9 Quality control
This method has a number of conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data is 
recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the non-
conformance is investigated and reported in the non-conformance log, and appropriate corrective 
action is taken before testing is resumed. 

19.9.1 Blanks

Reagent blanks consisting of 3 mL of high-purity nitric acid and 18 mL of Mill-Q water and 
method blanks consisting of an unused, pre-baked GF/C filter disc, 2 mL of high-purity nitric 
acid, and 18 mL of Milli-Q water are included in each run.

19.9.2 Reference standard

A reference standard is run every 15 samples. These must be within 5.0% of the calibration 
standard of the same concentration (i.e. 2000 µg/L). 

19.9.3 Calibration curve

The linear correlation coefficients obtained from the calibration curve must have an R2 ≥ 0.995 
with a first order fit. If this criterion is not met, new calibration standards may need to be 
prepared.

19.9.4 Reference sample

A reference sample is included at the beginning of every run for Fe. The Fe value obtained must 
agree to within 5.0% of the expected value. Results for reference sample performance are charted 
and assessed for drift and bias.

19.9.5 Duplicates

Random duplicates are run every 15 samples. Samples for duplicate analysis are chosen at the 
beginning of the analysis run (before the first analysis is done). Duplicates must agree to within 
5.0% of each other. If duplication is inadequate, samples bracketed by the duplicates are re-tested.
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19.9.6 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibration and 
Verification. The calibrations of the Eppendorf™ pipettes are verified on a weekly basis or prior to 
making standards using methods outlined in Section 3, Labware Calibrations and Verifications. All 
glassware is cleaned according to Section 2, Labware Cleaning.

19.10 Quality assurance
Proficiency testing is not currently conducted for the Part Fe analysis.

19.11 Sample preparation

19.11.1 Digestion and extraction

1.	 Compress the filter to the bottom of the vial so that as much of it as possible can be 
covered by the nitric acid. 

2.	 In a fume hood, use a repeater pipette to add 2 mL of high-purity concentrated nitric acid 
to each vial.

3.	 Place the vials in a cardboard flat (or whatever else may be convenient) and put them in a 
fume hood. Allow the samples to digest at room temperature for at least two days. 

4.	 After a 72-hour digestion period has passed, use a repeater pipette to add 18 mL of 
Milli-Q water to each vial. Be careful to avoid cross-contamination of vials from splash-
back, wiping the repeater pipette with a Kimwipe™ as necessary. The samples are now 
ready for analysis. 

5.	 Prior to analysis, the sample vials are inverted to mix.

19.12 Analysis

19.12.1 Atomic absorption spectrometer

1.	 Open the regulator to begin the flow of acetylene gas to the instrument. Ensure the tank 
has a pressure of at least 50 psi. 

2.	 Turn on the atomic absorption spectrometer.

3.	 On the computer, open “WinLab32 for AA.” The software will connect to the instrument 
as it starts up.

4.	 Click on the Lamps icon on the toolbar. Turn on the iron hollow cathode lamp (HCL) by 
selecting Lamp X under the “Set Up” column, with X being whichever port number the 
iron HCL is being housed in. The spectrometer can have up to four HCLs at a given time, 
so ensure you have selected the correct port. The “Energy” intensity of the lamp should be 
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around 75 once it is turned on, and the icon under the “On/Off” column will turn green. 
Close the Lamp Setup window (if it is open, the software will not let you run samples). Let 
the lamp warm up for at least 15 minutes before starting measurements. 

5.	 Place the sample line in a beaker of fresh DRO water. Once the flame is turned on, it will 
begin aspirating the sample.  

6.	 Click on the Flame icon on the toolbar. Click on the On/Off switch icon to turn on the 
flame. The acetylene flow should be at 2.50 L/min, while the airflow should be 10.00 
L/min. Once the flame is turned on, adjust the acetylene pressure from the tank to 14 
psi. Close the Flame Control window. Let the flame burn for at least five minutes before 
starting measurements.

7.	 Click on the MethEd icon on the toolbar. Select the “ELA Fe” method and click OK.

8.	 Click on the Manual icon on the toolbar. First, under “Info. File,” click Open and open the 
“ELA Fe.sif” sample info file. Next, under “Results Data Set Name,” click Open. Enter 
the name as “MMM DD ELA,” and put the description as the range of sample numbers 
you will be analyzing. Click OK—do not worry about what is highlighted; as long as you 
have put in a new name and description, no old data will be over-written. Ensure the 
“Save Data” box under the “During Analyses:” heading is checked.

9.	 Click the Results icon on the toolbar and position the window on the screen such that both 
it and the Manual window are visible. Samples are now ready to be run.

10.	 In the Manual window, change the ID to a description of the sample (i.e. 500 std or 
2017082801-01) about to be analyzed and write the sample information onto the 
BenchSheet. Take the sampling tube and hold it in the sample or standard to be measured. 
Filter particles can clog the sampling line, so try to avoid touching the filter or placing 
the sample line at the bottom of the vial where the filter particles tend to reside. When the 
sampling tube is in place, click the Analyze Sample button. Once the Sample Progress bar 
indicates the analysis is completed, remove the sampling tube from the sample and place 
it back into the beaker of DRO water. The sample readings should now be displayed in the 
Results window. Move on to the next sample once you are happy with them. Any samples 
with a reading higher than the largest calibration standard will need to be diluted. Refill 
the DRO beaker as needed. It is ok if the sample line aspirates air, though try to maintain 
liquid aspiration as much as possible.   

11.	 Once the sample run is complete, let the instrument suck DRO water for five minutes.  

12.	 After the rinsing is complete, click the Flame icon on the toolbar. Click on the On/Off 
switch icon to turn off the flame.  

13.	 Click on the Lamps icon on the toolbar. Click the green icon next to the Fe lamp under the 
“On/Off” column to turn the HCL off. The power bar should drop to zero, and the icon 
will turn grey.

14.	 Close “WinLab32 for AA” and turn off the spectrometer. The program will ask, “Do you 
want to quit using WinLab?” Click OK. It will then tell you “Sample information has 

https://www.iisd.org/ela/


IISD.org/ela 246

The Chemical Analysis of Fresh Water

changed” and ask you if you want to save the changes on disk before continuing. Click No. 
The window will then close after a couple of seconds.    

15.	 Close the regulator to cease the flow of acetylene gas.

Table 19.2. A typical sequence of a particulate iron analytical run

19.12.2 Data retrieval

1.	 On the computer, open Data Manager.  

2.	 Click on the Result Name matching the Results Data Set Name you gave at the start of the 
sample run. Click on the Export icon on the top toolbar. The Data Export Wizard will open.

3.	 Click on Use Existing Design. Click the Browse button and select “ELA Fe.xpt.” Click 
Next. All samples should be highlighted. Click Next until you reach the page with the 

Scan # Sample description

1 DRO Water

2 DRO Water

3 2000 μg/L reference standard

4 0 μg/L calibration standard

5 125 μg/L calibration standard

6 250 μg/L calibration standard

7 500 μg/L calibration standard

8 1000 μg/L calibration standard 

9 2000 μg/L calibration standard

10 2000 μg/L reference standard

11 filter blank

12 filter blank

13 L227 reference sample

14 L227 reference sample

15–27 samples 1-13

28 random duplicate from samples 
1–13

29 2000 μg/L reference standard

Scan # Sample description

30–44 samples 14–28

45 random duplicate from samples 
14–28 

46 2000 μg/L reference standard

34–48 samples 29–43 

49 random duplicate from samples 
29–43

50 2000 μg/L reference standard

51 filter blank (remeasure)

52 filter blank (remeasure)

53 0 μg/L calibration standard

54 125 μg/L calibration standard

55 125 μg/L calibration standard

56 500 μg/L calibration standard

57 1000 μg/L calibration standard 

58 2000 μg/L calibration standard

59 2000 μg/L reference standard
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heading “4. Select Export Options.” Here, under “Name:” select the text box and name it 
“yyyymmdd PartFe” with the analysis date. Click Next until you reach the page with the 
heading “8. Export Data Set” and click the Export Data button. Click Finish.

4.	 The data set has now been exported to C:\Users\Public\PerkinElmer\AA\Data\Reports 
where it will be a .csv file. Copy the file to a flash drive. When you have access to a 
computer equipped with Microsoft Office, open it with Excel and save it as an Excel file. 

19.13 Cleaning
The equipment is cleaned according to Section 2, Labware Cleaning. Briefly, filters are removed 
with forceps and discarded. Excess sample is discarded into the sink under running water. Vials 
and lids are rinsed three times with hot water, placed in a 10% HCl acid bath for at least four 
hours, and rinsed three times with DRO water.

19.14 Calculations
The calculation of Part Fe in samples is performed by using the “PartFe Calculation Template.
xls” worksheet.

The corrected absorbance (Acorrected) is calculated using equation 19.5:

Equation 19.5.	 Acorrected = Ameasured − Ablank

where Ameasured is the absorbance of the sample, and Ablank is the average absorbance of all the 
method blanks. The concentration of iron in the extract (Cextract) is calculated using equation 19.6: 

Equation 19.6.	
Cextract =

  Acorrected − b 
× D

where m is the slope, b is the intercept of the calibration curve after correcting for the reagent 
blank absorbance, and D is the dilution factor, which is calculated using equation 19.7:

Equation 19.7.	
D =

  V1

 

The concentration of iron in the sample (Csample) is then calculated using equation 19.8:

Equation 19.8.	
Csample =

  Cextract × Vextract

where Vextract is the extract volume (typically 20 mL), and Vsample is the volume of the sample 
filtered through the filter disc. 

(        )m

V0

Vsample
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The worksheet template should be saved to a new file name to record the data. The file name 
should be in the format of “yyyymmdd_PartFe.xls” (e.g. 20200821_PartFe.xls) and saved in the 
directory \\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\PartFe\yyyy_PartFe.

To calculate the particulate iron concentrations in the samples, fill in each of the yellow fields with 
the Sample ID, dilution factor, extract volume, filtration volume, and absorbance of each of the 
blanks, calibration standards, reference standards, reference samples, and samples.  

Information on the date, analyst’s initials, standard lot numbers, expiry date, stock 
concentrations, number of calibration standards (n), reference standard preparation date, and 
reference sample check batch number are also recorded in this spreadsheet in the yellow fields.  

19.15 Data entry
The particulate iron concentrations of each sample, which are calculated using the “PartFe 
Calculation Template. xls,” as well as the QC data, are entered into the Sample Master LIMS. 
The completed “PartFe Calculation Template. xls” is printed and filed in the PartFe folder. 
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Appendix 19A. Calibration and Reference Standards 
Preparation Record
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20.0 Chlorophyll-a: Gross fluorescence 
method

20.1 Introduction and scope
The following method is used in the IISD Experimental Lakes Area Analytical Service Laboratory 
for the determination of chlorophyll-a (Chl-a) in fresh water.

20.2 Method principle
Particulate matter from samples of lake water is collected on glass fibre paper, dried using 
vacuum desiccation and stored at ≤ -20 °C until analyzed. Photosynthetic pigments within the 
filter-retained particulate matter are quantitatively extracted in a mixture of methanol, acetone, 
and water. The extract is analyzed fluorometrically using the Environmental Protection Agency 
Method 445.0 (Arar & Collins, 1997).

For Chl-a, excitation between 430–450 nm gives an emission maximum between 650−675 nm. 
In the method described, a fluorometer equipped to provide excitation at 440 nm and detection 
emission at 660 nm is used. The output of the instrument is in arbitrary units, and it must be 
calibrated using a ch-a solution of known concentration.

Chl-a (from Anacystis nidulans) from Sigma Aldrich is a convenient source of pure Chl-a that is 
free of chlorophyll-b and can be used to calibrate the fluorometer.

Using the recommended fluorometer settings, the instrument responds almost exclusively to 
Chl-a. However, chlorophyll degradation products will also produce a response when present 
(as may be the case with samples from aphotic waters or sediments). Estimates using this “gross 
fluorescence” method will over-estimate Chl-a where degradation products are present. A high-
performance liquid chromatography procedure should be used to specifically measure Chl-a 
where this distinction is required.

20.3 Occupational health and safety
This method requires the use of volatile solvents (methanol and acetone). Hand and eye 
protection must be used when working with solvents and should be performed in a fume hood.
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20.4 Validation

20.4.1 Operating range

This depends on the mass of cells capable of being collected on a GF/C filter and, hence on the 
volume of lake water available or capable of being filtered. The lower limit of chlorophyll mass 
that can be detected is 0.5 ng. For the default volume of water sample filtered (200 ml) and 2 ml 
solvent used for pigment extraction, the method detection limit is 0.05 µg/L Chl-a in lake water. 
The upper limit of 100 µg/L can be attained by adjusting the filtration volume and extraction 
volume.

20.4.2 Detection limits

The method detection limit (MDL) goal for the Chl-a test is 0.5 ng or less.

The test performs as well, or better, than these established goals and hence this method is fit for 
determining Chl-a in water.

20.5 Sample conditions
See Section 6, Sample Preparation and Filtration for details on sample preparation. 

The sample filter discs analyzed must be

	‒ collected (filtered) on Whatman GF/C 4.25 cm glass fibre filters, 

	‒ vacuum desiccated for 16 hours,

	‒ stored dry in individual Petri dishes,

	‒ stored at ≤ -20 °C, and

	‒ stored in the dark, preferably not longer than 12 months.

20.6 Equipment
	‒ Shimadzu UV-1800 scanning spectrophotometer

	‒ UV Probe software

	‒ Turner Designs Trilogy Fluorometer equipped with a Chl-a Non-Acidification 
Fluorescence Module

	‒ 1 cm low volume cuvettes (quartz windows)

	‒ 13 mm (O.D.) glass cuvettes

	‒ low volume glass transfer pipettes

	‒ 25 mL glass volumetric flasks
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	‒ 9 mL test tubes with threaded neck and polytetrafluoroethylene (PTFE)-lined caps for 
extraction

	‒ flat-ended filter forceps

	‒ stainless steel rod

	‒ repeating dispenser calibrated at 2.0 mL for dispensing the extracting solvent

	‒ glass graduated syringes

	‒ rack to support vials in an upright position

	‒ Chlorophyll-a BenchSheet (Appendix 20D)

20.7 Purchased reagents

20.7.1 Methanol (HPLC or certified ACS grade)

Store at room temperature in the manufacturer’s bottle. Stable as per the manufacturer’s 
specifications.

20.7.2 Acetone (HPLC or certified ACS grade)

Store at room temperature in the manufacturer’s bottle. Stable as per the manufacturer’s 
specifications.

20.7.3 Chl-a calibration crystals

Chl-a from Anacystis nidulans algae is a crystalline solid obtained in nominal 1 mg quantities from 
Sigma Aldrich and is free of chlorophyll-b, unlike chlorophyll extracted from spinach. Stored at 
≤ -20 °C (< 0 °C manufacturer’s instructions) in the dark. 

20.7.4 Chl-a reference crystals

Chl-a from spinach is a crystalline solid obtained in nominal 1 mg quantities from Sigma Aldrich 
and may contain chlorophyll-b. Stored at ≤ -20 °C (< 0 °C manufacturer’s instructions) in the 
dark. 

20.8 Prepared reagents
	‒ Preparation information for all reagents and standards is recorded in the Reagent 
Preparation logbook.

	‒ All reagents and standards are labelled with an expiry date.

	‒ Reagent and standard containers are washed according to Section 2, Labware Cleaning and 
rinsed with new reagent before pouring in the bulk of new reagent.
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	‒ Unless otherwise indicated, all reagent chemicals are ACS grade.

	‒ Unless otherwise indicated, all reagents and standards are prepared with Type 1 ultrapure 
water (Milli-Q).

	‒ Unless otherwise indicated, all reagents and standards are prepared in volumetric flasks.

20.8.1 Type 2 ultrapure deionized reverse osmosis (DRO) water

Effluent from an Elix 20 Water Purification System (> 5 MΩ∙cm purity). The feedwater for the 
Elix 20 system is water from Lake 239 that is filtered through a 20", 5-µm pleated paper filter, UV 
treated, and then filtered through an Extra Fine Pore Sediment Cartridge (Rainfresh), an Ion-Ex 
Cartridge (MilliporeSigma), and a Super-C Carbon Cartridge (MilliporeSigma).

20.8.2 Type 1 ultrapure water (Milli-Q)

Effluent from a Milli-Q Advantage A10 Water Purification System (> 18 MΩ∙cm purity) with 
Type 2 DRO feedwater.

20.8.3 Extraction solvent

Using a graduated cylinder, mix the following proportions of solvent:

	‒ 68% methanol   

	‒ 27% acetone     

	‒ 5% Milli-Q water    

This is stable for six months at room temperature in a brown glass bottle.

Do not allow this solvent mix to sit open to atmosphere to evaporate, or proportions will change.

20.8.4 Chl-a calibration standard stock

Under low light conditions, ~1 mg of crystalline Chl-a from A. nidulans is dissolved in 100 ± 2 
mL acetone to give a stock standard of ~10 mg/L (since the exact weight of the crystalline Chl-a is 
uncertain). The exact concentration is not essential since it is determined spectrophotometrically 
each time it is used to prepare the intermediate calibration standard.  

This solution should be handled with care at all times. Exposure to acid vapours must be 
avoided as this will cause degradation of Chl-a to phaeophyton-a. Regular handling of the Chl-a 
calibration standard stock can lead to both photo-degradation of pigment and evaporation of 
solvent. While the concentration is determined spectrophotometrically (see Section 20.8.11) each 
time it is used, it is best to attempt to minimize the changes in the Chl-a calibration standard 
stock concentration as much as possible. Store the Chl-a calibration standard stock in an amber 
glass bottle, sealed with a PTFE-lined screw-cap, at ≤ -20 °C in the dark for up to one year.
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20.8.5 Chl-a reference standard stock

The Chl-a reference stock is prepared and handled with the same precautions as the Chl-a 
calibration standard stock, as outlined above in section 20.8.4.

20.8.6 Intermediate Chl-a calibration standard

The standard should be prepared fresh and stored in the dark at room temperature while not in 
use.

The intermediate Chl-a calibration standard is prepared by diluting the Chl-a calibration 
standard stock with the extraction solvent to obtain a concentration of 500 ± 50 µg/L. The 
concentration of the intermediate Chl-a calibration standard is verified spectrophotometrically 
(see Section 20.8.11). 

1.	 Remove ~1 ml of the Chl-a calibration standard stock that was just measured from the 
spectrophotometer cuvette using a glass transfer pipette with an attached bulb.

2.	 Place the ~1 ml of the Chl-a calibration standard stock into a 25 ml graduated cylinder 
with a glass stopper.

3.	 Dilute the Chl-a calibration standard stock with ~20 mL of extraction solvent from the 2 
mL calibrated dispenser to obtain a concentration of 500 ± 50 µg/L.

4.	 Measure as an unknown on the spectrophotometer as per Section 20.8.11 below. If the 
intermediate Chl-a calibration standard is greater than 550 µg/L, add more extraction 
solvent and remeasure. If the daily Chl-a calibration standard stock is less than 450 µg/L, 
add more Chl-a calibration standard stock and remeasure. Continue adjustment until the 
500 ± 50 µg/L concentration is achieved. 

20.8.7 Intermediate Chl-a reference standard

The standard should be prepared fresh and stored in the dark at room temperature while not in 
use.

The intermediate Chl-a reference standard is prepared in the same manner as the intermediate 
Chl-a calibration standard, as outlined above in Section 20.8.6.

20.8.8 Chl-a calibration standard curve

The standard should be prepared fresh and stored in the dark at room temperature while not in 
use.

Five Chl-a standard concentrations are prepared by diluting the intermediate Chl-a calibration 
standard with extraction solvent in 25-mL volumetric flasks according to Table 20.1. Use glass 
graduated syringes to measure and deliver intermediate Chl-a standard. Do not use plastic 
pipette tips as they are “wetted” with solvent and do not deliver accurate volumes.
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Table 20.1. Dilution volumes of calibration standards

Target conc. DF Intermediate Std Vol. (µL) Final Vol. (mL)

0 extract solvent only 0 25

5 100 250 25

10 50 500 25

25 20 1250 25

50 10 2500 25

100 5 5000 25

Note: The actual standard concentrations will differ slightly from the target concentrations, 
depending on the concentration of the intermediate Chl-a standard. For example, if the 
intermediate Chl-a standard measured 520 µg/L, the 100, 50, 20, and 10 dilution factors will 
result in a calibration curve with concentrations of 5.2, 10.4, 26, 52, and 104 µg/L, respectively.

20.8.9 Chl-a reference standard – 10 µg/L

The standard should be prepared fresh and stored in the dark at room temperature while not in 
use.

A 10 µg/L Chl-a reference standard is prepared by diluting 500 µL of the intermediate Chl-a 
reference standard with 24.5 mL of the extraction solvent in a 25-mL volumetric flask.

20.8.10 Reference sample

Reference samples are prepared in bulk according to Section 4, Reference Sample Preparation. 
Briefly, the reference sample consists of a GF/C filter that has been used to filter 50 mL of Lake 
227 water collected during the summer bloom. The reference samples are vacuum desiccated and 
stored in the dark at ≤ -20 °C.

20.8.11 Spectrophotometric determination of stock and intermediate standards

1.	 Turn on the power on the Shimadzu UV-1800 scanning spectrophotometer and let it 
warm up for at least two hours.

2.	 On the PC desktop, double-click the UV Probe shortcut.

3.	 Click OK.

4.	 Ensure that the Photometric icon is selected (Figure 20.1).

https://www.iisd.org/ela/


IISD.org/ela 256

The Chemical Analysis of Fresh Water

Figure 20.1. The Photometric icon

5.	 Open the method file under \\ela-camp.iisd.ca\shared\Chem Lab\Analysis Results\Chla\
chlorophyll.pmd

Note: You must change the file type to methods in order to find the correct file.

6.	 The file will open with the correct wavelengths (665, 650, and 700 nm) selected, plus the 
calculation equation 20.1:

Equation 20.1.	 Conc (μg/l) = 16.5(A665−A700) − 8.3(A650−A700)  

7.	 Click the Connect button at the bottom (Figure 20.2). If not available, click View > 
Photometric buttons. The UV detector will now go through its startup sequence.  

8.	 After the startup sequence has finished, if the instrument has passed, click OK.

9.	 Rinse two 1-cm cuvettes with acetone and fill them with acetone.

10.	 Wipe the cuvettes with Kimwipes™ and place them in the appropriate holders in the 
spectrophotometer (the cuvette farthest away from you is the reference position).

Figure 20.2. Chl-a UV Probe photometric method window prior to connecting the UV 
Probe software to the Shimadzu UV-1800 scanning spectrophotometer

Photometric
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11.	 Click the Baseline (Figure 20.3) button, which will now be selectable. The baseline window 
options should be 400 to 800 nm. Click OK. The spectrophotometer will run through the 
two acetone samples to establish a standard baseline. After it has finished, all the buttons 
will be selectable (bold) again.

Figure 20.3. Chl-a UV Probe photometric method window

12.	 Remove the front cuvette, empty it, rinse it with stock solution, fill it with calibration 
stock, and return the cuvette to the front. Fill in the Sample ID of the standard table 
with “Chl stock_date” (format as mmdd, where the date is the current date of analysis). 
Click the Read Unknown button (Figure 20.3). Record the Chl-a concentration on the 
Chlorophyll-a BenchSheet (BenchSheet) and in the Chlorophyll Standard logbook. If this 
value is more than 5.0% different than the previous recorded value, repeat the scan. If 
repeat scan is still > 5.0% different, repeat again and record the mean of the three new 
readings. 

13.	 Remove the front cuvette and transfer ~1 ml of the calibration stock to a 25-mL TC 
graduated cylinder with a tapered stopper. Dilute the calibration stock with enough 
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extraction solvent to yield a concentration of 500 ± 50 µg/L. Rinse the cuvette with 
methanol and then repeat step 12 using the diluted calibration stock (i.e. intermediate 
calibration standard) and labelling the Sample ID with “Cal_std_date” to measure and 
record the intermediate calibration standard. 

14.	 Repeat steps 12 and 13 for the reference stock and intermediate reference standard, 
labelling the Sample IDs with “Ref_stock_date” and “Ref_std_date,” respectively.

15.	 Save the results in \\ela-camp.iisd.ca\shared\Chem Lab\Analysis Results\Chla\yyyy_Chla 
in the format “yyyymmdd_Chla.unk” (e.g. 20140501_Chla.unk).

16.	 Once complete, click Disconnect and close the UV Probe software.

17.	 Ensure the spectrophotometer is turned off (if no longer needed) and rinse the two 
cuvettes with methanol.

20.8.12 Calibration of repeating dispenser

1.	 The dispenser used to distribute the extraction solvent must be checked prior to use to 
ensure it is delivering the proper volume.

2.	 Pump the dispenser twice to ensure there are no bubbles in the line.

3.	 Ensure the adjustable pointer is pointed at the 2-ml mark.

4.	 Take a 10-mL graduated cylinder and dispense five pumps of extraction solvent into it.

5.	 Volume should be 10 ± 0.1 mL.

6.	 If the volume is not acceptable, adjust the volume pointer. Loosen the knob, adjust the 
volume, and repeat the calibration.

20.9 Quality control
This method has a number of conditions for calibration standards, reference standards, reference 
samples, and blanks that must be met before samples can be analyzed and the resulting data 
is recorded. If any of the quality control (QC) expectations are not met, testing is stopped, the 
non-conformance is investigated and reported in the Non-Conformance log, and appropriate 
corrective action is taken before testing is resumed. If any QC failure persists, testing of samples is 
suspended until QC has been returned to within expectations. 

20.9.1 Solid secondary standard

A solid secondary standard is used prior to fluorometric analysis to check the drift of the 
instrument over time. The raw fluorescence units (RFU) of the solid secondary standard at the 
time of analysis must be within 2.5% of the RFU of the solid secondary standard at the time of 
calibration. If not, the fluorometer must be recalibrated.
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20.9.2 Reference standard

A reference standard is run every time a new calibration curve is run. The RFU of the reference 
standard must be within 5.0% of the RFU of the calibration standard of the same concentration 
(i.e. 10 µg/L).

20.9.3 Calibration curve

The linear correlation coefficients obtained from the calibration curve must have an R2 ≥ 0.995 
with a first order fit. If this criterion is not met, new calibration standards may need to be 
prepared.

20.9.4 Reference sample

A reference sample is included at the beginning of every run for Chl-a. The Chl-a value obtained 
must agree to within 5.0% of the expected value. Results for check sample performance are 
charted and assessed for drift and bias.

20.9.5 Duplicates

Random duplicates of sample extracts are run every 15 samples. The duplicates must agree within 
0.5 µg/L below concentrations of 10 µg/L or within 5.0% of the mean for concentrations greater 
than 10 µg/L. 

20.9.6 Instrument blanks

Instrument blanks, consisting solely of extraction solvent, are analyzed at the beginning of each 
run. The instrument blanks must be below 0.10 µg/L; otherwise the problem must be investigated 
and corrected.

20.9.7 Labware

Volumetric flasks are calibrated and maintained according to Section 3, Labware Calibrations and 
Verification. All other glassware is cleaned according to Section 2, Labware Cleaning.

20.10 Quality assurance
Unlike most analytical methods, there are few known inter-laboratory calibration or certification 
programs available for the measurement of Chl-a, and these can be prohibitively expensive. We do 
not currently participate in proficiency testing. However, this method follows guidelines set forth 
by the United States Environmental Protection Agency Method 445.0, In Vitro Determination of 
Chlorophyll a and Pheophytin a in Marine and Freshwater Algae by Fluorescence.
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20.11 Sample preparation
There is a 16-hour lag time between the extraction step and the analytical step. 

20.11.1 Pigment extraction

A sample is collected by filtering a known volume of water through a Whatman GF/C 4.25-
cm diameter GF/C filter. The default volume is 200 mL (see Section 6, Sample Preparation and 
Filtration).

Under low light conditions, the sample filter is desiccated under vacuum for 16 hours and 
processed immediately or stored at ≤ -20 °C in the dark in a small plastic Petri dish (see Section 
6, Sample Preparation and Filtration). The filter is transferred to a glass extraction test tube with 
forceps by folding the filter in half twice, particulates facing in, placing the filter in the bottom 
of the extraction tube and using the aluminum rod to move the filter to the bottom of the tube. 
The filter must be placed far enough down in the tube to be covered by the 2.0 mL of extraction 
solvent that will be added, but it should not be packed tightly, as this will affect the extraction.

The extraction tube, with filter, is placed in a numbered rack, and the BenchSheet is filled out 
with the sample number, rack position, sample description (e.g. 239 epi), and filtration volume. 

Using the calibrated dispenser, add 2.0 mL of extraction solvent to the extraction test tube 
containing the filter. Make sure the PTFE tip of the dispenser is free of bubbles and that the 
plunger is raised and lowered fully for each dispensing cycle. While the default extraction solvent 
volume added is 2.0 mL, filters with high levels of Chl-a (visual inspection of the biomass on the 
filter) are diluted at this stage with 4.0–8.0 mL of solvent. Record the extraction volume for each 
sample on the BenchSheet.

The cap is screwed on the test tube tightly and placed back into the rack, making certain that the 
filter is still at the bottom of the test tube and covered with solvent. After all samples are set up, 
the rack is covered by the bottom end of another rack so test tubes can be inverted three times to 
mix contents completely.

The sample is extracted while stored in the dark at 4 °C for a minimum of approximately 16 
hours (overnight).

At the end of the extraction period, the sample vials are again inverted to mix the sample and 
solvent. Vials are kept in the dark at room temperature for one hour prior to analysis. This allows 
the solvent to warm and particles to settle.
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20.12 Analysis

20.12.1 Calibration curve

A calibration curve is conducted at the beginning of the field season and any time the RFU of 
the solid secondary standard at the time of analysis is more than 2.5% different than the RFU 
of the solid secondary standard at the time of calibration. The fluorometer is calibrated with the 
calibration standards created in Section 20.8.8 using the following steps: 

1.	 Turn on the fluorometer and let it warm up for at least 30 minutes. The instrument goes 
to sleep after a period of inactivity; ensure that this does not occur.

2.	 Select the CHL-NA module. Close the 
door and dim the lights as dark as they 
can be without impairing your ability 
to read and write.

3.	 Put the instrument in raw fluorescence 
mode by clicking Mode. Remove the 
cuvette holder and measure the RFU 
of the solid secondary standard by 
clicking Measure Fluorescence Raw 
(Figure 20.4). Replace the cuvette 
holder and measure the RFU of the 
reference standard. Record these values 
on the BenchSheet.

4.	 Click Calibrate to enter the 
instrument’s calibration mode and 
select µg/L as the unit of measure. 

5.	 Fill a cuvette with at least 2 mL of 
extraction solvent, place in the cuvette holder and click OK.

6.	 Fill a cuvette with standard and enter the actual concentration of the standard (as 
calculated from the stock concentration, NOT the target concentration) and click OK. 
Record RFU values on the BenchSheet as they appear.  

7.	 Click Enter More Standards and repeat step 6 for the remaining four standards.

8.	 Name the calibration with the date in the “yyyymmdd format” and click Save.

9.	 Enter the calibration curve and reference standard data (again use calculation, not target 
concentrations) into the Excel worksheet (\\ela-lab.iisd.ca\shared\Chem Lab\Analysis 
Results\Chla\yyyymmdd_Chla.xls) and save the file as “yyyymmdd_Chla.xls” in \\ela-lab.
iisd.ca\shared\Chem Lab\Analysis Results\Chla\yyyy_Chla directory. Ensure that the 
calibration curve has an R2 ≥ 0.995 and the reference standard is within 5.0% of the 10 

Figure 20.4. Display screen of Turner 
Designs Trilogy Fluorometer in raw 
fluorescence mode
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µg/L calibration standard. If they are not within acceptable values, the reference standard 
and/or the calibration curve may need to be remade and/or reanalyzed. 

20.12.2 Fluorometric analysis

If samples are processed on the same date as the calibration curve was conducted, proceed to 
step 4.

1.	 Turn on the fluorometer and let it warm up for at least 30 minutes. The instrument goes 
to sleep after a period of inactivity; ensure that this does not occur.

2.	 Select the CHL-NA module. Close the door and dim the lights as dark as they can be 
without impairing your ability to read and write.

3.	 Put the instrument in raw fluorescence mode by clicking Mode. Remove the cuvette holder 
and measure and RFU of the solid secondary standard by clicking Measure Fluorescence 
Raw (Figure 20.4). Compare this value to the RFU of the solid secondary standard 
obtained on the date of calibration. If the RFUs are within 2.5%, proceed with an analysis 
of the samples. If not, a new calibration curve needs to be conducted.

4.	 Run an instrument blank by filling a cuvette with at least 2 mL of extraction solvent, 
placing it in the cuvette holder and clicking OK. Record the concentration and 
fluorescence value on the BenchSheet. Make sure to capture the fluorescence value before 
it disappears.

5.	 Run each sample in the same manner as the instrument blank.

	‒ If there is doubt about having enough sample to measure, remove the cuvette holder, 
place the cuvette with sample extract in it, and ensure the meniscus is above the 
window. If there is not enough sample, use a spatula to squeeze extra solvent out 
of the filter. If this still does not yield enough sample, use graduated glass syringes 
to dilute 1 mL of sample with 1 mL of extraction solvent and measure this, making 
note of the dilution.

	‒ If a sample is off-scale, dilute it as necessary with extraction solvent. Try to avoid this 
scenario by choosing the right amount of extraction solvent during the extraction 
step.

6.	 Run a random duplicate every 15 samples.

7.	 Once analysis is complete, turn off the fluorometer.

20.13 Cleaning
1.	 Dump any remaining solvent into the solvent waste container.

2.	 Remove filters from test tubes using the aluminum rod and discard them in the trash.
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3.	 Rinse the cuvettes, test tubes, and caps with hot tap water and scrub the test tubes with a 
brush to remove any remaining filter debris. Rinse the cuvettes, test tubes, and caps three 
times with hot water, followed by three times with DRO water. 

4.	 Dry the cuvettes, test tubes, and caps in an acid vapour-free environment.

All other labware is cleaned according to Section 2, Labware Cleaning. Briefly, the labware is 
rinsed three times with hot water, three times with DRO water, and air dried.

20.14 Calculations
A calibration curve, first order instrument response, R, is generated within the Trilogy fluorometer 
(equation 20.2):

Equation 20.2.	 Cstd = (b + mRstd)

where Rstd is the instrument response to the calibration standard of concentration Cstd in µg/L 
and b and m are the intercept and slope, respectively. This curve is then modified to calculate 
samples as:

Equation 20.3.	
Csmpl = (b + mRsmpl) ×

 vsolv

where Rsmpl is the instrument response to the sample of concentration Csmpl, and vsolv and vfilt are 
the volume of extraction solvent (mL) and the volume of sample filtered (mL), respectively.

20.15 Data entry
The Chl-a concentrations for each sample, which are calculated by the Trilogy fluorometer using 
the calibration curve, as well as the QC data, are entered into the Sample Master. The calibration 
curve and reference standard data (again, use calculation, not target concentrations) are entered 
into the Excel worksheet (\\ela-lab.iisd.ca\shared\Chem Lab\Analysis Results\Chla\yyyymmdd_
Chla.xls) and saved as “yyyymmdd_Chla.xls” in the \\ela-lab.iisd.ca\shared\Chem Lab\Analysis 
Results\Chla\yyyy_Chla directory. The Chlorophyll-a BenchSheet is filed in the Chl-a archived 
BenchSheet folder.

20.16 References
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Appendix 20A. Extraction Solvent Preparation Record
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Appendix 20B. Chlorophyll-a Calibration Standard Stock 
Preparation Record
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Appendix 20C. Chlorophyll-a Reference Standard Stock 
Preparation Record
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Appendix 20D. Chlorophyll-a BenchSheet
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